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1 What�s New in This Release
Siebel Marketing Installation and Administration Guide is a new book for the 7.7 version of Siebel 
Marketing.

Siebel Marketing 7.7 introduces a set of architectural and functional enhancements including:

■ The new segmentation interface provides increased visibility into segment membership and 
criteria counts.

■ An enhanced list generation capability provides increased flexibility and formatting options for 
exported list files.

■ Shared metadata in the Siebel Analytics repository (SiebelAnalytics.rpd) supports segmentation, 
reporting, list generation, and other Siebel Analytics functions. For more information about 
Marketing and Analytics metadata, see Siebel Analytics Server Administration Guide, version 
7.7.1 and later.

■ For customers using the Siebel Data Warehouse (sometimes referred to as the Siebel 
Relationship Management Warehouse) for segmentation, Siebel Marketing provides 
preconfigured metadata to support the Marketing module. For more information about Marketing 
metadata, see Siebel Analytics Server Administration Guide, version 7.7.1 and later.

NOTE: In this guide, the term Marketing module refers to the module within the Siebel Analytics 
Web Server that supports segmentation and list generation.

■ The enhanced Email Marketing Server provides improved scalability for high volume personalized 
email campaigns.
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What�s New in This Release ■  
What�s New in Siebel Marketing Installation and Administration 
Guide, Version 7.7, Rev. A
Table 1 on page 8 lists changes described for this version of the documentation to support release 
7.7 of the software.

Table 1. New Product Features in Siebel Marketing Installation and Administration Guide, Version 
7.7, Rev. A

Topic Description

Enhanced email campaigns 
functionality using Email 
Marketing

See �Installing and Configuring 
Email Marketing� on page 89

The new Email Marketing Server provides improved 
scalability for sending high-volume, personalized email 
campaigns and supports new features such as customizable 
merge fields, dynamic-content generation, and Forward to a 
Friend. (Before version 7.7, email campaigns were handled 
by Siebel Communications Server.)

A new chapter about source code 
formats

See �Creating Source Code and 
Vendor Profiles� on page 67

A new chapter describes source code formats. (Before version 
7.7, Rev. A, this chapter existed in the Siebel Marketing 
Guide.)

A new chapter about the Web 
Marketing module

See �Setting Up Web Marketing� on 
page 117

A new chapter describes the Web Marketing module. (Before 
version 7.7 Rev. A, the name of the Web Marketing module 
was the eMarketing module and the chapter existed in the 
Siebel Marketing Guide.)

Moved the upgrade topics to a 
separate appendix

See �Upgrade Guidelines for Siebel 
Marketing� on page 137

The new upgrade process is significantly different for version 
7.7. For example, after an upgrade, no workflows are 
deployed and you must deploy and activate workflows in 
Siebel Tools before you can use them. (Before version 7.7, 
Rev. A, upgrade topics were in Appendix A, Marketing 
Installation and Administration Reference.)

Removed troubleshooting content 
from Appendix A, and renamed the 
Appendix

See, �Advanced Marketing 
Information for Administrators� on 
page 125

Changes to troubleshooting process require removal of this 
content. (Before version 7.7, Rev. A, troubleshooting content 
was in Appendix A, Marketing Installation and Administration 
Reference.)
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What�s New in This Release ■
What�s New in Siebel Marketing Installation and Administration 
Guide, Version 7.7
Table 1 on page 8 lists changes described for this version of the documentation to support release 
7.7 of the software.

Table 2. New Product Features in Siebel Marketing Installation and Administration Guide, Version 
7.7

Topic Description

Simplified installation

See �Installing Siebel Marketing� on 
page 11.

This new topic provides information about the process of 
installing and enabling the 7.7 Marketing application 
components, including the Siebel Enterprise components and 
the Marketing module within the Siebel Analytics Web 7.7.1.

(Before version 7.7, Siebel Marketing was installed on the 
Marketing Server.)

Enhanced design features for 
creating list formats for campaign 
load, list export, email server and 
data load

See �Designing Marketing List 
Formats� on page 46

The List Format Designer is a new module in the Analytics 
Web Server that allows you to create list formats for a variety 
of purposes, including campaign load, list export, email 
personalization, customer synchronization, and other data 
loads.

(Before 7.7, creating list formats and loading campaign data 
were accomplished using data retrieval and snapshot files.)

Enhanced configuration and 
administration of the Marketing 
module (for segmentation and list 
generation)

See �Installing and Administering 
Segmentation and List Generation� 
on page 33

The new Marketing module within the Siebel Analytics Web 
allows you to configure metadata for segmentation and list 
generation. 

(Before 7.7, configuration had to be done on the Siebel 
Marketing Server and on the Siebel Analytics Server.)
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2 Installing and Administering 
Siebel Marketing
This chapter contains the following topics that apply only to a Microsoft Windows environment:

■ Installing Siebel Marketing on page 11

■ Enabling and Synchronizing Marketing Server Components on page 12

■ Activating and Deactivating Marketing Workflow Processes on page 14

■ Updating Marketing Connection Settings on page 15

■ Setting Optional Marketing Parameters on page 18

■ Enabling Automatic Responses for Opportunities and Orders on page 19

■ Configuring the Marketing Approval Process on page 20

■ About Load Balancing and Global Deployment of Siebel Marketing on page 22

■ About Marketing Responsibilities and Access Groups on page 23

■ Creating Marketing Seed Data on page 26

■ Guidelines for Testing the Marketing Module in an Integrated Environment on page 27

■ Monitoring Marketing System Tasks on page 30

■ Importing Marketing iHelp Files from the Demo Database on page 31

Installing Siebel Marketing
A Siebel Marketing installation has two main parts. You can install the following parts in any 
sequence.

■ (Required) The Siebel Marketing operational application. Includes Siebel Server. 

For more information about installing Siebel Server components, see the Siebel Installation 
Guide for the operating system you are using. For information about Web servers and operating 
systems supported by Siebel Marketing, see System Requirements and Supported Platforms on 
Siebel SupportWeb.

CAUTION: If you are upgrading an existing Marketing installation, see �Upgrade Guidelines for 
Siebel Marketing� on page 137 and the Upgrade Guide for the operating system you are using.

■ (Optional) Analytics Server components that provide segmentation and list generation 
capabilities.

For more information about installing the Marketing module, see �Installing and Administering 
Segmentation and List Generation� on page 33.
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Installing and Administering Siebel Marketing ■  Enabling and Synchronizing Marketing 
Server Components
Enabling and Synchronizing Marketing 
Server Components
During Siebel Server installation and configuration, you need to enable the server components 
required by Siebel Marketing. Check the status of the Siebel Server component groups using the 
Component Groups view in the Administration - Server Configuration screen. The Component Groups 
view is a list of installed Siebel Enterprise Server component groups with their associated 
components, servers, and tasks. For more information about enabling component groups, see the 
Siebel Installation Guide for the operating system you are using.

Enabling Component Groups for Siebel Marketing
You need to make sure component groups are enabled. The server assigned to the selected 
component group appears in the Servers view tab.

To enable component groups

1 From the Site Map, choose Administration - Server Configuration > Enterprises > Component 
Groups.

2 In the Enterprise Servers list, select the appropriate server.

3 In the Enterprise Component Groups list, verify the required component groups have been 
enabled by performing the following steps:

a Locate each of the required component groups using Table 3 on page 12 as a guide. 

b Identify optional server components you might need to enable from the following list:

❏ Assignment Manager. Used for campaign member assignment.

❏ Data Quality Manager. Identifies duplicate contacts, accounts, and prospects during List 
Import.

c If the Enable State field does not contain the value Enabled, select the component group, click 
the menu button, and choose Enable Component Group.

Table 3.  Component Groups and Components Required for Marketing

Group Name Components Description

MktgOM ■ Marketing Obj Mgr

■ eMarketing Obj Mgr

■ eEvents Obj Mgr

Marketing Object Manager. Supports 
the user interface and business 
objects for the Marketing application.

MktgSrv ■ List Import Service Manager Marketing Server. Used for list 
management list import.
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Installing and Administering Siebel Marketing ■  Enabling and Synchronizing Marketing
Server Components
Synchronizing Component Groups
After enabling server component groups, you must synchronize (enable) the server configuration.

To synchronize component groups

1 From the Site Map, choose Administration - Server Configuration > Enterprises > Component 
Groups.

2 In the Enterprise Servers list, select the appropriate server.

3 Click the Synchronize view tab and click Synchronize.

You do not have to select any components in this view. The synchronization task may take a few 
minutes.

Stopping and Restarting the Siebel Server
The Siebel Server must be restarted each time synchronization occurs. 

System ■ Siebel Connection Broker

■ Server Request Processor

■ File System Manager

■ Client Administration

■ Server Tables Cleanup

■ Server Manager

■ Server Request Broker

Supports general server 
management.

Workflow ■ Workflow Process Manager

■ Workflow Process Batch Manager

■ Workflow Action Agent

■ Workflow Recovery Manager

■ Workflow Monitor Agent

■ Generate Triggers

Executes required marketing 
workflow processes.

CommMgmt ■ Communications Outbound Manager

■ Communications Session Manager

■ Communications Configuration 
Manager

Communications Management. 
Delivers outbound wireless and fax 
offers for campaigns.

Table 3.  Component Groups and Components Required for Marketing

Group Name Components Description
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Installing and Administering Siebel Marketing ■  Activating and Deactivating Marketing 
Workflow Processes
To restart the Siebel Server process using Microsoft Windows

1 In the Microsoft Windows Control Panel, click the Services icon to open the Services window.

2 Locate Siebel Server and click Stop.

3 Click Start.

Activating and Deactivating Marketing 
Workflow Processes
The Siebel Marketing application requires a group of workflow processes to support various functions. 
Workflow processes must be activated before you can use them. When activated, the workflow 
process Status field contains a value of Active. For details about activating or deactivating workflows, 
see Siebel Business Process Designer Administration Guide. 

CAUTION: The procedure for activating a workflow has changed. You must deploy workflows in 
Siebel Tools and then activate workflows before you can use them. For more information, see the 
section about upgrade planning for Siebel Workflow Designer in the Upgrade Guide for the operating 
system you are using.

Activating Workflow Processes
Table 4 on page 14 contains a list of workflows required for the Siebel Marketing application. To 
activate a workflow process, use the instructions for deploying workflows in Siebel Business Process 
Designer Administration Guide.

For a list of the obsolete workflow processes that you need to activate after upgrading to Siebel 7.7, 
see �Deactivate Obsolete Marketing Workflow Processes� on page 139.

NOTE: Before attempting to use Siebel Marketing, make sure that you activate version zero (0) of 
all workflows in Table 4 on page 14, and then restart the Workflow Process Manager Component (or 
Siebel Server).

Table 4. Workflow Processes Required for Siebel Marketing

Workflow Name Group Description

Analytics Data Load Marketing Loads data through EAI for Customer 
Synchronization or Analytics Data Load 
requests

Campaign Copy Marketing Applies a campaign template

Email Marketing - Forward to Friend Marketing Sends new emails to forward recipients

Email Marketing - Update Status Marketing Updates the delivery status of an email 
offer

Generate Source Code Marketing Generates source codes for a campaign

Import Marketing Contact Marketing Subprocess for Marketing Campaign Load
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Settings
Deactivating Workflow Processes
For information about deactivating workflows, see �Deactivate Obsolete Marketing Workflow 
Processes� on page 139.

Updating Marketing Connection Settings
After you complete the Analytics installation, perform the following tasks:

■ Connecting the Siebel Server to the Analytics Web Server on page 15

■ Confirm Host and Symbolic URL for the Marketing Module on page 17

■ Setting up the Marketing File System for Mixed Environments on page 18

Connecting the Siebel Server to the Analytics Web 
Server
For segmentation and list generation, you need to connect the Siebel Marketing operational 
application (on the Enterprise Siebel Server) to the Analytics Web Server. To connect to the Analytics 
Web Server, you need to change the User ID and Password fields to the default login for the Analytics 
Web Server that you plan to use. This login is the user ID that is used to authenticate all requests 
to the Marketing module.

List Export Marketing Requests list files to be generated by the 
Marketing module

List Purge Marketing Purges prospects from an internal list

Marketing Approval Process Marketing Routes marketing approval items

Marketing Campaign Launch Marketing Launches one or more campaign waves

Marketing Campaign Load Marketing Loads segment or list members into a 
campaign

Marketing Stage Execution Marketing Scheduled execution of a program stage

Marketing Wave Launch Marketing Subprocess for Marketing Campaign 
Launch

Program Copy Marketing Applies a program template

Table 4. Workflow Processes Required for Siebel Marketing

Workflow Name Group Description
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Installing and Administering Siebel Marketing ■  Updating Marketing Connection 
Settings
You need to perform this setup to make sure that Siebel Server can communicate to Analytics Server 
during program and campaign design, campaign load, list generation, and campaign launch. For 
example, when a user submits a request for campaign load or list generation, the requests to the 
Marketing module use this login for impersonation when the user's password is unavailable.

NOTE: Impersonation is used to authenticate a user, allowing access to the Analytics Web Server 
when the user's password is unavailable. The default login is used to authenticate and create a 
session, and then the login Id is changed to the user Id of the person who submitted the request.

To change the user ID and password to the Analytics Web Server login

1 Log in to the Marketing application as the administrator.

2 From the Site Map, choose Administration - Marketing > Servers.

3 In the Servers list, query for Name = Default Marketing Server.

The Type field should be Siebel Analytics Web Server.

4 Scroll down to the Parameters list.

5 In the Parameters list, drill down on Authentication Service (SAWSessionServiceSoap) and 
perform the following steps:

a In the Outbound Web Services view, in the Service Ports list, change the first part of the 
address (default value is CHANGEME) to match the server name and domain of your Siebel 
Analytics Web Server running the Marketing module.

The address needs to be the full path name. For example, if your Marketing Server is named 
MarketingServer1, the full address for the JobManagementService would be the following:

http://MarketingServer1/analytics/saw.dll?SoapImpl=jobManagementService.

b Click the back button in the browser window.

6 In the Parameters list, drill down on Catalog Service (WebCatalogServiceSoap) and perform the 
following steps:

a In the Outbound Web Services view, in the Service Ports list, change the first part of the 
address (default value is CHANGEME) to match the server name and domain of your Siebel 
Analytics Web Server running the Marketing module.

b Click the back button in the browser window.

7 In the Parameters list, drill down on Job Execution Service (JobManagementServiceSoap) and 
perform the following steps:

a In the Outbound Web Services view, in the Service Ports list, change the first part of the 
address (default value is CHANGEME) to match the server name and domain of your Siebel 
Analytics Web Server running the Marketing module.

b Click the back button in the browser window.

8 Click Clear Cache.

You should not need to restart the Siebel Server for this change to be effective.
Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A16 ■



Installing and Administering Siebel Marketing ■  Updating Marketing Connection
Settings
Confirm Host and Symbolic URL for the Marketing 
Module
Perform this task so that users can see the Segment Designer and Segment Tree Designer in the 
Segments screen tab and the List Format Designer in the Administration - Marketing screen tab.

1 Log in to the Marketing application as the administrator.

2 Navigate to Site Map > Administration - Integration > WI Symbolic URL List. 

3 In the Administration - Integration screen, from the visibility filter, select Host Administration.

4 In the Host Administration list, query for Virtual Name = SEGMENTSERVER and verify that a 
record with the Name field = [SegmentationServerName] appears.

5 In the Name field, change [SegmentationServerName] to the Analytics Web Server name that 
you plan to use.

CAUTION: Be sure to change the Name column, not the Virtual Name column. Also, make sure 
that you have not included brackets in the name.

TIP: This server name must be unique. For example, if you assign a server name to your 
Analytics Web Server and try to use the same server name for Siebel Intelligence Dashboards, 
you will receive a unique name error. To prevent this, you can append the domain to the server 
name (for example, yourserver.yourdomain.com) or use the IP address in place of the name.

6 From the visibility filter, select Symbolic URL Administration. 

7 In the Symbolic URL Administration list, query for Web Application name = Marketing 
Segmentation and verify that records with the following Name field values appear:

■ MarketingEditListFormat

■ MarketingEditSegment

■ MarketingEditSegmentTree

■ MarketingListFormatsEntry

■ MarketingSegmentsEntry

■ MarketingSegmentTreesEntry

8 Scroll down to the Symbolic URL Arguments list and verify that each Web application resulting 
from your query in Step 7 on page 17 have the correct nqUser and nqPassword argument.

For each Web application, perform one of the following steps:

a To allow each user to connect using their username and login, perform the following steps:

❏ In the Symbolic URL Arguments list, Set the nqUser argument ArgumentType = 
Command and Argument Value = UseSiebelLoginId.

❏ Set the nqPassword argument to ArgumentType = Command and Argument Value = 
UseSiebelLoginPass.

b In the Symbolic URL Arguments list, to connect using a fixed username and login for all users, 
perform the following steps:
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Installing and Administering Siebel Marketing ■  Setting Optional Marketing Parameters
❏ Set the nqUser argument to ArgumentType = Constant and Argument Value to the shared 
login for the Marketing module.

❏ Set the nqPassword argument ArgumentType = Constant and Argument Value to the 
shared password for the Marketing module

NOTE: After changing settings for any Web service or symbolic URLs, be sure to log out of the 
browser session and log in again for the changes to take effect.

Setting up the Marketing File System for Mixed 
Environments
For segmentation and list generation, access to the Marketing File System is shared between the 
Siebel Server and the Analytics Web Server. If the Siebel Server and Analytics Web Server are 
installed on a combination of UNIX and MS Windows operating systems (heterogeneous 
environment), the Marketing File System must be configured for sharing across environments.

Enable File Sharing in Mixed Environments
Analytics Web Server must have visibility and write permissions to the Marketing File System. In a 
mixed (heterogeneous) environment, you may have to run a third-party application such as Samba 
to access the Marketing File System across different platforms. 

Analytics Web Server uses the MarketingFileSystem parameter to identify the Marketing File System. 
This parameter on the Analytics Web Server points to the same path as the Marketing File System 
parameter on the Marketing Object Manager. However, the path syntax should correspond to the 
platform on which Analytics Web Server is running.

For example, you might have the following configuration:

■ Siebel Server and the Marketing File System run on UNIX. The Marketing File System might be 
located at /export/home/filesystem on the Siebel Server (sdcn1125s031).

■ The Analytics Web Server might be running on MS Windows.

You could export this file system path to be visible on MS Windows by running a third-party 
application such as Samba on the UNIX machine. In this example, the parameters would be set as 
shown in the following list:

■ The Marketing File System parameter on the Siebel Server could be set to /export/home/
filesystem.

■ The MarketingFileSystem configuration parameter on the Analytics Web Server should be set to 
\\sdcn1125s031\export\home\filesystem.

Setting Optional Marketing Parameters
This section contains the following topic:

■ Setting Universal Time Option (UTC) on page 19
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Opportunities and Orders
Setting Universal Time Option (UTC)
The time zone of the operating system on the Siebel Server machine can be set to any zone. 
However, the time should be synchronized with the database server. For example, if the time on the 
database server is 10:00 PM GMT, the Siebel Server machine should show a time of 2:00 PM (PST) 
or 4:00 PM (CST). To compensate for Siebel Servers and a database that are in different time zones, 
the Universal Time Option parameter is enabled to specify that all server tasks will be submitted in 
reference to a Universal Time. You must set this option to TRUE when deploying your Siebel 
application globally because global deployments typically have some Siebel Servers in a different 
time zone from the Siebel transactional database. If your implementation does not span time zones, 
this setting is optional.

NOTE: If your Marketing Server requests do not run and remain in Queued status, then you might 
have a UTC issue. Please repeat each step in this task to verify your settings.

For more information about UTC, see Global Deployment Guide.

To set the universal time option

1 From the Site Map choose Administration - Application > System Preference.

2 In the System Preference Name field, query for Universal Time Coordinated, and perform one of 
the following steps:

■ To use the universal time option, in the System Preference Value field, set the value to TRUE.

■ To disable the universal time option, in the System Preference Value field, set the value to 
FALSE.

3 Verify that the operating system Clock and Time Zone on the Database Server machine is set to 
(GMT) Greenwich Mean Time.

4 Synchronize the time on the Siebel Server machine with the time on the database server 
machine.

5 Restart the Siebel Server to make your change effective.

Enabling Automatic Responses for 
Opportunities and Orders
Responses can be created automatically when you associate a campaign with an order, associate a 
campaign as a source for an opportunity, or create an opportunity using the Create Oppty button in 
the Campaign screen. By default, the user properties for automatic response creation are disabled.

To enable automatic response creation in the Orders, Opportunities, and Campaigns screens, 
perform the following tasks in Siebel Tools:

■ Orders screen. Set the User property Create Auto Response Service to Y in the Order Entry - 
Orders business component. When you enable this service, a response is created for the primary 
contact for the order whenever a campaign is associated with the order.
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Process
■ Opportunity screen. Set the User property Create Auto Response Service to Y in the 
Opportunity business component. When you enable this service, a response is created for one of 
the opportunity contacts whenever a campaign is associated as a source with the opportunity.

■ Campaigns screen, Contacts/Prospects view tab. Enable the Create Oppty button in this 
view tab by setting the User property Create Auto Response Service to Y in the Opportunity 
business component. When you enable this service, a response is created automatically 
whenever the user clicks the Create Oppty button in the Campaign screen.

Configuring the Marketing Approval 
Process
Siebel Marketing provides the ability to submit a variety of marketing items for review and approval 
using the Marketing approval process. Marketing plans, budget requests, programs, campaigns, 
event plans, and offers can be submitted from one employee to another by changing the Approval 
Status field on any of these objects.

The approval process is integrated with the Universal Inbox, so that marketing items that are 
submitted for review or approval, also appear in the Universal Inbox for the user who sent or received 
the item.

In the standard configuration, a change in the approval status opens a dialog box that allows the 
user to select the recipient employee and add a comment. When the user clicks Send, the Marketing 
Approval Process workflow creates a Universal Inbox Item task for the recipient employee and 
updates the approval history with the approval status value and any comments made by the 
recipient.

Table 5 on page 20 contains a list of the business components for which the approval process is 
enabled.

Table 5. Business Components With Approval Process

Business Component Name

Campaign

Direct Mail Offer

Direct Sales Offer

eEvents Parent Event

Email Offer

Fax Offer

Indirect Offer

Marketing Budget Requests

Marketing Plans

Offer
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Modifying the Approval Values
The standard configuration provides the following lists of values (LOVs):

■ Approval Status. The values from this LOV appear in the Approval Status field that appears in 
the Marketing Plans, Budget Requests, Programs, Campaigns, Event Plans, and Offers screens.

■ Action. The values from this LOV appear in the Action field in the Universal Inbox applets and 
the Approval view tab of the Marketing Plans, Budget Requests, Programs, Campaigns, Event 
Plans, and Offers screens. Action values are automatically mapped to Approval Status values. For 
example, when a user chooses an Approval Status value of Needs Revision in one record the 
Action value is updated to Request Revision in the corresponding Universal Inbox record. Table 6 
on page 21 shows the preconfigured mapping for these values.

If required, you can add to the list of values using the Administration - Data screen. If you add a 
value that you want to be an Approval Last Point, you need to identify the new value as an Approval 
Last Point in Siebel Tools.

To add a new approval value and map the LOVs

1 From the Site Map, choose Administration - Data > List of Values.

2 In the List of Values list, query for the MKTG_PLAN_APPR_TYPE list of values and perform the 
following steps:

Phone Offer

Program Container

Web Offer

Wireless Offer

Table 6. Values for Approval Status and Action LOVs

Approval Status Action Description

(blank) Not Yet Submitted This field is blank until a value is selected.

Approved Approve Approval Last Point. No further action is 
required by user.

Declined Decline Approval Last Point. No further action is 
required by user.

Needs Revision Request Revision Requires action by the user until an 
Approval Last Point is selected.

Submitted Submit Requires action by the user until an 
Approval Last Point is selected.

Table 5. Business Components With Approval Process

Business Component Name
Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A ■ 21



Installing and Administering Siebel Marketing ■  About Load Balancing and Global 
Deployment of Siebel Marketing
a Click New and complete the fields. 

b You must complete the Display Name, Language Name, and Order fields, and then select the 
Active flag.

NOTE: Use a unique value in the Order column in this list. This controls the sequence that 
the items appear in the drop-down list.

3 Query for the MKTG_UINBOX_ACTION_TYPE list of values and perform the following steps:

a Click New and complete the fields. 

b You must complete the Display Name, Language Name, and Order fields, and then select the 
Active flag.

NOTE: Set the order value in this list to control the sequence that the item appears in the 
drop-down list.

To identify a new Approval Last Point value

1 Login to Siebel Tools and query for the business component for each marketing approval item. 
For a list of supported business components, see Table 5 on page 20.

2 For each business component, select the Business Component User Properties node.

3 Select the User Property named Approval Last Point.

4 Add the new value to the comma separated list.

CAUTION: Do not change the existing values (Declined and Approved). You should insert your 
value <your new value> as an additional value.

If your organization does not want this Approval dialog box to appear when the Approval Status 
changes, you can disable it.

To disable the Approval dialog box

1 Log in to Siebel Tools.

2 Find the base Business Component for which you want to disable the popup. For a list of 
supported business components, see Table 5 on page 20.

3 Select the Business Component User Properties node. 

4 Select the Show Approval Popup user property and change the value to No.

About Load Balancing and Global 
Deployment of Siebel Marketing
For information about Load Balancing server requests within the Siebel Enterprise, see Siebel 
Installation Guide for the operating system you are using and Siebel System Administration Guide. 
This section contains the following topics:

■ Isolating Marketing Workflow Processes on page 23
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Isolating Marketing Workflow Processes
Marketing workflow processes can be resource intensive during peak usage or large jobs. You might 
need to isolate marketing-related workflows from other workflow requests in the Enterprise by 
directing marketing requests to a specific instance of the Workflow Process Manager. If you need to 
do this for marketing workflow processes, you need to replicate the Workflow Process Manager 
component and change the enterprise parameter so that it points to the new component.

To create a new marketing Workflow Process Manager component

1 From the Site Map, choose Administration - Server Configuration > Select Enterprises > 
Component Definitions.

2 In the list, query for the Workflow Process Manager component.

3 From the list menu, choose Copy Record.

4 For the copied component, type a new component name such as Workflow Process Manager - 
Mktg in the Name field.

5 Type a new alias such as WfProcMgrMktg in the Alias field.

6 Change the Enable State field to Enable.

7 In the Enterprises screen, select the Parameters view.

8 In the Enterprise Parameters list, query for the parameter named Marketing Workflow Process 
Manager.

9 In the Value field, change the value to the name of the new component that you just created.

About Marketing Responsibilities and 
Access Groups
This section contains the following topics:

■ About Marketing Responsibilities on page 23

■ Modifying Privileges for Marketing Access Groups on page 24

■ Assigning Marketing Users to Access Groups on page 25

About Marketing Responsibilities
Siebel eBusiness applications provide a set of Marketing Responsibilities that contain the full set of 
active views. These responsibilities are divided into core Responsibilities and add-on Responsibilities.

■ Core responsibilities. Base user responsibilities that serve as a starting point for any Marketing 
user. Typically, a user has only one core Marketing responsibility from this list.The following is a 
list of core Responsibilities:

■ Campaign Agent

■ Campaign Administrator
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■ Marketing Planning Manager

■ Events Manager

■ Marketing Executive

■ Add-on responsibilities. Support additional modules that certain users may need depending 
on their job description. These responsibilities are intended to be added to a core responsibility. 
They do not include common screens such as Accounts and Contacts because a core 
responsibility provides these screens. Because these are added to core responsibilities, you can 
assign a user multiple add-on responsibilities.

The following is a list of add-on Responsibilities:

■ Web Marketing User

■ Segmentation User

■ Marketing Program Manager

■ Marketing Admin

■ Marketing Analytics User

TIP: If you create custom views, you might want to create new add-on responsibilities for these 
views, instead of adding these views to the standard responsibilities provided by Siebel Systems. 
During future upgrades, this helps you identify custom views that you created.

Modifying Privileges for Marketing Access Groups 
Siebel Marketing restricts the use of some buttons in the user interface (and their underlying 
methods) to those users assigned to Marketing access groups. This makes sure that unauthorized 
users cannot perform functions that they are not trained to perform. Marketing Access Groups can 
be used to restrict use of any button or menu item on any applet.

Siebel Marketing provides the following preconfigured access groups:

■ Marketing Managers

■ Marketing Administrators

To modify the Marketing access privileges for an applet

1 Login to Siebel Tools.

2 In the Object Explorer, select Applets.

3 Select the applet, such as Campaign Execution Status List Applet, for which you want to modify 
access.
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4 In the Applet User Properties, in the Marketing Access Group user property, add or delete access 
groups. Use the following syntax for each user property entry:

NOTE: N is an integer 0,1,2, and so on, for each method you want to restrict.

For example, the Campaign Execution Status List Applet has the following user properties in the 
standard repository:

5 To add or remove an access group for a specific method, add or remove the access group name 
from the comma separated list in the user properties.

If required, you can create additional access groups for your organization.

To create a new marketing access group

1 From the site map, choose Administration - Groups > Access Groups.

2 In the Access Groups list, click New.

3 In the new record, type an Access Group name and, from the Type drop-down list, select Access 
Group.

4 Review all the applets in the application for which you want to enable or disable a button, menu 
item, or other control that invokes a method.

5 For each applet, modify the applet user properties to reference the new access group.

Assigning Marketing Users to Access Groups
You need to perform this setup task to make sure your Marketing users have access to the 
appropriate functionality. You assign the users to access groups based on the position of each user. 
For more information about access groups, see Security Guide for Siebel eBusiness Applications.

To assign Marketing users to access groups

1 From the Site Map, choose Administration - Group > Access Groups.

Name Value

Marketing Access Group <n> "<method name>", "<access group 1>", "access group 2>", 
and so on

Name Value

Marketing Access Group 0 "PromptPurgeLoad" , "Marketing Administrators"

Marketing Access Group 1 "PromptSuspendWave" , "Marketing Administrators" , 
"Marketing Managers"

Marketing Access Group 2 "PromptLaunchWave" , "Marketing Administrators" , "Marketing 
Managers"
Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A ■ 25



Installing and Administering Siebel Marketing ■  Creating Marketing Seed Data
2 In the Access Groups list, in the Name field, query for Marketing*.

NOTE: At least two access groups (Marketing Administrators and Marketing Managers) appear.

3 In the Access Groups list, select Marketing Administrators.

4 In the Party list, add the positions for your administrators.

For example, Siebel Administrator and Marketing Administrator positions.

5 In the Access Groups list, select Marketing Managers.

6 In the Party list, add the positions for your marketing managers.

For example, Marketing Analysts, Program Managers, and so on.

NOTE: You need to add positions as access group members, not User List or Organization.

7 Restart the client for this change to be effective.

Creating Marketing Seed Data
After you install the Marketing application, there are some optional seed data that can be created to 
support various business processes. This section contains the following topics:

■ Creating Marketing Regions on page 26

■ Creating Marketing Activity Templates on page 27

■ Creating and Using Marketing Activity Plans on page 27

Creating Marketing Regions
Marketing regions provide a way to organize the marketing plans and tactics in your organization. 
Additionally, regions allow you to generate more detailed Marketing reports and rollups in Siebel 
Analytics.

You can define marketing regions according to any set of parent child relationships that you require. 
Although there is no limit to the number of layers you can create in your hierarchy, marketing 
analytics only supports a hierarchy that is a maximum of 10 layers deep.You can implement a 
marketing region hierarchy by making one region the child of another region. The following example 
shows a simple regional hierarchy:

Worldwide

North America

EMEA

Latin America

Asia Pacific

To create marketing regions

1 From the Site Map, choose Administration - Location > Regions.
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2 In the Regions list, create a new record.

3 Type the Region name and description.

4 Be sure to set the Type as Marketing Region.

5 If this region is a child of another region, select the Parent Region in the Parent Region field.

6 Save the record.

7 Repeat Step 2 on page 27 through Step 6 on page 27 for each region in the hierarchy.

Creating Marketing Activity Templates
Activity Templates provide a convenient way for users to quickly assign a set of milestones and 
activities to a program or campaign. For instructions about how to create activity templates, see 
Applications Administration Guide. For instructions about updating Activity Templates from prior 
releases, see the activity plan topic in the Upgrade Guide for the operating system you are using.

NOTE: When you create Marketing activity templates, be sure to set the type of the template to the 
name of the main marketing business components, for example Program Container and Campaign.

Creating and Using Marketing Activity Plans
Activity Plans allow marketing users to associate preconfigured planning and milestone activities and 
tasks with a template (activity plan). Users can assign the templates to marketing programs and 
campaigns. This creates one or more activities that are associated with a campaign or a program.

NOTE: Activities are not created for contacts that are loaded into a campaign.

Activity Plans may be designed to help you plan the marketing program or campaign or execute it. 
Before you link an activity plan to your campaign, you need to create activity templates or customize 
existing templates to reflect your business process and needs. Templates allow you to define a 
generic set of activities that may be reused. 

For example, a marketing department production manager might design an activity plan template 
called Direct Mail that contains regularly scheduled campaign planning activities (meetings with 
creative or budgetary staff) and start tasks (such as generating an export list according to 
segmentation criteria). Using the Campaign Activity Plans view the manager can associate the 
activity plan template to the current campaign and then assign resources, define priorities and status 
and so on to each predefined task, adding comments where necessary. 

If your marketing program or campaign has a combination of planning and start activities, you can 
create two activity plans, one for planning and one for execution tasks, and assign them both to the 
program or campaign.

Guidelines for Testing the Marketing 
Module in an Integrated Environment
If you want to deploy the Marketing module for segmentation and list generation, you need to install, 
configure, and test your integrated environment.
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■ Installation. You need to install the following products:

■ Siebel Analytics Web Server and Siebel Analytics Server. For more information, see Siebel 
Analytics Installation and Configuration Guide. 

■ Siebel Enterprise Server. For more information, see Siebel Installation Guide for the 
operating system you are using.

■ Configuration. After installing, you need to configure segmentation metadata, list export 
metadata, and create example list formats. For information about configuring segmentation and 
list export metadata, see the chapter about Marketing metadata in Siebel Analytics Server 
Administration Guide.

■ Testing. 

■ After installing the Marketing application and Marketing module, you need to conduct a 
system test to verify that all components are correctly activated.

■ After you install and configure Siebel Marketing and create segmentation metadata, you need 
to test campaign load.

This section contains guidelines that will help you test a Marketing integrated environment.

To test the Symbolic URL integration

1 In Siebel Marketing, click the Segments screen tab.

2 In the Segments screen, click the Segment Designer link.

If the Segment Designer page does not appear, perform Step 5 on page 28.

3 In the Segments screen, click the Segment Tree Designer link. 

If the Segment Tree Designer page does not appear, perform Step 5 on page 28.

4 From the Site Map, choose Administration - Marketing > List Formats. 

If the List Format Designer page does not appear, perform Step 5 on page 28.

5 If any of the previous steps do not obtain the specified results or you receive an error, return to 
Administration - Integration > WI Symbolic URL List and check the Host Administration settings.

To test the Web Services integration

1 In Siebel Marketing, click the Segments screen tab.

2 In the Segments screen, click the Segment Designer link.

3 In the Segment Designer, create a test segment and save the segment in the Web Catalog.

For more information about creating segments, see Siebel Marketing User Guide.

4 Navigate to the Campaign screen and perform the following steps:

a In the My Campaigns list, click New.

b In the record, type a campaign name, and save the record.

c Drill down on the Campaign name and click the Design view tab. 
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5 In the Design view, perform the following steps:

a Click the Segments/Lists link.

b In the Segments/Lists list, click Add Segment. 

c In the Previously Used Segments dialog box, click Choose a new Segment.

d In the next Previously Used Segments dialog box, click the Folder Location select button to see 
the following folders in the Siebel Analytics Web Catalog:

❏ Your user name

❏ Shared

6 If you receive an error, perform the following steps:

a From the Site Map, choose Administration - Marketing > Servers view

b Verify the following values:

❏ The Marketing Server definition has the correct Authentication user and password

❏ All three Web services have the correct Analytics Web Server name in the address

To test navigation links to the Segment Designer page

1 From the Site Map, choose Campaigns. 

2 In the My Campaigns list, drill down on the name of your test campaign.

3 In the Campaign Details form, click the Design view tab.

4 In the Design view, click the Segments/Lists link.

5 Add a segment to associate it with a campaign.

6 Drill down on the name of the segment.

The Segment Designer should appear with your segment open for editing.

7 If you receive an error, verify the following:

a From the Site Map, choose Administration - Marketing > Servers and verify that the Marketing 
Server definition has three parameters for the navigation views.

b Log in to an Analytics URL directly, and verify that the segment request exists and can be opened 
successfully.

To test campaign load

1 In Siebel Marketing, click the Segments screen tab and perform the following steps:

a In the Segments screen, click the Segment Designer link.

b In the Segment Designer, create a test segment and save the segment in the Web Catalog.

For more information about creating segments, see Siebel Marketing User Guide.

c Click the Advanced Options tab and verify that a valid Campaign Load List Format is associated 
with the segment.
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2 Navigate to the Campaign screen and create a test campaign by performing the following steps:

a In the My Campaigns list, click New.

b In the record, type a campaign name, and save the record.

c Drill down on the Campaign name and click the Design view tab. 

3 In the Design view, perform the following steps:

a Click the Segments/Lists link.

b In the Segments/Lists list, click Add Segment. 

c In the Previously Used Segments dialog box, click Choose a new Segment.

d Locate and select your test segment.

4 Click OK twice to associate the segment with the campaign.

5 In the Campaign form, click Menu and choose Load Campaign.

6 In the Load Campaign dialog box, click OK to submit the load request.

7 Click the Execute view tab and select the System Tasks link.

8 In the System Tasks list, verify that the campaign loads successfully.

Monitoring Marketing System Tasks
The Marketing Application provides a set of views that allow any user or administrator to monitor the 
progress of any marketing-specific server process. Each marketing-specific job is referred to as a 
system task. Table 7 on page 30 contains a list of where to locate these jobs.

Each system task provides high-level logging details that tracks the successful completion or any 
errors in each major step of the task. Because the task log is intended to be used by all users of the 
system, the System Task view does not provide low-level logging details. 

If an administrative user wants further details on a marketing system task, each step in the task log 
provides the Siebel Server, log file (indicating the server component), and Task Id. The administrator 
can use this information to locate the log file or the logging details under Server Administration.

Marketing system tasks display information for the following tasks:

Table 7. Views for Monitoring Marketing System Tasks

Location Purpose

Site Map > Administration - Marketing > 
System Tasks

Displays all marketing system tasks for all users.

Site Map > Programs > Execute tab > System 
Tasks

Displays all marketing system tasks for the 
selected program and related campaigns.

Site Map > Campaigns > Execute tab > 
System Tasks

Displays all marketing system tasks for the 
selected campaign.
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■ Campaign Load

■ Campaign Launch

■ Wave Launch

■ Stage Execution

■ Generate Source Codes

■ List Export

■ List Import

■ Analytics Data Load

Importing Marketing iHelp Files from the 
Demo Database
The demo database includes many iHelp files that can help users through frequently used tasks.   The 
following section provides instructions for exporting any of the iHelp examples included.

NOTE: Siebel Systems has developed a library of available tasks for Marketing tasks that are not 
part of the Siebel 7.7 demo data/sample database. To obtain a copy of these iHelp files, please see 
Siebel SupportWeb (https://ebusiness.siebel.com/supportweb/), or contact a representative 
from Siebel Product Marketing or Siebel Technical Support for assistance.

To export a task from the demo database

1 Connect an instance of the Siebel 7.7 application to the demo database.

2 From the Site Map, choose Administration - iHelp > All iHelp Items.

3 Select a task you want to export.

4 In the iHelp Items list menu, select Export iHelp Item Definition.

5 In the File Download dialog box, click Save and save the XML file anywhere on your computer's 
file system or anywhere on your network.

You can access the file later when you are ready to import it into another environment.

To import the task in your new installation

1 From the Site Map, choose Administration - iHelp > All iHelp Items.

2 In the iHelp Items list menu, select Import iHelp Item Definition.

3 In the Import iHelp Item Definition dialog box, select the XML file from the location on your 
computer or network where you stored the task.

4 Click the Designer tab.

A flowchart of the steps appears.
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5 Click the Responsibilities tab and associate the responsibilities that should have access to this 
set of instructions.

6 In the list, select the iHelp item record and click Activate.

7 Test the iHelp task by going to a screen related to the task and clicking the How do I icon in the 
top-left view bar.
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Segmentation and List 
Generation
This chapter contains the following topics:

■ Installation Guidelines for the Marketing Module on page 33

■ Update Default Repository and Connection Settings on page 34

■ About Mapping Segmentation Metadata on page 34

■ Setting Up Marketing Module Parameters in Siebel Analytics on page 35

Installation Guidelines for the Marketing 
Module
To install the segmentation and list generation (Marketing module), you install Siebel Analytics 
version 7.7.1 or later. 

NOTE: In this guide, the term Marketing module refers to the module within the Siebel Analytics Web 
Server that supports segmentation and list generation.

During the installation, make sure that you adhere to the following guidelines:

■ Install Siebel Analytics, version 7.7.1 or later. This installation includes Analytics Server, 
Analytics Web Server, and the Marketing module. For installation instructions, see Siebel 
Analytics Installation and Configuration Guide.

■ Use a set of Analytics license keys that allow access to the Marketing module capabilities. These 
license keys provide access to the following features in the Analytics Web Server: 

■ Segment Designer

■ Segment Tree Designer

■ List Format Designer

■ To reduce the size of the installation disk space, you can choose the Custom install option and 
clear the check boxes for any of the optional components in the following list that you do not 
need for your installation:

■ Analytics Server (Required)

■ Siebel Analytics Administration Tool (Required)

❏ Siebel Analytics Job Manager (Required)

❏ Siebel Analytics Application Repository (Required)

■ Siebel Analytics Clustering Manager (Optional)

■ Siebel Analytics Scheduler (Optional for Marketing)

■ Siebel Analytics Client (Optional)
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■ Siebel Analytics ODBC Driver (Required)

■ Siebel Analytics Web (Required)

■ Siebel Analytics Catalog Manager (Required)

■ Data Warehouse (Optional)

Update Default Repository and 
Connection Settings
After the install is complete, perform the following tasks: 

■ Update the nqsconfig.ini file. 

■ Update the [Repository] section of the nqsconfig.ini to reference the Analytics Repository 
(RPD) file that contains the segmentation metadata. For more information about changing 
the nqsconfig.ini file see Siebel Analytics Server Administration Guide.

■ Start the Analytics Server and test that some queries run successfully.

■ Verify the Analytics Web DSN.

■ Verify that the DSN Analytics Web points to the correct the Analytics Server on the machine 
where the Analytics Web Server is installed. 

■ Start the World Wide Publishing Service, your Web server (for example, IIS), and the 
Analytics Web Server. 

■ Log in and make sure you can navigate to the user interface for Segment Designer and List 
Format Designer. 

❏ If Siebel Answers and Siebel Intelligence Dashboards are licensed, run a test report query 
against the Analytics Server.

❏ If Siebel Answers is not licensed, create a simple segment and try to Update Counts. 
Otherwise, use the Siebel Analytics Client to test a query.

About Mapping Segmentation Metadata
Segmentation allows you to identify a group of targets for applying a marketing treatment. Typically, 
targets are individuals, businesses, bank accounts, or households but they can be any dimensional 
entity in the database such as Opportunities or Assets. The marketing segmentation user interface 
allows you to specify criteria that groups targets based on behavior patterns. Segmentation Metadata 
allows you to specify this criteria and is comprised of the following entities:

■ Target levels

■ Segmentation catalogs

■ Sampling factors

■ Conforming dimensions

■ Qualified list items
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■ Cache

■ Saved Result Sets

For instructions about how to create segmentation metadata, see Siebel Analytics Server 
Administration Guide. When you have created the segmentation metadata, you need to test the 
integrated environment.

Setting Up Marketing Module 
Parameters in Siebel Analytics
This section contains the following topics:

■ Verifying Database Privileges for the Marketing Module on page 35

■ Setting Permissions for Marketing Server Groups on page 35

■ Administering System Parameters for the Marketing Module

■ Managing Marketing Jobs on page 40

■ Managing Marketing Defaults on page 42

Verifying Database Privileges for the Marketing Module
The Segmentation and List Generation subsystems of the Marketing module use write-back 
capabilities for internal functions such as cache and saved result sets. For security reasons, the 
administrator can set up a second writable connection pool for the cache and saved result set 
database whose login and password has database privileges to create tables and write back to the 
database. You should contact your database administrator to verify that the user has these 
privileges. To verify that write back has been set up properly:

■ Verify that the connection pool used for the physical SQL permits writeback.

■ In Target Levels, in Saved Result Sets, verify that the connection pool used for the physical SQL 
permits writeback.

■ In Qualified List Items, in Cache Information, verify that the connection pool used for the physical 
SQL permits writeback.

■ In User/Group Permissions, for Query Limits for the segmentation database, set Populate 
Privilege to Allow.

NOTE: You do not have to set Populate Privilege to Allow, if you select the Allow populate queries 
by default check box in the General tab.

Setting Permissions for Marketing Server Groups
Specify the Web Catalog folders for segments, segment trees, list formats, and filters to which each 
user or Web group should have access.
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To provide visibility to functions of the Marketing module, perform the following tasks:

■ Specify the users and groups that should have access to the Segment Designer, Segment Tree 
Designer, and List Format Designer. For instructions about creating Users and Groups for the 
Analytics Web and managing access to Web Catalog folder, see Siebel Analytics Web 
Administration Guide.

■ After the users and groups are created, navigate to the Administration - Marketing screen, 
select Marketing Server Admin, and then select Manage Privileges. 

■ In Manage Privileges, designate which users and groups should have permission to access 
and perform each privilege listed. For instructions about managing privileges for Analytics 
Web users, see Siebel Analytics Web Administration Guide.

■ Establish the Web users and groups that should have access to see each Analytics Web Catalog 
folder. For instructions about managing the Web Catalog and permissions, see Siebel Analytics 
Web Administration Guide.

■ In the Analytics Repository, verify which groups should have permission to each Target Level, 
Segmentation Catalog, and Presentation Column. 

To set permissions for Marketing Server Groups

1 Log in to Siebel Analytics as an administrator.

2 In the Analytics application, click the Admin link.

3 In the Siebel Analytics Administration page, click Manage Privileges.

4 In the Access row, allow access by the appropriate groups to the following parts of the Marketing 
module:

a Access Segment Designer

b Access Segment Tree Designer

c Access List Format Designer

5 In the List Formats row, specify which user groups can perform each action.

6 In the Segmentation row, specify which user groups can perform each action.

Administering System Parameters for the Marketing 
Module
System settings for the segmentation and list generation subsystems of the Analytics Web Server 
are contained in a configuration file. This file can be found at the following location:

\\install root\SiebelAnalyticsData\Web\config\instanceconfig.xml
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During installation of the Marketing module, use this configuration file to indicate the correct path 
names for the marketing file system, logging levels, and other properties. Table 8 on page 37 
contains parameters supported by the Marketing module.

Table 8. Marketing Parameter Default Settings

Parameter Default Value Description

MarketingPrevi
ewSize

200 Number of default records shown in the List Format Designer 
when a user selects Generate Preview. This parameter can be 
overridden by the end users in the Preview user interface by 
entering a different preview size in the Preview Parameters 
dialog box.

MarketingPrevi
ewPath

\\<hostname>\L

ists\Preview\

File system path where preview and output list files are 
written. The following paths are examples:

■ C:\Temp\ (Analytics Web running on Windows)

■ /tmp/ (Analytics Web running on UNIX)

This parameter can be overridden by the user in the List 
Format Designer by specifying a different destination folder 
path.

MarketingFileE
ncoding

UTF8 Character set encoding of the List Format files generated. The 
following encoding types are supported:

■ UTF8

■ UTF16

■ ANSI

■ UTF16LE

■ UTF16BE

ANSI is the Windows code page character set encoding. 
UTF16 defaults to UTF16LE. These values are case 
insensitive.
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MarketingFileS
ystem

\\<hostname>\L

ists\

File system path used by Siebel Marketing to store output list 
files. This path must be accessible to the Analytics Web 
Server, must have write permissions for the user under which 
Analytics Web Server is started, and must end with a 
backslash.

The Marketing transactional application must use the same 
location as the Marketing File System. In the following 
situations, Analytics Web Server must have access to the 
path specified in the MarketingFileSystem parameter:

■ In an environment in which Siebel Server and Analytics 
Web Server are running on the same platform 
(homogenous), this path matches the Siebel File System 
server parameter such as in the following example:

\\hostname\Siebel\filesystem\ (Analytics Web running 
on Windows)

■ In an environment in which Siebel Server and Analytics 
Web Server are not running on the same platform 
(heterogeneous), the Siebel file system must be made 
visible to Analytics Web Server by running a third-party 
application (such as Samba) where the Siebel file system 
resides and by exporting this path such as in the following 
example:

/export/home/Siebel/filesystem (Analytics Web 
running on UNIX)

MarketingJobsL
ogSize

100 Maximum number of jobs in the job history log. After the 
maximum is reached, the oldest 25% are expired and 
removed. 

MarketingJobsL
ogDetailLevel

5 Amount of debugging information saved for each job. The 
following is a list of values:

■ 0 = No Details 

■ 1 = SQL Execution Manager 

■ 2 = SQL Execution Manager Ordering 

■ 3 = Cache Management Details 

■ 4 = Internal SqlNodes structures 

■ 5 = Internal RqtNodes structures 

■ 6 = Object XMLs 

Table 8. Marketing Parameter Default Settings

Parameter Default Value Description
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MarketingJobs
WaitSeconds

20 Duration between successive checks on the status of a 
Marketing job run from the User Interface. The jobs include 
Segment Counts, Segment Tree Counts, Saved Result Set 
Creation (in the Segments user interface or the Segment 
Trees user interface) and Purge and List Format Preview/List 
Generation. The wait-refresh cycles keep the browser from 
timing out while waiting for the jobs to complete. 

MarketingCach
eMaxExpireMin
utes

1440 Maximum time that a database cache entry can exist before 
it is expired and removed. 

MarketingCach
eMaxEntries

500 Maximum number of database cache entries allowed in the 
system. 

AdministrativeL
ogin

Administrator Login credential of the Administrative Analytics Server user 
under which Marketing runs its EXECUTE PHYSICAL queries. 
These include queries to delete cache result sets, delete 
saved result sets, delete header saved result sets and insert 
header result set records.

AdministrativeP
assword

SADMIN 
(Encrypted)

Password credential of the Administrative Analytics Server 
user under which Marketing runs its EXECUTE PHYSICAL 
queries. The password is encrypted and can be retrieved by 
posting the following URL as an Administrative Web user:

http://localhost/analytics/
saw.dll?EncryptString&string=<password>

MarketingData
Validation

False Replaces control characters in the column data with spaces. 
If this parameter is set to true, control characters in the 
column data whose ASCII value is less than 32, such as the 
carriage return and the line feed characters, are replaced by 
spaces before writing out to any list files.

MarketingWrap
ColumnHeaders

True Applicable only when files are being written out in the 
Delimited format and when a Text Qualifier is specified. 

■ When the default value is true, the column headers are 
wrapped using the text qualifiers specified in the List 
Format Options tab. 

■ When the default value is false, column headers are not 
wrapped. 

Table 8. Marketing Parameter Default Settings

Parameter Default Value Description
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Managing Marketing Jobs
The Manage Marketing Jobs console allows you to view the status and details of each segmentation 
or list generation request running on the Analytics Web Server. To view the details of a request, click 
the Details link in the Action column for the job.

You can also view the current database cache for any Qualified List Items accessed by a segment or 
segment tree request. To view the details for the cache, click Details in the Action column for the 
cache entry. To purge the cache, click the Purge link in the Action column for the cache entry.

NOTE: The Purge link next to each cache entry row purges all existing cache entries for the user who 
created the entry.

To view marketing jobs

1 From the Site Map, choose Administration - Marketing > Marketing Server Admin.

2 In the Siebel Analytics Administration page, click Manage Marketing Jobs.

MarketingUseB
OM

True Controls writing of the Byte Order Mark (BOM) characters at 
the beginning of list files. Typically applications read BOM 
characters to identify the encoding of the data.

■ When set to true, BOM characters are inserted at the start 
of the list file, identifying the character encoding used in 
the file.

■ When set to false, the BOM characters are not written. 

■ If you set the character set encoding to ANSI then no 
BOM is written.

MarketingEnabl
eNodeProfiling

True Enables or disables the hyperlink to the profile dashboard 
from counts in the Segment Designer and Segment Tree 
Designer.

Table 8. Marketing Parameter Default Settings

Parameter Default Value Description
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3 The top section displays all marketing jobs. The bottom section displays cache entries. The 
following list describes the types of marketing jobs.

Using Job Action Links
The following is a list of action links:

■ Cancel. All marketing jobs can be cancelled by clicking the Cancel action link. If a job is in the 
middle of a long-running operation, such as running a set of Siebel Analytic Server queries, the 
job issues SQLCancels to cancel all queries. While the Analytics Server is processing the cancel, 
the job state shows Running (Cancelling). After all queries have been cancelled, the job state 
updates the value to Cancelled.

■ Cancel All. Cancels all running jobs in the system.

■ Detail. Each job record also includes a Detail link which includes real-time information about the 
progress of the job. This log contains basic job statistics as well as detailed information specific 
to the job. 

■ For count, write saved result set, and write list file jobs, the log includes the query plan used 
to generate the logical SQL and SQL results and timings. 

■ For delete saved result sets, the log includes the logical delete statements on the header and 
data tables. 

■ For write list files, the log includes the constrained list items qualified by the list and the list 
SQL.

Marketing Job Description

Get Counts Represents a segment or segment tree count submitted through the 
Segment Designer, Segment Tree Designer, or SOAP API. For the Segment 
Designer, a count request within the Edit Criteria Block dialog box appears. 
The name of the segment or tree is always displayed in the information 
column.

Write List Files Represents a list generation job for full output list generation or preview. The 
information field contains the list format name as well as the location where 
the output files are written.

Write Saved 
Result Set

Represents the saving of either a segment result set or a segment tree cell 
result set. The name of the segment or tree is always displayed in the 
information column.

Delete Saved 
Result Set

Represents the deleting of a segment result set. The name of the segment 
or tree is always displayed in the information column.

Purge Cache Represents the user action of deleting cache result sets. This job type 
includes purging all cache in the system, purging all cache for a specific user, 
purging cache for a specific segment and purging cache for a specific tree.
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Managing Cache in the Marketing Jobs Console
The Marketing Jobs console displays a list of the active Marketing cache for all users of the Marketing 
module.

The cache entries can be seen under the Database Cache heading in the Marketing Jobs view. For 
each cache entry, the following information is provided:

■ Qualified List Item. QLI for which the IDs were cached.

■ User. User who submitted the Marketing job responsible for generating the cache.

■ Sampling Context. Sampling factor used for the request, as indicated in the Segment Designer 
or Segment Tree Designer.

■ Created. Date the cache entry was created.

■ Last Accessed. Most recent time the cached was accessed by a job.

■ Expiration. Date the cache entry will expire.

■ Time to Create. Time required to create the cache entry.

■ Action. Allows the administrator to View Details for the entry or Purge all Cache entries for a user.

■ GUID. Global Unique ID for the Cache entry. This ID is written to the Cache header table for each 
entry.

The console allows the administrator to manually purge cache entries, using one of the following 
approaches:

■ The Purge All Cache link beneath the Database Cache heading will purge all current cache from 
the system.

■ The Purge Cache link in the Action column for a cache entry will purge all Cache entries for a user.

NOTE: This link purges all cache for that user, not just the entry for the link.

Managing Marketing Defaults
The Marketing Defaults page controls the default system parameters for segment and segment tree 
requests. Each parameter is set for each target level. This page allows you to set the following global 
defaults:

■ Default Campaign Load File Format. This option sets the default campaign load format for 
any new segment or segment tree request. When a user creates a new segment or segment tree, 
you can view this parameter on the Advanced page in the Segment Designer or Segment Tree 
Designer.

■ Default Global Audience. This option selects the segment to be used as the automatic Global 
Audience for any new segments or segment trees created using that target level. Users are not 
allowed to remove Global Audiences from their segment or segment tree criteria. For more 
information about Global Audiences, see Siebel Marketing User Guide.

■ Profile Dashboard. This option controls the dashboard that appears when users click the 
Counts link in the Segment Designer or Segment Tree Designer.
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Below the default fields, the view provides a system setting (Enforce Global Audiences in the 
Segment Designer). When this check box is selected, the Global Audience for each Target Level 
automatically appears at the bottom of any segments created in the Segment Designer.

Setting Global Marketing Defaults
This section describes how to set global defaults for campaign load formats, segments, or 
dashboards.

To set Global Marketing Defaults

1 Go to Analytics Web and click the Admin link.

2 In the Siebel Analytics Administration page, click Manage Marketing Defaults.

Target levels appear in the first column.

3 For each Target Level, perform the following steps:

a In the Default Campaign Load File Format, click Browse and select the default format for new 
segments and segment trees.

b In the Default Global Audience field, click Browse and select the default segment for new 
segment trees.

c In the Profile Dashboard field, click Browse and select the default report that appears when the 
user clicks the hyperlinked counts in the Segment Designer or Segment Tree Designer.
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4 Designing Marketing List 
Formats
This chapter contains the following topics:

■ About Designing Marketing List Formats on page 45

■ Designing Marketing List Formats on page 46

■ List Format Column Properties and Formatting Options on page 60

About Designing Marketing List Formats
List Formats allow you to define the layout of files that you can use for a variety of purposes. The 
List Format Designer can be used to select any content from a subject area (list catalog), using filters 
that you add to the list format definition.

The List Format Designer can generate lists for several purposes:

■ List Export. Typically used for campaign distribution lists, such as direct mail, exports to 
external vendors, exports to other IT applications, and other channels. Typically, list formats 
contain the name, customer profile, address, email address, and other information for the 
members of a segment or segment tree cell.

■ Campaign Load. Used to load the members of a segment or a segment tree cell into the 
campaign history table in the Siebel transactional database through EAI.

■ Email Personalization lists for email marketing. Used to export the relevant data for each 
member of an email campaign to the Siebel Email Marketing Server.

■ Customer Synchronization. Used to import a batch of new customers into the Siebel 
transactional database or to update a set of customer profiles through EAI.

■ Analytics Data Load. Used to import any type of data into the Siebel transactional database 
through EAI.

You can combine data from more than one subject area by using the set operation capability in the 
List Format designer. This allows you to combine data from more than one data source into a single 
file. For example, you can combine the list of segment members from your data mart with some 
additional customers that may only exist in your Siebel transactional database. To obtain descriptions 
for commonly used terms, see �Frequently Used Terms for Marketing List Formats� on page 46.

The List Format Designer supports a variety of options to format the content including column sorting 
and casing for each column. For a list of formatting options, see �Column Properties Formatting 
Options� on page 62. 

Navigating to the List Format Designer
Access to the List Format Designer start page depends on your product license key and system 
privileges. You open List Format Designer in one of the following ways:
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■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > List 
Formats.

■ If you log in to the Marketing module directly, you click the Marketing screen tab and then click 
Create a List Format.

Frequently Used Terms for Marketing List Formats
Table 9 on page 46 defines frequently used terms for list formats.

Designing Marketing List Formats
The List Format Designer can generate lists in different formats for the specific purposes. You can 
find examples of each type of list format in the following location:

Shared Campaign Load Formats/Marketing/Example List Formats

Shared List Export Formats/Marketing/Example List Formats

Shared Email Server Formats/Marketing/Example List Formats

Shared Data Load Formats/Marketing/Example List Formats

This section contains the following topics:

■ Defining List Export Formats on page 47

■ Defining Email Personalization (Email Server) Formats on page 49

■ Defining Data Load or Customer Synchronization Formats on page 51

■ Adding Columns to List Formats on page 53

■ Combining Lists From Different Subject Areas on page 55

■ Adding Calculated Fields and System Fields to a List Format on page 55

■ Adding a System Data Expression as a Column in a List Format on page 56

Table 9. Frequently Used Terms for Marketing List Formats

Term Description

Column set A set of columns from a subject area.

Filter (list formats) A criteria added to the list format to constrain the data included in the 
list file.

List catalog A subject area that is enabled for list export.

Data set The result of applying filters to a column set selected from a list catalog.
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Defining List Export Formats
A List Export format defines the customer data and other campaign-related information that is 
exported so that the campaign can be executed. For example, a list export format might provide a 
list file for the following purposes: 

■ Sending a list of customers and addresses to a direct mail vendor for printing and mailing

■ Distributing a call list to employees in a sales organization

■ Exporting the campaign list to another IT application

In addition to using in campaigns, you can define list export formats for a wide variety of uses. The 
only requirement is that the data be accessible by the Analytics Server.

If you are using the standard metadata from the Siebel Analytics Administration Tool for the Siebel 
Data Warehouse, the application provides examples of List Export formats in the following location 
in the Web Catalog:

Shared List Export Formats/Marketing/Example List Formats

To create a list export format and add columns

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, you click the Marketing screen tab and then 
click Create a List Format.

2 From the list of Subject Areas on the right, select a subject area that includes the columns you 
want for your export file. 

NOTE: Be sure to determine whether you want to pull data from the Siebel transactional 
database, the Siebel Data Warehouse, or another data source, and then select the corresponding 
Subject Area.

3 Expand the folders in the selection panel and click each column name to add it to the format. 

4 If you want to modify the displayed name for a column, in the Column Properties dialog box, use 
the Custom Headings option.

5 Click the properties button on a column to apply custom formatting.

For information about column formatting options, see �List Format Column Properties and 
Formatting Options� on page 60.

6 Add any filters that you want to apply to the list format contents every time a list is generated.

NOTE: If the campaign membership already constrains the expected set of output records, this 
step is not required.

7 If you plan to use this export format for campaign execution, add filters to constrain the output 
to a specific campaign wave or set of waves using system data expressions.

8 Click the save icon in the upper-right corner of the screen and follow the instructions in the dialog 
box.
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To add filters to constrain output to the correct campaign waves

1 From the selection panel, add the column that corresponds to the Campaign Wave Id.

2 Select the formula button to add a filter based on the column.

3 In the Edit Filter dialog box, click Add and select System Data.

4 In the System Data list, select the Wave Id expression.

5 Click OK to add the filter.

6 Click the delete button to remove the column from the output columns (unless you want to 
include the Wave Id as an included column).

For information about adding system data expressions, see �Adding a System Data Expression as 
a Column in a List Format� on page 56.

7 Click the save icon in the upper-right corner of the screen and follow the instructions in the dialog 
box.

To set options, headers, and footers for list export formats

1 Click the Options tab and select the following options based on the results you want to achieve:

2 If you want to set up a custom header or footer, click the Headers and Footers tab.

3 Click in the Header Content or Footer Content workspace and add any text you want to include.

4 If required, add any System Data expression, to the header or footer content.

For more information, see �Adding Marketing List Format Headers and Footers� on page 64. For a 
list of system data expressions, see �Adding a System Data Expression as a Column in a List 
Format� on page 56.

5 Test your list format by previewing some sample contents of the list format. 

To preview a list format, see �Previewing a Marketing List Format� on page 63.

6 To combine data from multiple subject areas, click Combine with list from another Subject Area.

For details, see �Combining Lists From Different Subject Areas� on page 55.

NOTE: You must apply column formatting to the combined results. 

Attribute Option

Purpose List Export

(choose format) Delimited File or Fixed 
Width

End of Field Delimiter (any)

Text Qualifier optional

Include Column Headers optional
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7 Click the save icon in the upper-right corner of the screen and follow the instructions in the dialog 
box.

Defining Email Personalization (Email Server) Formats
An Email Personalization format (Email Server format) is used to export the members of an email 
campaign to the Siebel Email Marketing Server. The Email Personalization Format provides the 
columns that can be used as merge fields to personalize the email message sent to each recipient. 
You can find examples of email personalization formats in the following location: 

Shared Email Server Formats/Marketing/Example List Formats

To define an email personalization (server) format

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, click the Marketing screen tab and then click 
Create a List Format.

2 From the list of Subject Areas on the right, select a subject area that includes the columns you 
want for your email server file.

In most situations, the Subject Area corresponds to data pulled directly from the campaign 
history in the Siebel transactional database.

3 Expand the folders in the selection panel and click each column name to add it to the format.

4 Add the columns from the Subject Area that you want to be available as merge fields in the email 
template. 

5 Add the required columns.

The following columns are required for all email server formats:

■ First Name

■ Last Name

■ Email Address

■ Camp Con Id

■ Contact Id

■ Prospect Id

■ Batch Number

NOTE: When you add the Batch Number column, you must include the column in the sort 
order and assign a split value. For more information, see �Adding Columns to List Formats� on 
page 53.

6 Make sure that the displayed name of the column exactly matches the values in the list in Step 3 
on page 49.
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■ If a Subject Area column that you select from the required columns list does not have a 
column label that exactly matches the name in the list, in the Column Properties dialog box, 
use Custom Headings option to modify the heading.

■ You can add additional columns as needed. If you need to modify the displayed name for a 
column, in the Column Properties dialog box, use Custom Headings option.

7 Remove the table heading portion of the column header caption for all the columns.

The Email Marketing Server expects each column header in the email file to contain the column 
header, not the table header caption. For each column in the format, use the following steps to 
remove the table heading portion of the column header caption:

a Select Column Properties on the column.

b In the Column Properties dialog, select the Custom Headings check box.

c Delete the value in the Table Heading field.

d Click OK.

8 Click the properties button on a column to apply any custom formatting that you want for the 
column.

For information about column formatting options, see �List Format Column Properties and 
Formatting Options� on page 60.

9 Add a filter to constrain the output based on the runtime Campaign Wave by adding the system 
data expression (Wave Id) to the column formula in the following steps:

a Add the Wave Id column to the format.

b Click the filter button and add the Wave ID System Data Expression in the filter. 

For details about adding system data expression to a list format, see �Adding a System Data 
Expression as a Column in a List Format� on page 56.

c Click the delete button to delete the Wave ID from the displayed columns.

10 If your email content needs to be filtered based on a secondary Qualified List Item, select the 
the following check box in the Filter section of the Columns view:

Re-qualify list results against original segment criteria

11 If necessary, click the Options tab and select the following options:

12 Test your list format by previewing some sample contents of the list format. To preview a list 
format, see �Previewing a Marketing List Format� on page 63.

Attribute Option

Purpose Email Personalization

(choose format) Delimited File

End of Field Delimiter Comma

Text Qualifier ""
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13 If you want to combine data from multiple subject areas, click Combine with list from another 
Subject Area.

For details, see �Combining Lists From Different Subject Areas� on page 55.

NOTE: You must apply column formatting to the combined results. 

14 Click the save icon in the upper-right corner of the screen.

Defining Data Load or Customer Synchronization Formats
The Analytics data load format is used to import any type of data into the Siebel transactional 
database. The customer synchronization format is used to import a batch of new customers into the 
Siebel transactional database or to update a set of customer profiles. You can find examples of data 
load formats in the following location: 

Shared Data Load Formats/Marketing/Example List Formats

Column Headings Must Match Field Names in Integration Components
If you use one of the standard subject areas provided for data load, the column names are already 
set to match the field names in the Integration Components in the Siebel enterprise application. If 
you want to load data that does not exist in these subject areas, you need to use other subject areas.

CAUTION: Data Load and Customer Synchronization formats must have columns that exactly match 
the fields names of the Siebel integration components where the data is loaded.

If necessary, use Custom Headings in the Column Properties dialog box to rename any columns 
whose label does not exactly match the name of the integration component field name in the Siebel 
enterprise application.

For customer data (Contacts, Accounts, and Prospects), the standard application provides example 
subject areas that are already set up for Analytics Data Load. The standard application provides the 
following three subject areas that can be used for this purpose:

■ Campaign Load - Contacts

■ Campaign Load - Accounts

■ Campaign Load - Prospects

Preconfigured Integration Objects Used in Headers and Footers
The standard Siebel application provides the following preconfigured integration objects that you can 
use in headers and footers:

■ Analytics Account

■ Analytics Contact

■ Analytics Household
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In the standard Siebel repository (SRF file), only certain fields from the extension tables in the 
business objects for Contacts, Accounts, and Households are enabled for update by default using the 
Analytics Data Load process. For example, in the Contacts business component, only the extension 
columns Attribute 49 through Attribute 64 are automatically set up for this purpose. If you need to 
update additional extension columns, confirm that all the business component fields are enabled for 
update through the corresponding Integration Component. 

For more information about the available fields in the Analytics Data Load integration components, 
see �Field Names for Marketing Integration Components� on page 125.

To define data load or customer synchronization formats

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, you click the Marketing screen tab and then 
click Create a List Format.

2 From the list of Subject Areas on the right, select a subject area that includes columns you want 
to load into the Siebel enterprise application.

3 Expand the folders in the selection panel and click each column name to add it to the format.

4 Verify that you have included the required columns for the Siebel Business Component you want 
load. For more information about business components, see Configuring Siebel eBusiness 
Applications. 

5 If necessary, in the Column Properties dialog box, use Custom Headings option to rename any 
columns whose label does not exactly match the name of the integration component field name 
in the Siebel enterprise application. For more information, see �Column Headings Must Match Field 
Names in Integration Components� on page 51.

CAUTION: Data Load and Customer Synchronization formats must have columns that exactly 
match the fields names of the Siebel integration components where the data is loaded.

6 Apply filters to constrain the data you want to load.

For example, if you want to load contacts that have been added to the Data Warehouse since 01/
01/2004, you could add a filter similar to the following:

Contact Created Date is greater than 01/01/2004 12:00:00 AM

7 Click the Options tab and select the following options:

Attribute Option

Purpose Analytics Data Load or Customer Synchronization

(choose format) Delimited File

End of Field Delimiter Comma

Text Qualifier ""

Max # Records 1000
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8 Click the Headers and Footers tab.

9 In the Headers and Footers field, type the integration object name that you want to load using 
the following format. See the following example:

CAUTION: You should not add additional text or a system data expression to the header. 
Additionally, do not press enter at the end of the second line. For EAI formatting, there must not 
be an end-of-line character at the end of the header.

For more information, see �Preconfigured Integration Objects Used in Headers and Footers� on 
page 51.

10 Test your list format by previewing some sample contents of the list format. To preview a list 
format, see �Previewing a Marketing List Format� on page 63.

11 If you want to combine data from multiple subject areas, see �Combining Lists From Different 
Subject Areas� on page 55.

12 Click the save icon in the upper-right corner of the screen.

Adding Columns to List Formats
You select the columns in a subject area to include in a list format. The subject area for the request 
is listed in the selection pane with the tables and columns it contains.

After you have added a column, you can use the buttons on the column to modify the column 
formatting, add a formula, add a filter, or sort or split the contents.

CAUTION: If you click the refresh button in the browser window before you finish creating a request, 
be aware that the browser reloads all frames and deletes your changes.

To add a column to the list format

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, you click the Marketing screen tab and then 
click Create a List Format.

2 Create a new list format or open an existing format.

3 Click columns in the selection pane to add them to the list format definition.

Format Example

# integration object name

#

# Analytics Contact

#
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4 Use the column buttons shown in Table 10 on page 54 to control the use of each column in the 
request.

To sort a list or split a list into multiple files

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, click the Marketing screen tab and then click 
Create a List Format.

2 Locate the column or columns by which you want to sort or split.

3 Use the column buttons described in Table 10 on page 54 to activate sorting or splitting.

Table 10. List Format Button Descriptions

 Button Description

The order by button allows you to include a column in sort order and specifies the order 
in which results should be returned, ascending or descending. The button appears as 
gray (unavailable), up and down arrows if the column has not been added to the sort 
order. When a column is part of the sort order, the button changes to an up or a down 
arrow.

You can order results by more than one column. If you choose more than one column, 
the order sequence number appears on the order by button. To remove or change the 
sort order from a column, click the order by button until the sorting is changed or 
removed.

The properties button lets you edit various format properties for the column. For more 
information, see �List Format Column Properties and Formatting Options� on page 60.

The edit formula button lets you change the column heading, create a formula for the 
column (such as adding a Rank or Percentile function), or add a system data 
expression. For more information, see �Adding Calculated Fields and System Fields to a 
List Format� on page 55.

The add filter button lets you create or edit a filter for the column. For information 
about adding filters to a criteria block, see Siebel Analytics User Guide.

The split button allows you to split the contents of the file by unique values in that 
column. The split button is not available unless the column is part of the sort order. 
When the split is active, a separate file generates for each distinct value for that column 
in the results.

The delete button deletes the column from the request.

The action button opens a menu of available options.
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Combining Lists From Different Subject Areas
You can use a List Format to combine two or more lists from different Subject Areas. For example, 
you can combine a set of customers from your data warehouse with a set of customers from your 
Siebel transactional database.

To combine data sets from multiple subject areas, you select a similar column set from each subject 
area. After you have combined two or more column sets, you can use standard set operators 
(Intersect, Union, Union All, and Minus) to determine the final result set.

Each column set from each subject area must have the same number of columns and the data types 
for corresponding columns must match.

To combine data sets across subject areas

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, you click the Marketing screen tab and then 
click Create a List Format.

2 Select a column set from your first subject area.

3 Add filters to control the contents of the first data set.

4 Click Combine with list from another Subject Area.

5 Select the Subject Area for your second column set. 

6 After you have added all the columns for each column set, click the Combined Results link.

7 Click the buttons on the columns in the Combined Results to control the formatting, sorting and 
splitting of the combined list.

Adding Calculated Fields and System Fields to a List Format
The column formula dialog box allows you to add a calculated column or a column based on a system 
data expression to the list format.

Calculated fields can be created using a wide variety of formulas based on other columns in subject 
area.

System Data are variables that can be added to a list format at run time. For example, if you are 
exporting a campaign file, you may want to include a column displaying the segment for each 
customer in the list. To do this, you add System Data for the Segment Name to the list format, and 
the system determines the correct segment for the file based on the campaign being executed. 
System Data can also be used for filtering the contents of the file based on the context of a campaign 
or other use.
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Adding a System Data Expression as a Column in a List Format
If you want to automatically populate campaign contact columns with values that are determined by 
the list generation process at run time, you need to set up the Campaign Contact columns to use 
system data expressions.

If you use list export format for campaign execution, you can add columns to constrain the output 
using system data expressions.

If you want to add a filter to constrain the output based on the run-time campaign wave, add the 
system data expression wave ID.

To add a system data expression 

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, click the Marketing screen tab and then click 
Create a List Format.

2 In the List Format Designer, select a column from the selection pane.

3 Click the fx button.

4 In the Edit column Formula dialog box, select the Custom Headings check box.

5 Delete the text from the Column Formula workspace.

6 Click the Available System Data link.

7 In the System Data list, select a system data expression. 

For example, if you choose the Campaign Id expression, the following appears

@{campaignID}{0}

NOTE: The value in the braces at the end of the expression is the default value for the 
expression. If you do not provide an input value for the list generation request, the default value 
is used.

8 If you want the System Data Expression column displayed in the file, leave the column in the 
column set at the top of the page.

9 If you want to filter the content but do not want the column to appear, perform the appropriate 
steps from the following list:

■ Add the column.

■ Apply the data expression to the Column Formula.

■ Delete the column from the column set by clicking the delete button on the column.
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System Data Expressions Used in List Format Elements
Each list format element (Column formula, Headers/Footers, and Filters) can contain one or more 
system data expressions. Table 11 on page 57 shows which system data expressions can be used in 
each list format element.

Table 11. System Data Expressions Used in List Format Elements

System Data Expression

Column Formulas

(Y=Supported)

Filters

(Y=Supported)

Headers/Footers

(Y=Supported)

File Size in Bytes Y

Record Count Y

Current Date and Time Y

Current User Y

Bytes per Record Y

Campaign Name Y

Campaign Id Y Y Y

Campaign Source Code Y Y Y

Load Number Y Y Y

Wave Id Y Y Y

Segment Id Y Y

Qualifying Segment Y Y

Segment Tree Path Y Y

Segment Tree Node Path Y Y

Segment Path Y Y

Split Details Y

Token Number Y Y

Email Batch Number Y Y

DNIS Number Y Y Y

File Counter Y

Offer Code Y Y Y

Offer Name Y Y Y
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List Format Types and Valid System Data Expressions
All system data expressions cannot be used with every list format. Table 12 on page 58 contains the 
list formats and shows which system data expressions can be used with each one.

Table 12. List Format Types and Valid System Data Expressions

List Format Type Valid System Data Expressions

Analytics Data Load No System Data Expressions

Customer Sync No System Data Expressions

Campaign Load Campaign Id

Load Number

Token Number

Email Batch Number

Segment Id
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List Export Campaign Name

Campaign Id

Campaign Source Code

Wave Id

Offer Code

Offer Name

DNIS Number

Split Details

File Counter

Record Count

File Size in Bytes

Bytes Per Record

Current Data and Time

Current User

Campaign Name

Campaign Id

Campaign Source Code

Offer Code

Offer Name

DNIS Number

Campaign Id

Segment Id

Wave Id

Table 12. List Format Types and Valid System Data Expressions

List Format Type Valid System Data Expressions
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List Format Column Properties and 
Formatting Options
You can edit properties for a list column to control the appearance and layout of a column and its 
contents. Table 13 on page 62 contains format options and descriptions.

This section contains the following topics:

Email Personalization Campaign Name

Campaign Id

Campaign Source Code

Wave Id

Offer Code

Offer Name

DNIS Number

Split Details

File Counter

Record Count

File Size in Bytes

Bytes Per Record

Current Data and Time

Current User

Campaign Name

Campaign Id

Campaign Source Code

Offer Code

Offer Name

DNIS Number

Campaign Id

Segment Id

Wave Id

Table 12. List Format Types and Valid System Data Expressions

List Format Type Valid System Data Expressions
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■ Editing the Layout of Column Contents on page 61

■ Previewing a Marketing List Format on page 63

■ Adding Marketing List Format Headers and Footers on page 64

■ Options for Marketing List Formats on page 65

Editing the Layout of Column Contents
Use the Column Format tab of the Column Properties dialog box to perform the following tasks:

■ Specify whether the column should appear in results. Columns are usually visible in results 
by default. However, you may want to include a column in your request that you do not want 
displayed in results, such as a column used in creating a filter.

■ Assign alternate table and column headings and apply custom formatting to them. You 
can also use functions and conditional expressions to format results in a variety of ways. Your 
selections apply only to the contents of the column for the request with which you are working.

To hide a column in a report results

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, you click the Marketing screen tab and then 
click Create a List Format.

2 In the List Format designer, click the properties button for a column.

Table 13 on page 62 contains format options and descriptions.

3 In the Column Properties dialog box, in the upper-right corner, select the Hide Column check box.

4 Click OK.

To create or change custom table and column headings

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, click the Marketing screen tab and then click 
Create a List Format.

2 In the List Format designer, click the properties button for a column.

Table 13 on page 62 contains format options and descriptions.

3 In the Column Properties dialog box, in the Headings area, click the Custom Headings check box 
and perform the following steps:
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a To add a custom table heading and column heading name, type new names in the Table 
Heading and Column Heading fields. 

The custom heading is used in this request instead of the default heading. You can also create 
a heading that allows navigation to another request or dashboard. 

b If you do not want any table name to appear in the heading, use a blank name for the Table 
Heading field.

c To change the format of the table heading or column heading, In the Column Format area, click 
the edit format button next to the Table Heading or Column Heading field.

d In the Edit Format dialog box, choose font, cell, border, and advanced style formatting options.

NOTE: You can also specify navigation to another request or dashboard in the Interaction 
area.

4 In the Column Format area, complete the appropriate fields using Table 13 on page 62 as a guide.

5 To control the way the data displays, in the Data Format area, select the Override Default Data 
Format check box and complete the appropriate fields.

6 Click OK.

Table 13. Column Properties Formatting Options

Format Option Description

Headings Headings display as the first row in the file when you select Include 
Column Headers in the List Format options page. By default, the heading 
is Presentation_Table_Name.Presentation_Column_Name.

For a column, you can provide a custom name for the table and column 
portions of the column header. 

Width (for fixed width 
only)

Width specifies the maximum # of characters that can be typed in the 
column.

Alignment (for fixed 
width only)

Justifies the value in the column relative the right and left boundaries of 
the column. The options are Left Justify, Center Justify, and Right Justify. 

Default Value If you type a default value in the Properties dialog box, if the selected 
column has an empty value for a row, the default value is automatically 
inserted.

Shuffle Forward The shuffle forward option makes a column eligible to be moved to the left 
whenever the column to the left of the shuffled column is empty. For 
example if Column 1 has an empty value for a row and Column 2 is 
enabled for Shuffling, the value in Column 2 is written to Column 1.

If multiple columns adjacent to the shuffled column (to the left) are 
empty, the shuffled value slides as far to the left as possible.
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Previewing a Marketing List Format
You can preview the layout of a list format using the Preview tab. To preview the file you provide 
some test parameters for any system data expression or Segments that are used to constrain the 
contents of the list.

To preview a list format

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

Casing Casing controls how capitalization is used in the selected column. The 
following are casing options with examples in parentheses:

■ Upper case (UPPER CASE)

■ Lower case (lower case)

■ Title case (Title Case)

■ Sentence case (Sentence case)

■ No casing (data is not modified from its original form)

Override Default Data 
Format

Allows you to override the default display characteristics. In the column 
Properties dialog box, the selections that appear vary based on the data 
type. For example, if the column contains numeric data, you can choose 
how you want the numbers treated, such as percentages, month names, 
or dates. You can choose the number of decimal places to display, how to 
display negative numbers, the number of digits to show, and the 
thousands separator to use. 

To use a custom format for text, choose Custom Text Format from the 
drop-down list, and then type the custom format.

To create a custom numeric format, you can use the number sign (#) to 
include significant digits, and the number zero (0) to include as many 
digits as specified, even if the number does not contain that detail as 
shown in the following examples:

Specifying ##.# shows 12.34 as 12.3

Specifying ##.000 shows 12.34 as 12.340

Hide Column If you check this option, the column does not appear in the contents of 
the file. However, a hidden column can be used for sorting, splitting and 
shuffling.

Table 13. Column Properties Formatting Options

Format Option Description
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■ If you log in to the Marketing module directly, click the Marketing screen tab and then click 
Create a List Format.

2 In the List Format Designer, select the format that you want to preview.

3 Click the Preview tab.

4 Verify that the Destination Folder Path points to the location where you want to save the preview 
file.

5 In the List Parameters area, click Add.

6 Type a test values for a Segment and/or System Data expression you have used in the format. 
If you have used multiple System Data, you can click Add more than once.

7 To generate a preview list of a few records, click Generate Preview. 

8 Type the number of records you want in the preview.

9 To generate a complete file of all qualifying records, click Generate List File.

Adding Marketing List Format Headers and Footers
Use the Headers and Footers page to add text content to the beginning or end of list files that are 
generated. The content of the header or footer can consist of text plus any System Data expressions 
that you want to include.

To add a header or footer to a list format

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, click the Marketing screen tab and then click 
Create a List Format.

2 In the List Format Designer, select a format.

3 Click the Headers and Footers tab. 

4 Add any text in the Header Content or Footer Content workspace that you want included at the 
beginning or end of the file.

5 Check the Include Headers or Include Footers check box.

6 To add a System Data expression, place your cursor in the Header Content or Footer Content 
workspace, click Available System Data link and select the desired expression.

7 Click OK.
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Options for Marketing List Formats
The Options view tab controls the file type and file formatting for any lists generated using the list 
format.

■ Purpose. The intended use of the List Format. The type you choose determines in which folder 
the list format is saved and where in the Siebel Marketing application the list format is visible. 
For more information, see �About Designing Marketing List Formats� on page 45.

■ Delimited/Fixed Width. Indicates whether the columns in the file contents are delimited using 
a character or use fixed width.

■ End of Field Delimiter. Indicates the character used to delimit the columns in the file. 

If you want to use a special character other than commas, semicolons, spaces, or tabs, select 
Other and type another character in the field to the right of the selection.

■ Text Qualifier. This option wraps the values in each column with a pair of characters. You have 
the option to use double quotes ("") or single quotes ('').

■ Max # Records. This option limits the number of rows that can be written to a single file. When 
the maximum number of records is reached, List Designer starts a new file. The List Designer 
generate additional files until all records are exported.

■ Include Column Headers. When you select this check box, the column labels are included as 
the first row in the file.
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5 Creating Source Code and 
Vendor Profiles
Siebel Marketing uses source code capabilities with exported lists, allowing proper campaign tracking 
and reporting. The source code format can include encoded information about each customer or 
prospect based on any business component field. You can also define and maintain multiple formats 
for use in different campaign scenarios. After you launch the campaign, the source codes assigned 
to each customer can be captured as part of the response and decoded for closed-loop tracking.

Siebel Marketing supports the assignment of source codes to each contact in a campaign. A source 
code appears to the customer as a seemingly indecipherable mix of alphanumeric characters that 
typically can be found on a mailer. Marketers, however, can gather a wealth of information about the 
demographic makeup of the consumer responding to an offer, as well as the particulars of the 
marketing campaign that delivered the promotion, by decoding the source code. 

In a typical scenario, a customer contacts a company�s call center to place an order for merchandise 
or ask questions about an item advertised in a catalog. During the first few minutes of the call, the 
representative asks the customer to read the code that appears on the catalog�s label or order form. 
Depending on the information received, the call center representative may be authorized to present 
to the customer a better offer on the merchandise than the one in the catalog.

The call center representative can also capture the customer�s source code to make sure that the 
marketing organization can make the link that this customer is responding to a direct marketing 
campaign.

In Siebel Marketing, a unique source code is assigned to a marketing program element each time an 
element is created. Marketing program elements include program, stages, segments, campaigns, 
and waves.

NOTE: When marketing programs, segments, and campaigns are created, Siebel Marketing assigns 
a unique source code value to new program stages, segments, and campaigns. Although the stage 
or campaign�s name may be duplicated, the source code field is the actual identifier. If you change 
the system-assigned source code to something more meaningful to you, make sure it is a unique 
value.

Figure 1. Typical Export File Content
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These individual source code components are concatenated and grouped according to the sequence 
and format that you specify in the Source Code Formats view, shown in Figure 1 on page 67, to help 
you track your marketing program and analyze response to campaigns and offers. The source code 
format can contain up to 75 characters and may optionally include other tracking information.

When you load a campaign or generate source codes manually, the source code for each contact is 
assembled, based on the characteristics associated with the target contact in the marketing program. 
For example, the source code for a contact who is in Segment 1 and is in the first wave of Campaign 
1 can be different from the source code for a contact who is in Segment 3 and the second wave of 
Campaign 1.

In addition, you can tailor the contact information that is generated for the distribution list to suit 
your business requirements. At minimum, a list has a contact�s name or some other identifier and a 
source code. It may also contain an address (if you are mailing to the contact), phone number (if 
you are calling the contact), email address, account number, and so on. 

Creating Source Code Formats
The Source Code Formats view allows you to define a source code format, specify the individual 
components that will be included, and determine how these components will be arranged or 
sequenced.

After creating a source code format, you can use the source code in the following ways:

■ Include in an export list.

■ Embed as a personalization element in an email offer.

■ As input in the customer-facing Web Marketing home page (in the applet named Do you have 
another offer?).

■ As a direct input to a response from any of the Response views.

The Source Code Formats list shows available source code formats. The All Components list displays 
details of the source code format selected in the list and is used to create the structure of the source 
code grouping, or format. The All Components list contains the automatically computed length of 
each source code (maximum of 75 characters).

By clicking Move Up or Move Down, you can rearrange components in the format. If you delete 
components (for example, component 2 and component 4 of 5), click the menu button and choose 
Resequence to reorder the remaining components before saving the record.

To create source code formats

1 From the Site Map, choose Administration - Marketing > Source Code Formats.

2 In the Source Code Formats list, create a new record.

3 Type a name and a description for the Source Code Format.

4 When you save the source code format, the new format appears in the Source Code Formats list.
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To define source code format components

1 From the Site Map, choose Administration - Marketing > Source Code Formats.

2 In the Source Code Formats list, select a source code format.

3 In the All Components list, create a new record. 

4 Complete the fields for the component, using the following information as a guide.

Field Description

Attribute Shows the available fields from the business component. For a list of available 
business components, see the Type row in this table.

Default 
Value

Inserted when the input value is NULL. You can provide a default value for any 
source code component. For example, if you included Campaign Member 
Country, you could insert a value for any members with no Country in their 
profile.

Sequence Sequence determines the position of the code component in the source code 
format. Sequence is automatically set when source code components are added 
to the format. Use Move Up, Move Down or Resequence to adjust the order.
Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A ■ 69



Creating Source Code and Vendor Profiles ■  Creating Source Code Formats
5 Save the component.

NOTE: Repeat Step 3 on page 69 through Step 5 on page 70 to add more components, one row 
at a time. 

6 Adjust the sequence of the components by clicking Move Up and Move Down.

To reorder deleted components before saving the changes, click the menu button and choose 
Resequence.

Modifications in the Source Code Format are reflected the next time a program snapshot is built. 
For information about how to associate a source code with a stage, see Siebel Marketing User 
Guide.

Type The Type field shows the business component that will used as the source of the 
field. The supported components are Campaign, Campaign Member, Program, 
Segment, Stage, Wave, and Offer. When you select one of these types, you 
must also select the Attribute. 

The Type field also allows you to insert a Constant, Numeric Sequence, or 
Alphanumeric Sequence.

■ Constant. A fixed value that is the same for all campaign members. You can 
have more than one constant in the source code format. For example, you 
can use a constant to insert a spacing character such as a hyphen (-).

■ Numeric Sequence. Inserts a running count in the source code for each 
campaign member in a campaign wave. The value uses a standard integer 
sequence of 1,2,3...9,10,11....N.

■ Alphanumeric Sequence. Similar to Numeric Sequence, except that the 
values include integers and letters of the alphabet. For example, 
1,2,3....9,A,B,C....,X,Y,Z,10,11, and so on.

The source code generator adds a prefix of zeros (0) to the numeric sequence 
and alphanumeric sequence based on the width of the field. For example, if the 
width is 4, the values will be 0001, 0002, 0003, and so on.

Width The width of the source code component is automatically added. However, you 
can change the width. The maximum width for the entire source code format is 
75 characters. The following is a list of examples:

■ If the source code width for a component is 16 characters and you specify 
6 as the width in this field, the individual source code for the component is 
truncated to the first six characters.

■ If the component�s code has a width of 10 characters, and you specify 20 as 
the width, 10 blank spaces appear in your source code format.

Field Description
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Setting Up Vendor Profiles
Vendors are external partners that receive lists of target contacts when you launch a campaign. Your 
campaign strategy might call for vendors such as call centers, fulfillment centers, and printers to 
split lists of contacts. Some customers would receive a telephone call, others a direct mail offer, and 
a third group would receive promotion samples.

Use the Vendors view to create a library of vendor profiles for your marketing programs. Vendors 
include telemarketers, fulfillment houses, and any other company you retain to help you with 
campaign distribution.

Vendor Tasks
When you launch a marketing campaign, the generated output list is automatically sent to the 
specified vendor using the vendor�s preferred distribution method and communications protocol (File 
Transfer Protocol, email, and so on). 

Before creating a vendor record, make sure the following tasks have been performed:

■ Create Export List Formats. Ask your vendor what format they prefer for the automatically 
generated distribution lists. For example, do they want the list to contain a header or do they 
prefer ASCII (default) or fixed-width output. Then, create an output file layout tailored to the 
vendor�s preferences. 

You will be asked to provide the default export list format when creating the vendor profile. For 
details, see �Designing Marketing List Formats� on page 46.

■ Determine Distribution Method and Create Distribution Profile. As you are creating the 
vendor record, you will need to select a distribution method and a distribution (communications) 
profile for the method. Set up distribution profiles that reflect each vendor�s requirements. 

For example, if your vendor prefers to receive list files using File Transfer Protocol (FTP), you 
would need to set up a communications profile for that vendor containing information about 
HostName, IP Address, Password, and so on. Communications profiles are set up using the 
Communications Administration screen�s Communications Drivers and Profiles view.

If the list files will be sent to the vendor attached to email, set up a communications profile for 
email, and verify that the vendor contact has provided an email address. For more details, see 
�Defining Distribution Profiles for Vendors� on page 72.

If someone in your marketing department will be receiving the distribution list, rather than an 
outside vendor, a vendor record and communications profile that includes the team member�s 
email address should be set up.

Defining Vendors
Use the following procedure to set up profiles for the third-party vendors that will receive the 
distribution list of contacts. If your marketing department is the list recipient, set up a vendor profile 
using the marketing department contact as the vendor.
Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A ■ 71



Creating Source Code and Vendor Profiles ■  Setting Up Vendor Profiles
To define vendors and assign list distribution methods

1 From the Site Map, choose Administration - Marketing screen > Vendors.

2 In the Vendors list, create a new record.

3 Complete the fields for the vendor definition, using Table 14 on page 72 as a guide and save the 
record.

NOTE: If one vendor can handle multiple list formats, such as a direct mail format and a telWeb 
Marketing format, create separate vendor profiles for each type. For example, the profiles might 
be named: Ace Fulfillment: Direct Mail, and Ace Fulfillment: TelWeb Marketing.

Defining Distribution Profiles for Vendors
Use the Communication Administration screen�s Drivers and Profiles view to define communications 
profiles for email, fax, and FTP distribution of lists to vendors. Output file layouts and vendor profiles 
must be defined for all types of lists. If you are using email or FTP, you must also define Email 
Address, Distribution Method, and Distribution Profile in the Vendor profile. For more information 
about using delivery profiles, see Siebel Marketing User Guide.

Siebel Marketing provides default drivers in its library that can be modified for use when sending files 
to a vendor. A system or marketing administrator can create distribution profiles for each of these 
driver types that override the default parameters for that driver. For more information about 
communications drivers and profiles, see Siebel Communications Server Administration Guide.

Table 14. Vendors View Fields

Field Comment

Contact Name Select the contact name, if it exists. If the contact does not appear in the 
list, add the relevant information using the All Contacts list. 

By default, the system looks for the email address in the EMAIL_ADDR 
column of the S_CONTACT table. If you store the email address in a 
different column, see Siebel Communications Server Administration Guide 
to configure the Recipient Email Address field.

Distribution Method Choose the method that describes how the distribution list will be sent to 
the vendor.

Distribution Profile Choose from the list of predefined distribution profiles. Distribution Profiles 
are defined using the Administration - Communications > Communications 
Drivers and Profiles view.

Email Address The email address for the vendor is automatically added if it was defined 
for the selected vendor contact. You cannot add the email address in this 
view.

If you plan to send a generated list to the vendor using email, you must 
add the email address for the contact in the All Contacts or My Contacts 
view. 
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6 Designing Marketing Campaign 
Load Formats
This chapter contains the following topics:

■ Creating and Testing Campaign Load Formats on page 73

■ About Marketing Integration Objects on page 79

Creating and Testing Campaign Load 
Formats
Campaign load formats define the way campaign-related data is copied from a marketing data source 
into the Siebel transactional database for launching a campaign. You must define campaign load 
formats for your marketing data sources before you can use Siebel eBusiness Application Integration 
(EAI) technology to import this information. For example, contact information such as first and last 
name, phone number, and email address can be brought into the Siebel database during campaign 
load only if you define campaign load formats for this data. The Campaign Load workflow process is 
used to manage the load process.

For information about creating a campaign load format for the Siebel Data Warehouse, see �Examples 
of Recommended Campaign Load Mappings� on page 85.

This section contains the following topics:

■ Creating Campaign Load Formats on page 73

■ Testing Campaign Load Formats on page 78

Creating Campaign Load Formats
Before you begin creating campaign load formats, make sure the subject area in the Analytics 
Administration Tool includes the required fields to load new customers and execute your campaigns. 
For example, if you are loading contact data, you need to verify that the Subject Area used for the 
Campaign Load Format includes Contact First Name, Middle Name, Last Name, and so on. For more 
information about creating Subject Areas for list formats, see Siebel Analytics Server Administration 
Guide.

Creating campaign load formats requires that you complete all of the following tasks that are 
described in this section:

■ Create a campaign load format and add columns. Campaign load formats have columns that 
are always required, regardless of the type of customer data such as contacts, accounts, or 
prospects being loaded.
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■ Enable system data expressions for required columns. Several of the required Campaign 
Contact columns need to be automatically populated with values that are determined by the list 
generation process at run time. To accomplish this, you set up the Campaign Contact columns to 
use system data expressions.

■ Supply Integration Ids. Every campaign load format requires an integration ID (referred to as 
Key 1) that supplies the enterprise-wide ID representing that customer. For example, most 
corporate data warehouses already have unique customer Ids assigned as the enterprise 
customer ID. Campaign load expects this column to be included in the campaign history.

■ Requalify list results against original criteria. The members of the campaign load file must 
be evaluated against the segment criteria when generating the campaign load file. This option 
allows you to limit the information in the list file only to members of the segment (and any 
Qualified List Items constrained on the segment tree).

■ Set options, headers, and footers for campaign load formats. In the header, you can add 
an integration object name but you should not add a system data expression.

To create a campaign load format and add columns

1 Using one of the following methods, navigate to the List Designer start page:

■ In the Siebel Marketing application, from the Site Map, choose Administration - Marketing > 
List Formats.

■ If you log in to the Marketing module directly, click the Marketing screen tab and then click 
Create a List Format.

2 From the list of Subject Areas on the right, select a subject area that includes the required 
columns for your campaign load format.

The standard application provides some subject areas for this purpose, including the following:

■ Campaign Load - Contacts

■ Campaign Load - Accounts

■ Campaign Load - Prospects

NOTE: Your administrator might have added additional subject areas.

3 Expand the folders in the selection panel and click each column name to add it to the format. 

4 Verify that you have included the required columns for each integration object and integration 
component, based on the type of party being loaded (contacts, accounts, or prospects).

NOTE: The column label must exactly match the field name of the integration component in the 
Siebel enterprise application repository (siebel.srf). For information about required integration 
component fields, see �Enabling and Synchronizing Marketing Server Components� on page 12 and 
�Field Names for Marketing Integration Components� on page 125.

a To rename a column label that does not exactly match the field name of the integration 
component, click the properties button.
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b Select the Custom Headings option.

If you use one of the standard subject areas listed in Step 2 on page 74, the column names 
matches the field names in the integration components in the Siebel enterprise application.

c Type the necessary table and column heading. 

The table heading should match the integration component name and the column heading 
should match the field name.

5 Select the following required columns to add them to the campaign load format:

a From the Contact folder, add the Person UId column.

b From the Campaign Contact folder, add the following columns:

❏ Campaign Id

❏ Segment Id

❏ Load Number

❏ Token Number

❏ Scalability Batch Number

❏ External Key. The key (or keys) to be mapped depends upon the party being loaded. 
Table 15 on page 75 shows the mappings used in the preconfigured reports.

To enable system data expressions for required columns

1 Click the properties button on the column.

2 In the dialog box, first click the Custom Headings check box. 

This makes sure the table and column name are not changed when you modify the formula in 
Step 3 on page 75.

3 Clear the current formula from the Column Formula box.

4 Place your cursor in the Column Formula box, then click the Available System Data link.

Table 15. External Key Mappings

Type of Party Key Party Id Map to this Column Id

Contacts Key 1 Contact Id Contact.ROW_ID

Accounts Key 1 Contact Id Contact.ROW_ID

Accounts Key 2 Account Id Account.ROW_ID

Prospects Key 3 Prospect Id Prospect.ROW_ID
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5 Select the appropriate system data expression from the following list:

The expression is added to the formula. For example, the Campaign ID column would show the 
following formula: 

@{campaignID}{0}

NOTE: If you get an error message in the Formula dialog box, ignore the error. 

6 Click OK.

To assign integration Ids

1 Choose the Column from the Subject Area that provides the Integration ID for the Contacts 
Target Level.

2 Select the column in the right pane.

3 Click the formula button in the column.

4 Check the Custom Headings box.

5 Delete the existing formula and replace it with the appropriate value from Table 15 on page 75.

6 Click OK.

To requalify list results against original criteria

1 In the Columns view, in the Filters pane, select the following check box:

Re-qualify list results against original segment criteria

2 The following line is automatically added to the filter criteria:

Re-qualified against original segment criteria

Column Corresponding System Data Expression

Campaign Id Campaign Id

Load Number Load Number

Scalability Batch Number Email Batch Number

Segment Id Segment Id

Token Number Token Number

Scalability Batch Number Email Batch Number
Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A76 ■



Designing Marketing Campaign Load Formats ■  Creating and Testing Campaign Load
Formats
To set options, headers, and footers for campaign load formats

1 Click the Options tab and select the following options:

2 Click the Headers and Footers tab.

3 Type the integration object name that you want to load, using the following format (example also 
shown):

CAUTION: You should not add additional text or a system data expression to the header. 
Additionally, do not press enter at the end of the second line. For EAI formatting, there must not 
be an end-of-line character at the end of the header.

4 Verify your campaign load format by previewing some sample contents of the list format.

NOTE: For instructions about how to preview a list format, see �Previewing a Marketing List 
Format� on page 63.

5 When you obtain the expected results, click the save icon to save your work.

Siebel Contact and Campaign History Tables
When you load a campaign, the Campaign Load workflow process modifies data in the Siebel 
database after Contact and Contact Key integration components are mapped and campaign load 
mapping data is modified.

■ Contacts table (S_CONTACT). The Contacts table stores contact-level information.

■ Campaign History table (S_CAMP_CON). The Campaign History table contains the history of 
contacts that qualify for campaigns, as well as the Campaigns ID, Segment ID, Wave Number, 
and so on. 

If you include optional integration component fields such as Account or Contact Address in the 
campaign load format, other Siebel tables are updated with data according to the integration fields 
that are mapped.

Attribute Option

Purpose Campaign Load

(choose format) Delimited File

End of Field Delimiter Comma

Text Qualifier ""

Max # Records 1000

Format Example

# integration object name

#

# Marketing Contact

#

Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A ■ 77



Designing Marketing Campaign Load Formats ■  Creating and Testing Campaign Load 
Formats
For every record that qualifies for a campaign, the Campaign Load process uses the Contact 
component user key to determine if the contact record exists. Table 16 on page 78 contains the table 
update rules.

NOTE: If you use the Marketing Contact integration object, the lookup uses the User Key fields for 
Contacts and Accounts. Figure 2 on page 81 shows the integration components for the Marketing 
Contact integration object. If you use the Marketing Person integration object, the lookup only 
requires the Campaign Id, Load Number, Token Number, Contact Id, or Prospect Id to confirm that 
the person is present in the transaction database.

Testing Campaign Load Formats
To verify that you have created a valid Campaign Load Format, it is recommended that you build a 
test campaign and test segment. 

To test your campaign load mapping

1 Verify that you have included the minimum required fields for each integration component.

For more information, see �About Marketing Integration Objects� on page 79.

2 Confirm that the Campaign Load Format includes the required columns for all formats:

■ Campaign Id

■ Segment Id

■ Load Number

■ Batch Number

■ Token Number

3 Confirm that the parent integration component is mapped for every child component. For 
example, if you included Account Address fields, ensure that you also included Account Name 
and Location. 

4 Create a test segment using the Segment Designer. For the segment, go to the Advanced Options 
tab and change the Campaign Load List Format to use your new Campaign Load Format. Save 
the segment.

5 Create a new campaign under the Campaigns screen tab. 

Table 16. Campaign Load Table Update Rules

Siebel Contact 
Record S_CONTACT S_CAMP_CON

Exists Update existing record Insert new record

Does not exist Insert new record Insert new record
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6 In the Design > Segments/Lists view for the Campaign, click Add Segment to choose your test 
segment.

7 Select the menu on the upper form for the campaign and select 'Load Campaign'. In the dialog 
box, confirm the load time and click OK to submit.

8 Navigate to the Execute > System Tasks view to monitor whether the Campaign Load task 
successfully completed. Investigate any error messages that appear in the Task Log.

9 After the load completes successfully, validate that the data loaded matches the expected 
information.

a While your campaign is still selected, navigate to All Contacts/Prospects across Organizations 
and query for all the campaign members for that Load Number. If desired, export these rows to 
a file using the Export menu option.

b Go to Site Map > Administration - Marketing > Marketing Server Admin > Manage Marketing 
Jobs. Find the Marketing Job that you generated with the type WriteListFiles. Open the details 
link and find the network path to the file that was generated.

c Compare the contents of the file and the data that was loaded into your campaign to confirm 
that the data was complete and correct.

10 Make any changes required to the Campaign Load Format using the List Format Designer. Be sure 
to save any changes to the Format.

11 When completed, purge the load history by performing the following steps:

a From the Site Map, choose Campaigns and drill down on the campaign.

b In the Execute tab, click Suspend Wave.

NOTE: You need to suspend the waves in the load before you can purge a load.

c In the Execution Status view, click Purge Load, and then delete your test campaign.

About Marketing Integration Objects
For each campaign load format, you must select only one of the following integration objects:

■ Marketing Contact integration object. If any campaign contact names do not exist within the 
Siebel transactional database, you must use the Marketing Contact integration object. It provides 
the field mappings necessary to import new contacts and accounts. For more information, see 
�About the Marketing Contact Integration Object� on page 80.

■ Marketing Prospect integration object. If any prospect names from your target segment do 
not exist within the Siebel transactional database, you must use the Marketing Prospect 
integration object. It provides the field mappings necessary to import new prospects. For more 
information, see �About the Marketing Prospect Integration Object� on page 83.
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■ Marketing Person integration object. If all your campaign contacts and prospects exist within 
the Siebel transactional database prior to loading any campaigns, then you can also use the 
Marketing Person integration object. Typically, this configuration occurs for installations that use 
the Siebel Data Warehouse populated from the Siebel transactional database and that do not 
introduce new customers into the Siebel Data Warehouse from other sources. Because the 
contact and prospect field information is already recorded, to load the campaign in this 
configuration, you only need to map the Contact and Prospect IDs between the data warehouse 
and Siebel transactional database. For more information, see �About the Marketing Person 
Integration Object� on page 84.

The application does not provide an integration object that can insert new contacts and prospects 
simultaneously in the same load.

This section contains the following topics:

■ About the Marketing Contact Integration Object on page 80

■ About the Marketing Prospect Integration Object on page 83

■ About the Marketing Person Integration Object on page 84

■ Examples of Recommended Campaign Load Mappings on page 85

About the Marketing Contact Integration Object
The Marketing Contact integration object provides field mappings to typical contact- and account-
related information from the external data sources. The predefined integration object, Marketing 
Contact, defines the information that is exchanged between the external data source and Siebel 
Marketing, using EAI technology. For more information about EAI, see Overview: Siebel eBusiness 
Application Integration Volume I. For a list of fields for the Marketing Contact integration object, see 
�Field Names for Marketing Integration Components� on page 125.
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Figure 2 on page 81 shows the integration components for the Marketing Contact integration object. 
Required fields apply when a new contact is inserted into the Siebel transactional database.

During campaign load, integration component User Keys determine if a record already exists in the 
component (for the given values) and if the record is unique. Required fields cannot be a null value 
for the new record.

Table 17 on page 81 describes the Marketing Contact integration components.

Figure 2. Marketing Contact Integration Components

Table 17. Marketing Contact Integration Component Description

Component Comment 

Account Maps account information associated with the contact.

Account Address Maps the account address.
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Mapping Rules for the Marketing Contact Integration Components
Using contact information for campaign load requires the following integration components:

■ Contact. Includes information such as contact first name, contact last name, and so on.

■ Campaign Contact. Fields must be mapped in the campaign load report. Mapping includes the 
required campaign load columns and the keys that store unique IDs from the data warehouse for 
the party (contacts, prospects, or accounts) being loaded.

Use the following rules when mapping components:

■ A parent integration component must be mapped before mapping a child component. For 
example, the Account Address component cannot be mapped unless Account is mapped.

■ User Key fields must be mapped for each integration component if one or more fields for the 
component is mapped.

■ Required fields must be mapped for each integration component if one or more fields for the 
component are mapped.

■ Make sure that the campaign load format includes a column indicating the Siebel Systems 
organization in which the contact and account data should be loaded.

Sample Mappings for Contact Key Components
The combination of keys that are mapped in the campaign load report depend upon the target levels 
that you use.

Account 
Organization

Maps information about the account�s organization.

Campaign Contact Maps campaign history-level information such as campaign Id, load number, 
wave number, contact Id, prospect Id, account Id, and the keys that bind 
Siebel contacts with their unique IDs in the data warehouse. 

Contact Maps contact-level information such as the contact�s name, telephone 
number, email address, and so on.

Contact Address Maps the contact�s address information.

Contact 
Organization

The Contact Organization component maps information about the contact 
organization.

Table 17. Marketing Contact Integration Component Description

Component Comment 
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Table 18 on page 83 describes examples of Key mappings for sample target levels.

About the Marketing Prospect Integration Object
The Marketing Prospect integration object provides field mappings to typical prospect information 
from marketing data source(s). The required fields are fields that cannot be a null value for the new 
record.

Figure 3 on page 83 shows the integration components for the Marketing Prospect integration object. 
Required fields apply when a new prospect is inserted into the Siebel transactional database.

Because prospects are all held in a single base table and a single corresponding business component, 
there are two user keys to validate when creating a campaign load format based on Marketing 
Prospect. For a list of fields for the Marketing Prospect integration object, see �Field Names for 
Marketing Integration Components� on page 125.

Table 18. Key Mappings for Sample Target Levels

Target Level Key Mapping

Contacts Key 1

Accounts Key 2

Prospects Key 3

Households Key 4

Figure 3. Marketing Prospect Integration Components
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Table 19 on page 84 describes the Marketing Prospect Integration components.

NOTE: Required fields apply when a new contact is inserted into the Siebel transactional database.

Mapping Rules for the Marketing Prospect Integration Components
Using prospect information for campaign load requires the following integration components:

■ Prospect. Includes information such as prospect first name, prospect last name, and so on.

■ Campaign Contact. Fields must be mapped in the campaign load report. Mapping includes the 
required campaign load columns and the keys that store unique IDs from the data warehouse for 
the prospects being loaded.

About the Marketing Person Integration Object
Most deployments of the Siebel Marketing application use the Marketing Contact Integration Object 
for loading campaign data. Marketing Contact Integration Object is most commonly used because it 
supports inserting new contact and account names into the transaction database. When all the 
customer data resides in the Siebel transaction system, the load process can avoid inserting new 
customers and improve the load time. The Marketing Person integration object supports this simple 
lookup load process.

The Marketing Person integration object should be used only when all target contacts, accounts and 
prospects in the campaign already exist in the transaction database. The only required mapping is 
between the Row ID from the Contact and Prospect tables in the Siebel transactional database and 
the external data source, typically the Siebel Data Warehouse. For a list of fields for the Marketing 
Person integration object, see �Field Names for Marketing Integration Components� on page 125.

Table 19. Marketing Prospect Integration Component Description

Component Comment 

Campaign Contact Maps campaign history-level information.

■ User Key: Campaign Id, Load Number, and Token Number

Prospect Maps prospect information. 

■ User Key: Prospect Contact UId

■ Required fields: First Name, Last Name, and Prospective Contact 
UId
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Figure 4 on page 85 shows the integration components for the Marketing Person integration object. 
Required fields apply when a new campaign contact record is inserted into the Siebel transactional 
database.

Table 20 on page 85 describes the integration component for the Marketing Person integration object.

Mapping Rules for the Marketing Person Integration Components
When creating a campaign load mapping using the Marketing Person integration object, use the 
following guidelines:

■ The Contact Id and Prospect Id values imported from the external data source must match the 
Row IDs for the Contact or Prospect in the Siebel contact or prospect tables.

■ If all incoming target names are contacts, then you do not need to map Prospect Id. Alternatively, 
you might use the Marketing Contact integration object. If all incoming target names are 
prospects, then you do not need to use Contact Id. If the target list includes both contacts and 
prospects, then both fields are required.

Examples of Recommended Campaign Load Mappings
Campaign Load Mappings depend on the following:

■ The Data source. The data source includes Siebel Data Warehouse, Siebel transactional 
database, or a data source other than Siebel applications.

■ The Data elements required to be imported into Siebel. These elements include Contact 
fields, Account fields, Contact address, and so on.

Figure 4. Marketing Person Integration Components

Table 20. Marketing Person Integration Component Description

Component Comment 

Campaign Contact Maps the required campaign history columns and keys 
that store the unique IDs from the data warehouse for the 
party being loaded.

User Key: Campaign Id, Load Number, Token Number, and 
one or more of the following:

■ Contact Id

■ Prospect Id
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■ Contact Qualification. Determine if new contacts or existing contacts qualify for a campaign.

■ Presence of contacts and prospects in the Siebel database. Determine if all contacts and 
prospects are already present in the contact and prospect tables in the Siebel database.

This section contains descriptions of mappings with the name of the sample campaign load format 
report in which the recommended mappings appear.

Examples of Mappings to the Siebel Data Warehouse
These mappings are applicable when campaigns are run against Siebel Data Warehouse.

■ Recommended Mappings for Existing Contacts And Prospects. See the following sample 
campaign load format report:

Campaign Load - Contacts and Prospects Example

■ Recommended Mappings for Existing Accounts. See the following sample campaign load 
format report: 

Campaign Load - Existing Accounts

Examples of Mappings to the Siebel Database
The mappings shown in the following reports are applicable when campaigns are run on the Siebel 
Systems database.

■ Recommended Mappings for Contacts And Prospects. See the following sample campaign 
load format report: 

Campaign Load - Contacts and Prospects Example

■ Recommended Mappings for Accounts. See the following sample campaign load format 
report: 

Campaign Load - Existing Accounts

Examples of Mapping to a Non-Siebel Database
The mappings shown in the following reports are applicable when campaigns are run on a non-Siebel 
Systems database.

■ Recommended Mappings for New Contacts. This is for cases where some of the contacts 
being loaded for the campaign are not existing in the Siebel database. See the following sample 
campaign load format: 

Campaign Load Contacts - Example

■ Recommended Mappings for New Accounts. This is for cases where some of the accounts 
being loaded for the campaign are not existing in the Siebel database. See the following sample 
campaign load format: 

Campaign Load Accounts - Example
Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A86 ■



Designing Marketing Campaign Load Formats ■  About Marketing Integration Objects
■ Recommended Mappings for New Prospects. This is for cases where some of the prospects 
being loaded for the campaign are not existing in the Siebel database. See the following sample 
campaign load format: 

Campaign Load Prospects - Example
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7 Installing and Configuring Email 
Marketing
This chapter contains the following topics:

■ About Installing and Configuring Siebel Email Marketing on page 89

■ Siebel Email Marketing Architecture on page 94

■ Requirements for Installing Email Marketing on page 96

■ Installing the Email Marketing Server on page 98

■ Configuring Email Marketing Daemons on page 102

■ Final Test of Email Marketing Components on page 113

About Installing and Configuring Siebel 
Email Marketing
The Siebel Email Marketing Server is a combination of components designed to support high volume, 
personalized email messages and track email bounces and click-through responses. The Siebel Email 
Marketing Server consists of the following three components, each with its own installer and each is 
separate from the Siebel Marketing Server installer:

■ The Email Sending Daemon (ESD). Assembles each outbound email message for a campaign 
using the email template (HTML or text) and the recipient list, and then sends each message to 
your company's outbound MTAs for delivery.

■ The Bounce Handler Daemon (BHD). Tracks email messages that cannot be delivered, parses the 
returned email messages, and records the cause of the bounce.

■ The Click-Through Daemon (CTD). Tracks clicks made by the email recipient on any Siebel-
supported hyperlinks included in the email template.

This section contains the following topics:

■ Example of Email Delivery on page 90

■ The Siebel Email Marketing Server Installation on page 90

■ Email Sending Daemon (ESD) on page 91

■ Bounce Handler Daemon (BHD) on page 91

■ Click-Through Daemon (CTD) on page 92

■ Frequently Used Terms for Email Marketing on page 93
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Example of Email Delivery
It is important to understand email delivery so that you will understand the key principles and items 
discussed in this chapter. The example in this section is a simplified description of the email delivery 
process and describes one email being sent. When users send thousands or millions of emails, the 
process becomes more complex. Siebel Email Marketing is designed to address the issues associated 
with sending a large volume of emails.

When an email is sent by person A to person B, an attempt is made to deliver the email. The first 
step in the process occurs when the user clicks Send in their email client. The email client tries to 
initiate a connection to an email server. 

NOTE: This email server is often called a Mail Transfer Agent (MTA) because of its function or a 
Simple Mail Transfer Protocol (SMTP) Server because of the protocol it uses. 

When the client has a connection to a Mail Transfer Agent, the Mail Transfer Agent and the client 
communicate using the Simple Mail Transfer Protocol. The following are important parts of this 
communication:

■ One critical piece of this communication involves the transfer of the email message to the Mail 
Transfer Agent. 

■ Another piece of this communication is the passing of the sender's email address. This email 
address is often referred to as the SMTP envelope from (or sender) address. The use of the term 
envelope represents the email content as a letter and the SMTP communication as the envelope 
used to carry the letter.

If the recipient of the email (person B) has their mailbox on this server, then the server drops the 
email in the box and the job is done. If person B is on another domain, the Mail Transfer Agent 
executes a Domain Name Service (DNS) lookup to find the address of another Mail Transfer Agent to 
communicate with. Another Simple Mail Transfer Protocol conversation occurs and the second Mail 
Transfer Agent receives the message and delivers it to the mailbox for person. When it is in person 
B's mailbox, they will be able to retrieve it using another protocol such as Post Office Protocol (POP) 
and read the message in their email client. 

A number of unexpected issues can occur during this process. For example, the domain of the 
recipient can be unreachable or not exist at all. In this case, an error message, or bounce, is created 
by the Mail Transfer Agent that identifies the problem and the bounce is returned to the sender of 
the message (the sender�s email address is also called the from address of the SMTP envelope). 
Another problem might be that the domain has been found but the user does not exist on that 
domain. Again, a bounce is created and sent back to the sender of the original message. Both of 
these are examples of hard bounces. This means that not only was the email unable to be delivered 
but that it will never be delivered. Another type of bounce is a soft bounce, which means that 
although the email could not be delivered at present, it may be possible to deliver the message in 
the future.

The Siebel Email Marketing Server Installation
The Siebel Email Marketing Server consists of three components, each of which comes with its own 
installer and is separate from the Siebel Marketing Server installer. The installation media for the 
three Email Marketing Server components are distributed together on media separate from the 
Siebel Enterprise installation media.
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The following is a summary of the issues to consider when installing the different components of 
Siebel Email Marketing. The Email Marketing components can reside outside the firewall, with ports 
opened for SISNAPI, SOAP (HTTP), and networked file system access through the firewall. 
Alternatively, the Email Marketing components can reside inside the firewall with ports 80 and 25 
opened on the firewall (or proxies) or relays put in place.

These components talk to the Siebel Marketing Server using the Siebel Java Data Bean over the 
Siebel Internet Session API (SISNAPI). For additional information about the Siebel Java Data Bean, 
see the topic about integrating with the J2EE Application server in Transports and Interfaces: Siebel 
eBusiness Application Integration Volume III.

Email Sending Daemon (ESD)
The Email Sending Daemon assembles an email to be sent to a list or segment of contacts and 
prospects and delivers each email to the corporate outbound Mail Transfer Agents. Assembly includes 
adding headers in front of the email message content and merging personalized data into the 
message content. 

The Email Sending Daemon listens on port 80 for SOAP requests from the Siebel Marketing Server. 
A SOAP request includes the filename of the email message content, the email message headers, 
and the Marketing Server subwave contacts and prospects list (containing mail merge data). These 
files are found in the Marketing File System which is commonly a networked directory accessible to 
the Email Sending Daemon. The Email Sending Daemon must be able to communicate with one or 
more outbound Mail Transfer Agents in order to send mailings over the internet. The Email Sending 
Daemon must be able to tell the Marketing Server when it has completed a subwave as well as deliver 
details of email address errors that occurred while it communicated using Simple Mail Transfer 
Protocol to the Mail Transfer Agents (called synchronous bounces). Communications with the Siebel 
Marketing Server use SISNAPI protocol.

The most common placement for the Email Sending Daemon is within the corporate network, behind 
the DMZ. However, the Email Sending Daemon component can be placed inside the DMZ or outside 
the firewall, if there is a port opened to connect to the Siebel Marketing Server using SISNAPI 
protocol, SOAP, and the networked Marketing File System.

Bounce Handler Daemon (BHD)
Typically, the Bounce Handler Daemon receives and processes bounced mail on port 25 (the default 
SMTP port). 

Email messages that have bounced appear similar to regular email, though their email message 
content and headers probably have noticeable differences in content. For a bounced email to be 
returned to the Bounce Handler Daemon, the original email must have a usable return address (the 
SMTP envelope from address). The correct SMTP envelope from address is generated for you using 
the Bounce Handler Daemon's domain name (supplied by you when you configure the Email 
Marketing Server).

The recommended approach is to place the Bounce Handler Daemon machine in the DMZ. However, 
some network support technicians may want to place the Bounce Handler Daemon behind an inbound 
Mail Transfer Agent. The approach that you choose depends on the configuration of your network, 
DMZ, existing inbound Mail Transfer Agent, and firewall. The following example describes a typical 
approach:
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You might have a domain name of siebel.com and an inbound Mail Transfer Agent (in this example 
mail.siebel.com) for mail to that domain. The Mail Transfer Agent mail.siebel.com currently routes 
email successfully to machines in the internal network. It might be in the DMZ with a special hole 
for port 25 traffic or straddling the outer firewall with one NIC in the DMZ and the other NIC on the 
Internet. The Bounce Handler Daemon might be running inside the DMZ, with an internal-only 
hostname such as siebel-host.internal.siebel.com.

In this example, you would need to choose a Bounce Handler Daemon hostname such as 
bounces.siebel.com that is not already used by external DNS and then and perform the following 
steps:

■ Configure the Bounce Handler Daemon to use this hostname. 

■ Add a DNS MX record for this hostname to an internal DNS server that can be contacted by the 
inbound Mail Transfer Agent (mail.siebel.com).

■ Add this hostname to the Internet DNS servers as a hostname with an IP address for the inbound 
Mail Transfer Agent. 

Because the Internet DNS MX records for bounce.siebel.com point to the inbound Mail Transfer 
Agent, all bounced email for the Bounce Handler Daemon will be sent there first. Mail.siebel.com 
should be configured to relay all the mail for bounces.siebel.com to the Bounce Handler Daemon 
using the internal DNS server for the correct internal IP address.

It is common for an organization to have unroutable IP numbers within their enterprise. For example, 
IP numbers starting with 10.* or 192.168.* are only available inside the enterprise. Similarly, 
organizations often have hostnames, such as my-machine.corp.siebel.com, that are only visible 
inside the company network. If you use an IP address or hostname that is only available inside your 
company network for your Bounce Handler Daemon hostname, Mail Transfer Agents outside your 
network will not be able to connect to the Bounce Handler Daemon. Therefore, the Bounce Handler 
Daemon server must be available, directly or indirectly, from outside your network.

Click-Through Daemon (CTD)
The Click-Through Daemon listens on port 80 for HTTP requests (Click-through, Message Open, 
Forward to a Friend and un-subscription/subscription requests). This component can be placed in the 
DMZ, inside or outside the firewall, if a port is opened that allows it to connect to the Siebel Marketing 
Server using SISNAPI protocol. Web proxy servers can be used to route the HTTP requests to the 
Click-Through Daemon server. 
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Frequently Used Terms for Email Marketing
Table 21 on page 93 contains acronyms and terms frequently used in Email Marketing.

Table 21. Frequently Used Terms for Email Marketing

Acronym or 
Term Definition

BHD Bounce Handling Daemon. Processes asynchronous bounced email (bounces that 
do not occur in the SMTP communications between the Email Sending Daemon 
and the Mail Transfer Agent).

Bounce An email that is returned due to a temporary or permanent error condition. There 
are hard bounces and soft bounces as described in the following list:

■ Hard bounce. The email was not delivered and will never be delivered. For 
example, if the email address is invalid.

■ Soft bounce. The email cannot be delivered because of a temporary problem 
such as a full mailbox and can be delivered when the problem no longer 
exists.

CTD Click Through Daemon. Handles the following customer actions:

■ Unsubscribe and Subscribe allows contacts to opt in or opt out of email lists.

■ Forward to a Friend provides method for capturing new email addresses.

■ Related URLs track customer clicks an embedded link in an email.

■ Read Receipts logs message opens.

Daemon A program that is not invoked explicitly, but lies dormant waiting for an action or 
event to activate it.

DNS Domain Name System. Created to provide a way to translate domain names to 
their corresponding IP addresses. The DNS server maintains a list of domain 
names and IP addresses and each request is pointed to the correct corresponding 
IP address.

DMZ DeMilitarized Zone. A section of your corporate network that acts like a neutral 
zone or buffer between your internal network and the Internet. It is created by 
placing one firewall between this section of your network and the internal 
network, and another firewall between this section of your network and the 
Intranet. External users can access servers in the neutral zone, but not servers 
on the internal network. The servers in the DMZ handle incoming and outgoing 
traffic.

DNS groups DNS domain names are categorized into groups called a record and each record 
is given a special name such as MX or A.

■ MX (type of record). Specifies a domain name which can receive and possibly 
relay emails. This domain probably contains a server hosting an MTA.

■ A (type of record). Maps a domain name to an IP address.
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Siebel Email Marketing Architecture
Figure 5 on page 95 is an example of a typical architectural structure for Siebel Email Marketing 
components and shows how the components interact with Siebel Marketing.

ESD Email Sending Daemon. Manages the following tasks:

■ Email Construction and Personalization.

■ Round-robin delivery of outbound email to Mail Transfer Agents.

■ Synchronous bounced email. Bounces that occur in the SMTP conversation 
between the Email Sending Daemon and the MTA.

MTA Mail Transfer Agent. A program responsible for receiving, routing, and delivering 
email messages. MTAs receive email messages and recipient addresses from local 
users and remote hosts, perform alias creation and forwarding functions, and 
deliver the messages to their destinations. An MTA is sometimes called a Mail 
Transport Agent, a mail router, an Internet mailer, or a mail server program. 
Commonly used MTAs include sendmail, qmail, and Exim.

SISNAPI Siebel Internet Session Network Application Programming Interface. A 
proprietary Siebel network protocol used for communications to and from Siebel 
Components.

SMTP Simple Mail Transport Protocol. Used to move each email over the Internet.

SOAP Simple Object Access Protocol. The use of XML and HTTP to access services, 
objects, and servers in a platform-independent manner. For more information 
about SOAP, see Siebel Analytics Web Administration Guide.

Table 21. Frequently Used Terms for Email Marketing

Acronym or 
Term Definition
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If Siebel Email Marketing components lose connectivity to the Siebel Server, they queue all data and 
continue to function. After the connection is reestablished, queued data is processed.

Email Sending Daemon Integration and Workflow
Figure 6 on page 96 shows a more detailed view of the Siebel Email Sending Daemon, its 
interrelationship with Siebel Marketing, and the outbound flow of work within this architecture. The 
following steps correspond with the numbers in the figure:

1 Workflow calls Analytics Web to generate a list that is formatted for email personalization.

2 Siebel Analytics Web generates list files for each batch (subwave).

3 Workflow waits until files are returned.

4 Workflow launches a subprocess for each file and then notifies the Email Sending Daemon 
location of each file.

5 Email Sending Daemon retrieves each subwave list of Prospects and Contacts.

Figure 5. Email Marketing Architecture
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6 Email Sending Daemon sends email to all the Prospects and Contacts in each subwave list.

Requirements for Installing Email 
Marketing
Before installing Email Marketing, you need to perform the following tasks:

■ Removing an Existing Version of the Email Marketing Daemons on page 96

■ Install the Java Software Development Kit (SDK) on page 98

■ Verifying the Object Manager Component is Enabled and Running on page 98

Removing an Existing Version of the Email Marketing Daemons
If you have an existing version of the Email Sending Daemon, Bounce Handling Daemon, and Click-
Through Daemon, you must remove them before proceeding with this install.

To remove existing Email Marketing daemons on Windows 2000 Server

1 From the Start menu choose Settings > Control Panel > Administrative Tools > Services.

2 Stop the services for Email Marketing daemons.

a Right-click the existing Email Sending Daemon service (labeled esd) and select Stop.

b Right-click the existing Bounce Handler Daemon service (labeled bhd) and select Stop.

c Right-click the existing Click-Through Daemon service (labeled esd) and select Stop.

Figure 6. Email Sending Daemon Integration and Workflow
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3 Return to the Control Panel and select Add or Remove Programs.

4 To remove each daemon, perform the following steps (following the instructions in each dialog 
box):

a Select the Email Sending Daemon program and click Change/Remove.

b Select the Bounce Handler Daemon program and click Change/Remove.

c Select the Click-Through Daemon program and click Change/Remove.

5 Locate the directory where the following Email Marketing daemon programs were installed and 
remove them.

NOTE: After the uninstall, some files that could cause problems for the new installation might 
remain. Deleting files in these directories makes sure that the new installation does not inherit 
outdated information.

■ The default installation location for Email Sending Daemon is C:\Program Files\esd.

■ The default installation location for Bounce Handler is C:\Program Files\bhd.

■ The default installation location is C:\Program Files\ctd.

To remove existing Email Marketing daemons on a UNIX server

1 Log in as root.

The Root user has the rights to install and remove applications.

2 To remove the Email Sending Daemon program, perform the following steps:

a Navigate to the directory where the Email Sending Daemon program was installed and, if it 
is running, stop the Email Sending Daemon using the following command:

./tomcat-ctl.sh stop

b Navigate to the parent directory where the Email Sending Daemon program was installed and 
remove the Email Sending Daemon program directory using the following command:

rm -rf esd

3 To remove the Bounce Handler Daemon program, perform the following steps:

a Navigate to the directory where the Bounce Handler Daemon program was installed and, if it is 
running, stop the Bounce Handler Daemon using the following command:

./bin/bhd-ctl.sh stop

b Navigate to the parent directory where the Bounce Handler Daemon program was installed and 
remove the Bounce Handler Daemon program directory using the following command:

rm -rf bhd

4 To remove the Click-Through Daemon program, perform the following steps:

a Navigate to the directory where the Click-Through Daemon program was installed and, if it is 
running, stop the Click-Through Daemon using the following command:

./tomcat-ctl.sh stop
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b Navigate to the parent directory where the Click-Through Daemon program was installed and 
remove the Click-Through Daemon program directory using the following command:

rm -rf ctd

Install the Java Software Development Kit (SDK)
Install the most recent maintenance release of the Java 1.4.2 SDK, not the JRE. The Java 2 SDK is 
a superset of the JRE (Java Runtime Environment) and contains everything that is in the JRE, plus 
tools such as the compilers and debuggers necessary for developing applets and applications. The 
SDK files and instructions on how to install the SDK can be found on Sun's Java site at http://
java.sun.com/j2se/.

Verifying the Object Manager Component is Enabled and Running
The object manager component (such as Marketing Object Manager) to which you want to connect 
must be enabled and running on the Siebel Server. To verify this, use the following guidelines:

■ Log in to Siebel Server.

■ Navigate to Administration - Server Configuration > Servers > Components.

■ Query for the alias name and make sure the component has a status of Online or Running.

For example, the Marketing Object Manager component for the English language version has an 
alias name of SMObjMgr_enu.

Installing the Email Marketing Server
You need to locate the Email Marketing Daemon installation programs. They are shipped on separate 
media from the Marketing operational application media. Installers for all platforms and Email 
Marketing daemons (Email Sending Daemon, Bounce Handler Daemon, and Click-Through Daemon) 
can be found on this media.

NOTE: When installing on a MS Windows platform, the components should be installed on a drive 
with sufficient space to handle the size of the log files.

To install Email Marketing, you need to install each of the following components:

■ Email Sending Daemon (ESD). The Email Sending Daemon installation program for Email 
Marketing 7.7 is called esd-install.exe on MS Windows and esd-install.bin on UNIX. The Email 
Sending Daemon is typically placed on a different server from the Marketing Server or any of the 
other Email Marketing components (for example, BHD and CTD).

It is important to determine the appropriate location in which to install the Email Sending 
Daemon. Typically it is installed on the corporate network, behind the corporate DMZ. Selecting 
this location requires the network administrator to perform the following tasks:

■ Define how the Email Sending Daemon connects to outbound Mail Transfer Agents within the 
DMZ.

■ Provide a way for the Email Sending Daemon to look up DNS A records for outbound Mail 
Transfer Agents. 
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■ Bounce Handler Daemon (BHD). The Bounce Handler Daemon installation program for Email 
Marketing 7.7 is called bhd-install.exe on MS Windows and bhd-install.bin on UNIX. The Bounce 
Handler Daemon may be placed on a separate server from the Marketing Server or any of the 
other Email Marketing components (for example, ESD and CTD). However, it typically shares a 
server with the Click-Through Daemon.

It is important to determine the appropriate location in which to install the Bounce Handler 
Daemon. Typically it is installed inside the corporate DMZ. Selecting this location requires the 
network administrator to perform the following tasks:

■ Register the IP address that identifies the Bounce Handler Daemon on the Internet. The IP 
address must be registered as a DNS MX record. Historically, it takes at least two weeks 
(after registration) for the entire Internet to be properly updated with this information. 
Therefore, you need to register as early as possible.

■ Define a way for the Bounce Handler Daemon to receive inbound SMTP messages from the 
Internet through the outer DMZ firewall. The Bounce Handler Daemon passes asynchronous 
bounce details to the Marketing Server through SISNAPI protocol. The communication 
between the Bounce Handler Daemon and the Marketing Server requires you to define a way 
for the SISNAPI messages to pass through the inner DMZ firewall.

■ Click-Through Daemon (CTD). The Click-Through Daemon installation program for Email 
Marketing 7.7 is called ctd-install.exe on MS Windows and ctd-install.bin on UNIX. The Click-
Through Daemon may be placed on a separate server from the Marketing Server or any of the 
other Email Marketing components (for example, ESD and BHD). However, it typically shares a 
server with the Bounce Handler Daemon.

It is important to determine the appropriate location in which to install the Click-Through 
Daemon. Typically it is installed inside the corporate DMZ. Selecting this location requires the 
network administrator to perform the following tasks:

■ Define a way for the Click-Through Daemon to service HTTP requests from the Internet 
through the outer DMZ firewall. 

■ Register the IP address that identifies the Click-Through Daemon on the Internet. The IP 
address must be registered as a DNS A record. Historically, it takes at least two weeks (after 
registration) for the entire Internet to be properly updated with this information. Therefore, 
you need to register as early as possible.

■ The Click-Through Daemon passes details about the HTTP requests it serviced (Tracked URLs, 
Forward To Friend, and so on) to the Marketing Server through SISNAPI protocol. The 
communication between the Click-Through Daemon and the Marketing Server requires you 
to define a way for the SISNAPI messages to pass through the inner DMZ firewall. 

This section contains the following topics:

■ Installing the Email Sending Daemon (ESD) on page 100

■ Installing the Bounce Handler Daemon (BHD) on page 100

■ Installing the Click-Through Daemon (CTD) on page 101
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Installing the Email Sending Daemon (ESD)
This topic contains the information that you need to install the Email Sending Daemon. Before 
installing the Email Sending Daemon, make sure that you have completed all installation 
requirements. For more information, see �Requirements for Installing Email Marketing� on page 96.

To install the Email Sending Daemon in Windows and UNIX

1 On a Windows 2000 server, run the Email Sending Daemon installation program.

2 On a UNIX server, perform the following steps:

a Make a directory named esd. This will be the installation directory using the following command:

mkdir esd

b Copy the Email Sending Daemon installation program from the installation media to the directory 
that you created.

c In the Email Sending Daemon installation directory, run the Email Sending Daemon installation 
program.

3 In the Installation dialog box, review the information, and then click Next.

4 In the Choose Java Virtual Machine dialog box, select the software development kit (SDK) that 
you installed in �Requirements for Installing Email Marketing� on page 96, and then click Next.

NOTE: Make sure that you choose the correct SDK. Selecting the wrong SDK or selecting a JRE 
will result in your being unable to properly start the Email Sending Daemon.

5 In the Choose Install Folder dialog box, choose the Email Sending Daemon installation directory, 
and then click Next.

6 Review the Pre-Installation Summary dialog box, and then click Install.

7 In the Install Complete dialog box, verify the information, and then click Done.

Installing the Bounce Handler Daemon (BHD)
This topic contains the information that you need to install the Bounce Handler Daemon. Before 
installing the Bounce Handler Daemon, make sure that you have completed all installation 
requirements. For more information, see �Requirements for Installing Email Marketing� on page 96.

To install the Bounce Handler Daemon in Windows and UNIX

1 On a Windows 2000 server, run the Bounce Handler Daemon installation program. 

2 On a UNIX server, perform the following steps:

a Make a directory named bhd. This will be the installation directory using the following command:

mkdir bhd

b Copy the Bounce Handler Daemon installation program from the installation media to the 
directory that you created.
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c In the Bounce Handler Daemon installation directory, run the Bounce Handler Daemon 
installation program.

3 In the Installation dialog box, review the information, and then click Next.

4 In the Choose Java Virtual Machine dialog box, select the software development kit (SDK) that 
you installed in �Requirements for Installing Email Marketing� on page 96, and then click Next.

NOTE: Make sure that you choose the correct SDK. Selecting the wrong SDK or selecting a JRE 
will result in your being unable to properly start the Bounce Handler Daemon.

5 In the Choose Install Folder dialog box, choose the Bounce Handler Daemon installation 
directory, and then click Next.

6 Review the Pre-Installation Summary dialog box, and then click Install.

7 In the Install Complete dialog box, verify the information, and then click Done.

Installing the Click-Through Daemon (CTD)
This topic contains the information that you need to install the Click-Through Daemon. Before 
installing the Click-Through Daemon, make sure that you have completed all installation 
requirements. For more information, see �Requirements for Installing Email Marketing� on page 96.

To install the Click-Through Daemon in Windows and UNIX

1 On a Windows 2000 server, run the Click-Through Daemon installation program. 

2 On a UNIX server, perform the following steps:

a Make a directory named ctd. This will be the installation directory using the following command:

mkdir ctd

b Copy the Click-Through Daemon installation program from the installation media to the directory 
that you created.

c In the Click-Through Daemon installation directory, run the Click-Through Daemon installation 
program.

3 In the Installation dialog box, review the information, and then click Next.

4 In the Choose Java Virtual Machine dialog box, select the software development kit (SDK) that 
you installed in �Requirements for Installing Email Marketing� on page 96, and then click Next.

NOTE: Make sure that you choose the correct SDK. Selecting the wrong SDK or selecting a JRE 
will result in your being unable to properly start the Click-Through Daemon.

5 In the Choose Install Folder dialog box, choose the Click-Through Daemon installation directory, 
and then click Next.

6 Review the Pre-Installation Summary dialog box, and then click Install.

7 In the Install Complete dialog box, verify the information, and then click Done.
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Configuring Email Marketing Daemons
This topic contains the information that you need to configure Email Marketing Server and the Siebel 
Marketing application so that they can communicate with each other.

This section contains the following topics:

■ Configuring Email Marketing Daemons to Communicate With the Marketing Object Manager on 
page 102

■ Configuring the Email Sending Daemon on page 104

■ Configuring the Bounce Handler Daemon on page 108

■ Configuring the Click-Through Daemon on page 110

Configuring Email Marketing Daemons to Communicate 
With the Marketing Object Manager
CAUTION: During this process, do not start the Email Marketing daemons until told to do so. If you 
do accidentally start any of the daemons, stop them immediately before proceeding.

This section contains the following topics that apply to all Email Marketing daemons:

■ Identifying the Object Manager Alias and Port for Email Marketing on page 102

■ Setting Up the User Id, Password, and Language for Email Marketing on page 103

■ Migrate the Siebel Server JAR files to the Email Sending Daemon on page 103

Identifying the Object Manager Alias and Port for Email Marketing
You will need the object manager alias and port values to perform several tasks in this chapter. Keep 
a record of these values to make the tasks easier to complete.

To identify the object manager alias and object manager port

1 Determine the object manager alias name for the object manager to which you want to connect. 
Write this down to use later.

For example, SMObjMgr_enu (Marketing Object Manager)

2 Navigate to the SWE installation directory.

3 Locate the SWE eapps.cfg file in the following directory:

<marketing server install directory>\SWEApp\BIN\ 

4 Open eapps.cfg in a text editor.

5 Search for the object manager alias name to which you want to connect. The line begins with 
ConnectString.
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6 In the ConnectString line, locate the object manager port (a four-digit number preceded by a 
colon) and write down the number to use later.

For example, :2192

Setting Up the User Id, Password, and Language for Email Marketing
Each of the Email Marketing daemons have information that they need to pass to the Marketing 
Server. For example, for the Email Sending Daemon, the SISNAPI protocol is used to communicate 
information about subwaves that have been completed and details about synchronous bounces. This 
communication is established by following the steps in this topic.

To set up the siebel.properties file

1 Locate the siebel.properties file in each of the following directories:

■ <esd installation directory>\webapps\esd\WEB-INF\classes\

■ <bhd installation directory>\lib\

■ <ctd installation directory>\webapps\ctd\WEB-INF\classes

2 Open each siebel.properties file with a text editor such as WordPad (Windows) or vi (UNIX).

3 Locate the string siebel.conection.string.

4 To the right of the equals sign, add the object manager alias name using the following syntax:

<enterprise drive name>://<marketing server hostname>:<object manager port>/
<enterprise name>/<object manager alias name>/<siebel server name>

NOTE: For MS Windows, the enterprise name and siebel server name appear in square brackets 
after the Siebel Server service in the Services window.

5 Locate the string siebel.user.name.

6 At the right of the equals sign, add the System Administrator user name.

7 Locate the string siebel.user.password. At the right of the equals sign, add the System 
Administrator password.

8 Locate the string siebel.user.language. At the right of the equals sign, add the language 
abbreviation.

For example, enu (English).

9 Save your changes to each siebel.properties file.

Migrate the Siebel Server JAR files to the Email Sending Daemon
Migrate the Siebel Java bean (Siebel.jar) and Java Internationalization (SiebelJI_enu.jar) JAR files 
to the Email Sending Daemon.

■ Locate the Siebel Server Java JAR files in the following directory:

■ <siebel server install directory>\siebsrvr\CLASSES directory
Siebel Marketing Installation and Administration Guide Version 7.7 ■ 103



Installing and Configuring Email Marketing ■  Configuring Email Marketing Daemons
■ Copy the Siebel.jar file from this directory to the following directories:

■ <esd installation directory>\webapps\esd\WEB-INF\lib directory

■ <bhd installation directory>\lib directory

■ <ctd installation directory>\webapps\ctd\WEB-INF\lib directory

■ Copy the SiebelJI_<language>.jar file from this directory to the following directories:

■ <esd installation directory>\webapps\esd\WEB-INF\lib directory

■ <bhd installation directory>\lib directory

■ <ctd installation directory>\webapps\ctd\WEB-INF\lib directory

Configuring the Email Sending Daemon
This topic contains the configuration tasks that you need to perform so that the Marketing application 
can communicate with the Email Sending Daemon. Additionally, you need to configure the Email 
Sending Daemon to read files from the Marketing File System and communicate with the outbound 
Mail Transfer Agents. During these tasks, you will have an opportunity to verify that the Email 
Sending Daemon has been correctly installed and configured. For information about this test, see 
�Final Test of Email Marketing Components� on page 113.

CAUTION: During this process, do not start the Email Sending Daemon until told to do so. If you do 
accidentally start it, stop it immediately before proceeding.

To configure the Email Sending Daemon to connect to the Marketing Server, perform the following 
steps:

■ Identifying the Outbound Mail Transfer Agent for the Email Sending Daemon on page 104

■ Configuring the Email Sending Daemon to Access the Marketing File System on page 105

■ Configuring the SOAP Communications Port on page 106

■ Verifying the Email Sending Daemon Installation on page 106

■ Configuring the Marketing Application to Connect to the Email Sending Daemon on page 107

■ Configuring the Email Address Headers for the Email Marketing Server on page 108

Identifying the Outbound Mail Transfer Agent for the Email Sending 
Daemon
The Email Sending Daemon needs one or more outbound Mail Transfer Agents to deliver the email 
over the Internet.

To identify the outbound Mail Transfer Agent for ESD

1 Determine the hostname of the outbound Mail Transfer Agent.

2 Open the siebel.properties file in a text editor such as WordPad (Windows) or vi (UNIX).

3 Locate the string esd.mailServers.
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4 In the string, at the right of the equals sign, add the hostname of the outbound Mail Transfer 
Agent. If there is more than one, separate them with commas.

5 Save your changes.

Configuring the Email Sending Daemon to Access the Marketing File 
System
The Email Sending Daemon needs to access the Siebel Marketing File System in order to load the 
email message content (generated from the email offer(s) and attachments) and all of the subwaves 
of contacts and prospects generated for a campaign wave.

To identify the Marketing File System on Windows 2000 Server 

1 Log in to Siebel Server.

2 Navigate to Administration - Server Configuration > Servers > Parameters.

3 Query for Marketing File System. 

Write down the value of this parameter to use later in this task.

4 Identify the Windows share name for this directory.

Write down this name to use later in this task.

5 Open the siebel.properties file with a text editor such as WordPad.

6 In the string esd.mountPoint, at the right of the equals sign, type the following path using the 
share name determined in Step 4 on page 105:

\\\\<siebel server hostname>\\<marketing file system share name>

It is necessary to use two backslashes for each standard single backslash when defining this 
path. For example, C:\Windows would be C:\\Windows.

CAUTION: If the Marketing File System is on the same server as the Email Sending Daemon, 
use the complete path to the Marketing File System instead of the share name. This avoids 
potential permission issues.

7 Save your changes to the siebel.properties file.

To identify the Marketing File System location on a UNIX server 

1 Log in to Siebel Server.

2 Navigate to Administration - Server Configuration > Servers > Parameters.

3 Query for Marketing File System. 

Write down the value of this parameter to use later in this task.

4 Determine if this directory is exported through NFS. If it is not, export it.

5 Open the siebel.properties file with a text editor, such as vi.
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6 On the Email Sending Daemon server, make sure the Marketing File System is NFS mounted. If 
it is not, mount it at this time. 

Write down the full path name of the mounted Marketing File System to use later in this task.

7 In the string esd.mountPoint, at the right of the string, add the Marketing File System NFS mount 
directory.

8 Save your changes to the siebel.properties file.

Configuring the SOAP Communications Port
The Marketing application on the Siebel Server communicates with the Email Sending Daemon using 
the SOAP protocol, which uses HTTP requests. You need to configure the Email Sending Daemon to 
listen for these HTTP requests on a specific port.

To configure the SOAP communications port

1 Consider what port number you wish to use to service the SOAP commands (HTTP requests) on 
the Email Sending Daemon. 

Because this HTTP server will not service standard HTTP requests such as Web pages, any port 
can be used (even the default of 8080). Write down the port number you decide to use.

2 At the following location, open the server.xml file in a text editor, such as WordPad (Windows) or 
vi (UNIX):

 <ctd installation directory>\conf\server.xml 

3 Locate the XML tag Connector by searching for following phrase:

Define a non-SSL Coyote HTTP/1.1 Connector

4 Identify the value of the port attribute and, if necessary, change it to the value you chose in 
Step 1 on page 106.

By default this value is 8080. 

5 Save the change.

You will need this port number again in a subsequent task.

Verifying the Email Sending Daemon Installation
At this point, you can test the installation of the Email Sending Daemon. To verify that the installation 
was successful, you start the Email Sending Daemon and then perform several verification steps. For 
information about testing how all the Email Marketing components and the Marketing application 
work together, see �Final Test of Email Marketing Components� on page 113.

To start the Email Sending Daemon on Windows 2000 Server 

1 From the desktop, click Start and choose Settings > Control Panel.

2 In Control Panel, choose Administrative Tools > Services.
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3 Right-click the Email Sending Daemon service and select Start.

To start the Email Sending Daemon on a UNIX server 

1 Open a window and navigate to the Email Sending Daemon install directory.

2 Type and run the following command:

./tomcat-ctl.sh start &

3 Optionally, you can type and run the following commands:

./tomcat-ctl.sh start &; tail -f logs/esd.log

NOTE: The first command (./tomcat-ctl.sh start &) launches the daemon. The second 
command (tail -f logs/esd.log) displays output to the esd log as it is running without 
generating a read lock on the file. A read lock would prevent these commands from working.

To verify the Email Sending Daemon installation

1 Verify that the Email Sending Daemon Windows Service or UNIX process runs and stays running 
without an error message.

2 Open the esd_InstallLog.log file (found in the <esd installation directory>) and read the 
summary at the start of the file. Make sure it says that the installation was successful with no 
warnings or errors. If there are warnings or errors, you need to identify the cause and fix the 
error.

3 Verify that a esd.log file exists in the following directory:

<esd installation directory>\logs\esd.log

4 Verify that the following text is in the esd.log file:

INFO ConnectTest Successfully connected to Siebel Server!

INFO ConnectTest Logged out of Siebel.

5 Make sure there are no ERROR or WARN level messages in the esd.log file.

6 Confirm that the Email Sending Daemon Web container is running. 

NOTE: You will need the port number that you obtained in �Configuring the SOAP Communications 
Port� on page 106. 

■ Verify that you can open the following Web page without error using Internet Explorer:

http://<email sending daemon server hostname>:<email sending daemon soap port>/
esd/soaprpc

Configuring the Marketing Application to Connect to the Email Sending 
Daemon
This section describes how to allow the Marketing application to connect to the Email Sending 
Daemon.
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1 Open Internet Explorer and navigate to the Siebel Marketing Server login screen.

For example, http://<marketing server hostname>/marketing_enu

2 Log in as the server administrator.

3 From the Site Map, choose Administration - Web Services > Outbound Web Services.

4 In the Outbound Web Services list, in the Name field, query for SendMailingService.

5 In the Service Ports list, in the SendMailing record, perform the following steps:

a Obtain the Web Port Id identified in �Configuring the SOAP Communications Port� on page 106.

b In Address field, change the URL using the following syntax:

http://<esd server hostname>:<esd web port>/esd/soaprpc

6 Click Clear Cache.

7 From the Site Map, choose Administration - Marketing > Servers.

8 In the Servers list, in the Name field, query for Email Marketing Server.

9 In the parameters list, locate the Email Sending Daemon (ESD) parameter, and verify that the 
Outbound Web Service Port field contains SendMailing.

Configuring the Email Address Headers for the Email Marketing Server
This section describes how to configure the From and Reply-To headers for all outbound email sent 
using the Email Sending Daemon.

To configure the From Address and Reply-To Address for the Email Marketing Server

1 From the Site Map, choose Administration - Marketing > Servers.

2 In the Servers list, in the Name field, query for Email Marketing Server.

3 In the parameters list, in the Value field, update the values as shown in the following list:

Configuring the Bounce Handler Daemon
The Bounce Handler Daemon notifies the Marketing Object Manager that it has processed 
asynchronous bounces and needs to pass these bounce details to the Marketing Object Manager. This 
topic contains the information that you need to configure the Bounce Handler Daemon to 
communicate with the Marketing Object Manager.

Parameter Type Value

From Address (From 
header)

<the email address that you want to use as the 
From header for all outgoing emails>

Reply To Address 
(Reply-To header)

<the email address that you want to use as the 
Reply-To header for all outgoing emails>
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To configure the Bounce Handler Daemon, perform the following tasks:

■ Verifying the Bounce Handler Daemon Installation on page 109

■ Configure the From Address of the SMTP Envelope on page 110

■ Configure the Click-Through Daemon HTTP Server Port on page 111

CAUTION: During this process, do not start the Bounce Handler Daemon until told to do so. If you 
do accidentally start it, stop it immediately before proceeding.

Verifying the Bounce Handler Daemon Installation
To verify the installation was successful, you start the Bounce Handler Daemon and then perform 
installation tests. For information about testing how all the Email Marketing components and the 
Marketing Object Manager work together, see �Final Test of Email Marketing Components� on 
page 113.

To start the Bounce Handler Daemon on Windows 2000 Server 

1 From the desktop, click Start and choose Settings > Control Panel.

2 In Control Panel, choose Administrative Tools > Services.

3 Right-click the bhd service and select Start.

To start the Bounce Handler Daemon on a UNIX server 

1 Open a window and navigate to the Bounce Handler Daemon install directory.

2 Type and run the following command:

./bin/bhd-ctl.sh start &

3 Optionally, you can type and run the following commands:

./bin/bhd-ctl.sh start &; tail -f bhd.log

NOTE: The first command (./bin/bhd-ctl.sh start &) launches the daemon. The second command 
(tail -f bhd.log) displays output to the bhd log as it is running without generating a read lock on 
the file. A read lock would prevent these commands from working.

To verify the Bounce Handler Daemon installation

1 Verify that the Bounce Handler Daemon Windows Service or UNIX process is running and stays 
running without an error message.

2 Open the bhd_InstallLog.log file (found in the <bhd installation directory>) and read the 
Summary at the start of the file. Make sure it says that the installation was successful with no 
warnings or errors. If there are warnings or errors, you need to identify the cause and fix the 
error.

3 Verify that a bhd.log file exists in the following directory:

<bhd installation directory>\logs\bhd.log
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4 Verify that the following text is in the bhd.log file:

INFO ConnectTest Successfully connected to Siebel Server!

INFO ConnectTest Logged out of Siebel.

5 Make sure there are no ERROR or WARN level messages in the bhd.log file.

6 From a command prompt window, telnet to the Bounce Handler Daemon SMTP port (25) (for 
example, telnet bhd.siebel.com 25), wait for a greeting, and then type the word quit and press 
the ENTER key. Your telnet session should automatically exit.

Configure the From Address of the SMTP Envelope
This section describes how to configure the hostname that you use to create the from address of the 
SMTP envelope. This from address is the email address that receives bounced emails. The hostname 
you use as the from address is the host name of the Bounce Handler Daemon.

To configure the SMTP envelope from address

1 Navigate to the Siebel Marketing login screen at the following location: 

http://<marketing application hostname>/marketing_enu

2 Log in as the server administrator.

3 From the Site Map, choose Administration - Marketing > Servers.

4 In the Servers list, in the Name field, query for Email Marketing Server.

5 In the parameters list, in the Value field, update the values as shown in the following list:

Configuring the Click-Through Daemon
This topic contains the information that you need to configure the Click-Through Daemon to 
communicate with the Marketing Object Manager. The Click-Through Daemon needs to pass the 
server details about the HTTP requests it has serviced (Tracked URLs, Forward To Friend, and so on) 
to the Marketing Object Manager.

To configure the Click-Through Daemon to connect to the Marketing Object Manager, perform the 
following tasks:

■ Configure the Click-Through Daemon HTTP Server Port on page 111

■ Verifying the Click-Through Daemon Installation on page 111

Parameter Type Value

Bounce Handler 
Daemon (BHD)

<bhd server hostname>
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■ Configuring the Click-Through Daemon, Web Marketing, and Events Base URLs on page 112

CAUTION: During this process, do not start the Click-Through Daemon until told to do so. If you do 
accidentally start it, stop it immediately before proceeding.

Configure the Click-Through Daemon HTTP Server Port
Personalization elements sent in emails to contacts and prospects that the Click-Through Daemon 
services (for example, Track Message Open, Tracked URLs, and so on) must be able to issue HTTP 
requests to the Click-Through Daemon. You need to configure your firewalls/DMZ to service these 
requests and the Email Sending Daemon to listen for these HTTP requests on a specific port.

■ Identify the port number that you wish to use to service HTTP requests on the Click-Through 
Daemon and write it down for use in subsequent tasks.

NOTE: It is strongly recommended that you use port 80, which is the standard port for HTTP 
requests. Typically, this port is open for most firewalls between the corporate network and the 
Internet. Therefore, using this port minimizes connection issues between the Click-Through 
Daemon and your contacts and prospects.

■ Configure your firewall to properly service these requests over this port.

■ Open the following file with a text editor, such as WordPad (Windows) or vi (UNIX):

 <ctd installation directory>\conf\server.xml 

■ Search for the following phrase:

Define a non-SSL Coyote HTTP/1.1 Connector

■ Search for the XML tag Connector using the following phrase:

Find the value of the port attribute

By default this value is 8080. If you chose a different port number to service HTTP requests on 
the Click-Through Daemon, change the port attribute value and save the file.

Verifying the Click-Through Daemon Installation
To verify the installation was successful, you start the Click-Through Daemon and then perform the 
installation test. For information about testing how all the Email Marketing components and the 
Marketing Object Manager work together, see �Final Test of Email Marketing Components� on 
page 113. 

To start the Click-Through Daemon on Windows 2000 Server 

1 From the desktop, click Start and choose Settings > Control Panel.

2 In Control Panel, choose Administrative Tools > Services.

3 Right-click the ctd service and select Start.
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To start the Click-Through Daemon on a UNIX server 

1 Open a window and navigate to the Click-Through Daemon install directory.

2 Type and run the following command:

./tomcat-ctl.sh start &

3 Optionally, you can type and run the following commands:

./tomcat-ctl.sh start &; tail -f logs/ctd.log

NOTE: The first command (./tomcat-ctl.sh start &) launches the daemon. The second command 
(tail -f logs/ctd.log) displays output to the ctd log as it is running without generating a read lock 
on the file. A read lock would prevent the tail command from working.

To verify the Click-Through Daemon installation

1 Verify that the Click-Through Daemon MS Windows service or UNIX process runs and stays 
running without an error message.

2 Open the ctd_InstallLog.log file (found in the <ctd installation directory>) and read the Summary 
at the start of the file. Make sure it says that the installation was successful with no warnings or 
errors. If there are warnings or errors, you need to identify the cause and fix the error.

3 Verify that a ctd.log file exists in the following directory:

<ctd installation directory>\logs\ctd.log

4 Verify that the following text is in the ctd.log file:

INFO ConnectTest Successfully connected to Siebel Server!

INFO ConnectTest Logged out of Siebel.

5 Make sure there are no ERROR or WARN level messages in the ctd.log file.

6 Confirm that the Click-Through Daemon Web container is running. 

NOTE: To do this, you will need the port number that you obtained in �Configure the Click-Through 
Daemon HTTP Server Port� on page 111. 

■ Verify that you can open the following Web page without an error using Internet Explorer:

http://<click-through daemon server hostname>:<click-through daemon http port>/
ctd

Configuring the Click-Through Daemon, Web Marketing, and Events 
Base URLs
This section describes how to configure the base URLs for URLs sent in email campaigns. The 
following are the sets of base URLs that might be generated: 

■ Click-Through Daemon base URL (used for Tracked URLs, Forward To Friend, and so on)

■ Web Marketing base URL

■ Events base URL
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To configure base URLs for email campaigns

1 Navigate to the Siebel Marketing Server login screen at the following location: 

http://<marketing application hostname>/marketing_enu

2 Log in as the server administrator.

3 From the Site Map, choose Administration - Marketing > Servers.

4 In the Servers list, in the Name field, query for Email Marketing Server.

5 In the parameters list, in the Value field, update the values as shown in the following list:

Final Test of Email Marketing 
Components
At this point, you have installed and configured all of the Email Marketing components (Email 
Sending Daemon, Bounce Handler Daemon, and Click-Through Daemon) and tested each separate 
component. 

This section describes how to test all components and the Marketing application together as a 
complete system. This test involves sending a test email to three or more test contacts. The content 
of the test email template should include links to test the Click-Through Daemon, the Web Marketing 
Server, and the Events server. At least two of the contacts should be invalid email addresses, one 
within the corporate domain, and one outside the corporate domain. These will test bounce handling 
and bounce detail communications for the Email Sending Daemon and the Bounce Handler Daemon. 
Additionally, you should send email to at least one email account that you can access outside of your 
corporate network. This tests your Email Sending Daemon, DNS alterations, and corporate firewall 
configurations.

To perform this comprehensive test of the Email Marketing components, perform the following tasks:

■ Create the Test Email Template on page 113

■ Send the Test Email Template to Test Contacts on page 114

■ Confirm that all Tests Function as Expected on page 115

Create the Test Email Template
You create a test email template to verify your Email Marketing components are correctly installed 
and configured. For information about creating an email template, see Siebel Marketing User Guide.

Parameter Type Value

Click-Through Daemon 
(CTD)

http://<click-through daemon server 
hostname>:<port number>

Web Server <URL for Web Marketing>;<URL for Events>

For example, http://<hostname>/
emarketing_enu; http://<hostname>/

eevents_enu
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When you create the test email template, make sure you add a One-Click Unsub Response Form, a 
Web Offer link, and an Event link. 

NOTE: Because this email will be sent out over the Internet, it is a good idea to add text that 
announces that this is a test email, offers your apologies if someone unintended receives it, and 
provides information that allows recipients to contact you.

Send the Test Email Template to Test Contacts
Determine the contacts to whom the test email template will be sent, create an email offer from it, 
and send it to these contacts.

1 Whether you use a list or a segment to generate your target contacts for this test, make sure 
the following three contact types are included:

■ Invalid contact email address within the corporate domain. This tests communication 
from the Email Sending Daemon to the Marketing Object Manager. The Email Sending 
Daemon reports synchronous bounces to the Marketing Object Manager. An invalid email 
address within the corporate domain generates a synchronous bounce from the Mail Transfer 
Agent. 

NOTE: The system administrator should make sure that the Mail Transfer Agent is configured 
to handle synchronous bounces and confirm that the contact's email address will generate a 
synchronous bounce. This is desirable even if the Mail Transfer Agent is normally not 
configured to handle synchronous bounces. The reason for this is to make sure that if the 
normal Mail Transfer Agent configuration changes and starts performing synchronous 
bounces, your system will properly record them. After testing, the system administrator can 
return the Mail Transfer Agent to its normal configuration.

■ Invalid contact email address outside of the corporate domain. This tests the 
corporate firewall and Internet DNS configuration of the Bounce Handler Daemon. This also 
tests communication between the Bounce Handler Daemon and the Marketing Object 
Manager. An invalid email address for a domain other than the corporate domain should 
generate an asynchronous bounce that the Bounce Handler Daemon should be able to receive 
bounced emails, process bounced emails, and send the bounce details to the Marketing 
Object Manager.

Be aware that some email domains (such as aol.com) do not generate bounces. Also, be 
aware that email bounces are not guaranteed to be returned. It may take some research to 
determine whether the problem is actually the Bounce Handler Daemon or one of a number 
issues not related to the installation and configuration of the Email Marketing components.

■ Valid contact email address for an email account accessible outside of the corporate 
firewall/DMZ. This tests the corporate firewall and Internet DNS configuration with the 
Click-Through Daemon, Web Server, and Event Server. This tests communication between the 
Click-Through Daemon and the Marketing Server. The email sent to a valid contact contains 
a One-Click Unsub Response Form, a Web Offer link, and an Event link. The tester should 
access this account and email from a computer outside the corporate firewall to correctly 
execute this test.

2 Launch a campaign using a list or segment including the described types of contacts. 
Siebel Marketing Installation and Administration Guide Version 7.7114 ■



Installing and Configuring Email Marketing ■  Final Test of Email Marketing Components
3 Monitor the campaign to make sure that it succeeds without any errors. One example of an error 
is an error message in the log containing the word SOAP. This indicates that the Marketing 
application is not correctly configured to communicate with the Email Sending Daemon.

Confirm that all Tests Function as Expected
You need to perform the tests in this section to confirm that the system behaved as expected. 

1 Test an email offer sent to the valid contact email address

a Verify that the email offer was received. Find a computer that is outside of the corporate network 
and has access to the valid contact�s email account. Then you need to access that account from 
the computer that is outside of the corporate network.

Results of test. If the email offer is received, you have confirmed the following results:

❏ The Marketing Server communicates with the Email Sending Daemon.

❏ The Email Sending Daemon can access the email message content and subwaves from 
the Marketing File System.

❏ The Email Sending Daemon can send email to email accounts outside of the corporate 
domain using the corporate Mail Transfer Agents. 

❏ The email message From and Reply-To headers are correct.

b Click the One Click Unsub link in the email. 

A Web page that is hosted by the Click-Through Daemon appears with the message, You have 
been unsubscribed!

Results of test. This message confirms that you correctly configured the Click-Through 
Daemon for the corporate firewall and it has been properly added to the Internet DNS 
records. Additionally, this confirms that the Marketing application has been correctly 
configured with the base URL for the Click-Through Daemon.

c Click the One Click Unsub link in the email for the Web Offer link and the Event link.

Results of test. The Web Server and Event Server base URLs are properly configured within 
the Marketing application.

2 Campaign details

a Synchronous bounce reported. Navigate to the Campaign Contact/Prospect Applet-Admin applet 
for the test campaign. Verify that the invalid contact with an email address within the corporate 
domain is identified as a bounce.

Results of test. The Email Sending Daemon is able to communicate with the Marketing 
application and can report synchronous bounces.

NOTE: You may have to add the Email Bounce Type and Email Bounce Reason Code columns 
to the visible columns shown in this applet.
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b Asynchronous bounce reported. Navigate to the Campaign Contact/Prospect Applet-Admin 
applet for the test campaign. Verify that the invalid contact with an email address outside of the 
corporate domain is identified as a bounce.

Results of test. The Bounce Handler Daemon can receive bounces sent from outside of the 
company firewall. This means the Bounce Handler Daemon's hostname is correctly 
configured in the Internet DNS records. The Bounce Handler Daemon is able to communicate 
with the Marketing Object Manager and can report asynchronous bounces. The Marketing 
application has been correctly configured to use the Bounce Handler's hostname as the SMTP 
envelope from address.

c One Click Unsub recorded. Navigate to the Campaign Response List applet and verify that the 
valid contact's email address is entered here with a Response Type of One Click Unsub.

Results of test. The Click-Through Daemon can communicate with the Marketing Object 
Manager and update the Siebel transactional database with information that it collects when 
an email recipient clicks on a link that it monitors.
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Siebel Web Marketing is an optional Siebel Marketing module that provides you with the tools and 
templates to manage and execute Web-based marketing. It provides the Web site visitor a method 
of viewing a Web offer, downloading literature, and using preconfigured Web response forms to 
request more information or ask you to contact them by telephone.

Siebel Web Marketing Web sites can be deployed in more than one language. For information about 
deploying Siebel applications in a multilingual environment, see Global Deployment Guide.

This chapter contains the following topics:

■ About Web Marketing Web Site Visitors on page 117

■ Setting Up Siebel Web Marketing on page 118

About Web Marketing Web Site Visitors
A Web site visitor can navigate to the Web Marketing home page by typing the URL or by clicking a 
hyperlink on another Web page. At this point, the user is an anonymous visitor and can choose to 
register, log in (if they have an existing user name and password), or continue to navigate 
anonymously. When the anonymous visitor arrives at the Web Marketing home page, the default 
campaign offers and the details for the first offer in the Featured Offers list appear. If the visitor 
registers or logs in, the visitor sees other campaign offers for which they are eligible. For more 
information about default offers and default campaigns, see the description of featured offers in 
Siebel Marketing User Guide.

If a contact logs in using the contact�s user ID and password, any responses generated by this 
customer are tagged with the customer�s account ID and with the associated campaign ID. For 
information about setting up users, see �Setting Up Default Responsibilities and Users for Web 
Marketing� on page 120.

Web site visitors can also navigate to the Web Marketing site by clicking on an embedded URL from 
within an email offer. Only contacts or prospects receive these offers. When an email contact or email 
prospect clicks an embedded URL, the Web Offer page for this offer appears. Any responses to the 
offer from this contact or prospect are tagged with the associated campaign ID and offer ID, allowing 
marketers to track response rates for specific campaigns. For a list of responses that are captured, 
see �Response Management� on page 123.

Visitors access the Web Marketing home page in the following ways:

■ Anonymous visitor. Any visitor can type the Web Marketing URL into a Web browser and 
navigate to your Web Marketing home page. This visitor sees no personalized Welcome message 
and responses are not captured when the visitor clicks a Recommended Product link or 
downloads literature. An anonymous visitor can create a product information or call response by 
clicking on the Send Product Information or Request a Call link in the Offers page or Information 
page. The profile information that the anonymous visitor types creates a prospect record that is 
associated with the responses.
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■ Email contact. When a contact clicks an embedded link in an email, your Web Marketing home 
page appears and the Contact Id is set in an anonymous session. At this point, the email contact 
is not logged in. The contact must be a registered contact and must log in to access profile 
information in the My Accounts link or to perform any other tasks that require the contact to be 
a registered contact. The email contact can generate responses by clicking a Recommended 
Product link, downloading literature, or requesting product information or a telephone call.

In the Web Marketing home page, the contact can log in. After logging in, the email contact 
becomes a logged-in contact.

If an email contact clicks the My Accounts link during an anonymous session, the User Login (user 
registration) view appears, requiring the anonymous visitor to log in before continuing.

■ Email prospect. When a prospect clicks an embedded link in an email, your Web Marketing 
home page appears and the Prospect Id is set in an anonymous session. At this point, the email 
prospect is not logged in. The prospect must become a registered contact and must log in to 
access profile information in the My Accounts link or to perform any other tasks that require the 
prospect to be a registered contact. The email prospect can generate responses by clicking a 
Recommended Product link, downloading literature, or requesting product information or a 
telephone call.

In the Web Marketing home page, the email prospect must register as a new contact before the 
prospect can log in. In the User Login applet, the email prospect can type a user ID and password 
or click the New User link to register as a new contact and obtain a user ID and password. 

In the User Login view, the User Login (user registration) view appears, requiring the anonymous 
visitor to log in or to register as a new user before continuing. When registration is complete, the 
prospect is converted to a new logged-in contact. However, the original email prospect�s 
responses are not associated with the new contact record. After logging in, the email prospect 
becomes a logged-in contact.

NOTE: If an email prospect clicks the My Accounts link during an anonymous session, the User 
Login (user registration) view appears, requiring the anonymous visitor to log in or to register 
as a new user before continuing.

■ Logged-in contact. This contact has access to the My Account link and can perform all other 
tasks that a registered contact is eligible to perform. The logged-in contact can generate 
responses by clicking a Recommended Product link, downloading literature, or by requesting 
product information or a telephone call. These responses are associated with the contact record 
in the database.

Setting Up Siebel Web Marketing
This section describes how to set up Siebel Web Marketing. It includes information about customizing 
the user interface, controlling user access, setting up responsibilities, and managing default 
campaigns and offers.

Before Siebel Web Marketing can be used, certain setup tasks must be performed. These include:

■ Installing Web Marketing on page 119

■ Controlling User Access to the Web Marketing Web Site on page 119
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■ Setting Up Default Responsibilities and Users for Web Marketing on page 120

■ Setting Up a Default Campaign and Default Offer on page 120

■ Using Siebel Personalization with Web Marketing on page 121

■ Customizing the Web Marketing User Interface on page 121

Installing Web Marketing
Before you install and use Web Marketing, you must install the following:

■ Siebel Web Engine and related components. To deploy information about the Web and 
customer applications, you must install the Siebel Web Engine and the components on which it 
depends. These include a Web server, Siebel Gateway Name Server, and Siebel Server. For 
information about installing Siebel components, see the Siebel Server installation guide for the 
operating system you are using.

■ Siebel Applications. To perform administrative tasks such as server administration, creating 
Web offers, and managing marketing activities, you must install a Siebel employee application 
such as Siebel eSales and add the Siebel Web Marketing license key. For information about 
installing your Siebel employee application, see the appropriate administration guide, for 
example, Siebel eSales Administration Guide.

Siebel Web Marketing is an add-on module to Siebel Marketing. Siebel Web Marketing requires 
the Web Marketing Object Manager component, which is part of the Marketing Component Group. 
For information about installing Siebel Marketing, see �Installing and Administering Siebel 
Marketing� on page 11 and the Siebel Server installation guide for the operating system you are 
using.

Controlling User Access to the Web Marketing Web Site
You might want to perform some of the following tasks to control user access in your Siebel Web 
Marketing Web site:

■ Using external authentication using LDAP (Lightweight Directory Access Protocol)

LDAP is an Internet protocol that email programs use to look up contact information from a 
server.

■ Creating database users for LDAP to use in database access

■ Defining visibility for views and products

■ Assigning a proxy employee

■ Creating users through registration or user administration

■ Associating users with accounts

■ Allowing various levels of access such as Anonymous, Implicit login, and Explicit login

■ Customizing access to home and login pages. For more information, see information about the 
New User link in Siebel Marketing User Guide.
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■ Using single-sign on functionality

■ Allowing another system to log in

■ Adding fields to registration forms

For more information about controlling user access, see Security Guide for Siebel eBusiness 
Applications.

Setting Up Default Responsibilities and Users for Web 
Marketing
Responsibilities control which views the users can see. The views to which a user has access 
determines the links and page tabs that the user sees. For example, if a user has a responsibility 
that does not permit access to the Credit Cards view, no Credit Cards link appears in the My Settings 
view. If no views within a business object are visible, the page tab that maps to that business object 
will not be visible.

The responsibilities predefined for Siebel Web Marketing include:

■ Web Anonymous User. Grants view visibility to anonymous users such as anonymous visitors, 
email prospects, and email contacts. For more information about these user types, see �About 
Web Marketing Web Site Visitors� on page 117. This responsibility allows the user to access views 
that do not have the Requires_Explicit_Login flags set to TRUE in Siebel Tools. For more 
information, see Siebel Tools Reference.

■ Web Registered User. End user of the application in a business-to-consumer model such as 
logged-in contact. For more information about these user types, see �About Web Marketing Web 
Site Visitors� on page 117. This user has registered and is recognized by the Siebel application 
either through their login, or because the user enters the site by clicking an embedded link in an 
email offer.

■ Web Corporate User. End user of the application in a business-to-business model. A Web 
corporate user is associated with an account and must be authorized by the Web Delegated 
Customer Administrator to access the site. A Siebel Administrator can add new Web corporate 
users.

For more information about setting up and managing responsibilities, see Security Guide for Siebel 
eBusiness Applications.

Setting Up a Default Campaign and Default Offer
Assigning a default campaign and offer is part of the Web Marketing setup process. An offer 
associated with the default campaign can be designated as the default offer. 

You specify the default campaign and default offer in the Application Administration screen in the 
System Preferences view. To assign a default campaign, complete the Default Campaign Source Code 
field. To assign the default offer, complete the Default Offer Code field. 
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The default campaign and default offer determine which offers are presented to the customer during 
their Web Marketing session. These offers appear in addition to any targeted offers such as an 
embedded link in an email offer.

CAUTION: The default campaign must be a campaign not a campaign plan. If you associate the 
default campaign with the campaign plan, the response records from your campaign will not be 
associated correctly.

For more information about default offers and default campaigns, see the Featured Offers topic in 
Siebel Marketing User Guide.

Using Siebel Personalization with Web Marketing
Siebel Personalization allows you to deliver personalized content and offers to a customer profile, 
needs, interests, and history. Personalized content includes greeting users by name, presenting them 
with content targeted to their needs and interests, and showing them recommended products and 
offers based on their needs and history. 

Using Siebel Personalization, you can define rules to show and hide content dynamically during a 
user's experience with Siebel Web Marketing. Personalization deployment rules can depend on data 
such as user's profile information, date ranges, company information, products and services they 
already purchased or reviewed, and specific session information.

The home page in Siebel Web Marketing includes the salutation applet in the upper left corner. It 
typically includes a personal greeting but it can be configured to deliver targeted content such as 
product promotions, announcements, birthday greetings, and offer updates. The home page also 
contains a list of recommended products and featured offers, both of which can be personalized 
based on user-specific information. Conditional expressions can be used to hide applets under certain 
conditions.

You manage personalization in the Personalization Administration screen in your Siebel Application. 
For information about administering personalization, see Siebel Personalization Administration 
Guide.

Customizing the Web Marketing User Interface
The Siebel product provides a set of Web templates and cascading style sheets (CSS) to create the 
look and feel of a Siebel application. Customers can create their own look and feel by modifying 
corporate logos, colors, and fonts in the style sheets and Web templates. When modifying these 
elements, make sure you save a backup copy in case you want to restore the original files.

NOTE: These elements are not automatically upgraded during the upgrade process.

The Siebel Web architecture uses the Siebel Web Engine (SWE) to dynamically generate HTML pages. 
The SWE uses configuration information in the Siebel Repository (SRF) and HTML layout information 
in the Siebel Web Template (SWT) to merge data with the template when creating the HTML page.

To customize the Web Marketing User Interface, perform the following tasks:

■ Modifying Web Templates on page 122
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■ Implementing Web Marketing Without Frames on page 122

■ Full-Text Search on page 123

■ Response Management on page 123

Modifying Web Templates
A Web template defines the layout and formatting elements of the user interface (UI), such as views, 
applets, and controls. You associate these UI elements with the templates in Siebel Tools. The 
associated information is stored in the SRF file. For example, you might have a View object with three 
applets. You associate a View Template with the view, and map each applet to a placeholder in that 
template. The advantage of this approach is that the UI objects in the repository are not hard-coded 
in individual templates. As a result, a number of View objects can share the same template if they 
share the same layout. The same process and design applies to Applet objects.

The three primary templates types are Container, View and Applet. The final HTML pages created by 
the SWE places the applet in the view and the view in the container. Siebel eBusiness Applications 
provide numerous applet and view templates with the product. They can be viewed in Tools, but are 
edited in an external editor. For information about the physical user interface layer, see Siebel Tools 
Reference. 

The following is a list of some modifications that you might want to perform to change the look and 
feel of your Web site:

■ Modifying Views and Applets

■ Modifying Web Templates

■ Changing colors

■ Modifying behavior caused by clicking a button

■ Adding or removing applets

■ Changing controls

■ Making fields in a form appear

For more information about customizing the user interface, see Siebel Tools Reference.

Implementing Web Marketing Without Frames
Customer and partner applications use HTML frames for compatibility when running in browser-based 
applications. HTML frames allow portions of the browser window to scroll independently of the rest 
of the window. For example, you can place the navigation elements in one frame and content in 
another frame. You can scroll the content while the navigation elements remain in a fixed location.

Customer and partner applications can be implemented without using frames. Before choosing this 
method, consider the following limitation. In an unframed application, all UI elements exist in the 
same window. Therefore, the contents list may scroll off the page as a user scrolls down. For 
example, if the user scrolls down to review content, the navigation elements might not be visible.
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Full-Text Search
Siebel Search for Customers is a subset of the Siebel Search product. It allows users to scan 
database tables and documents for pertinent information. Siebel Search is included with every 
license of a Siebel application. For information about Siebel Search and Siebel Search for Customers, 
see Siebel Search Administration Guide.

Response Management
Siebel Web Marketing allows marketers to capture a series of responses during a customer 
interaction. Siebel Web Marketing supports automatic capture of the following responses:

■ Clicked on Web Offer. Captured when the recipient clicks the embedded link for a Web offer in an 
email offer.

■ Clicked on Product URL. Captured when the recipient clicks the embedded link for the product in 
an email or Web offer.

■ Clicked on Web Survey. Captured when the recipient clicks the embedded link for the Web survey 
in an email or Web offer.

■ Completed Web Survey. Captured when the recipient clicks Finish on the Web survey view. The 
survey answers are captured if the Save Answer field is checked for the question on the 
Smartscript Administration views. For more information, see Siebel SmartScript Administration 
Guide.

■ Downloaded Info/File. Captured when the recipient clicks the embedded link for the document 
that is downloaded in a Web offer.

■ Requested Unsubscribe. Captured when the recipient submits their subscription preference 
updates after clicking the embedded link in the email offer. In addition to the response, the 
contact profile is automatically updated.

■ Requested call back. Captured when the recipient submits their request after clicking the 
embedded link in an email or Web offer.

■ Requested more info. Captured when the recipient submits their request after clicking the 
embedded link in an email or Web offer.

■ Submitted Source Code. Captured when a contact or prospect types a source code and offer code 
in the Do you have Another Offer form in the Offers page.

Additional responses and Siebel events can be captured through configuration. For more information, 
see event tracking topics in Siebel Tools Reference.
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A Advanced Marketing 
Information for Administrators
This appendix contains the following advanced topics for system administrators and marketing 
administrators:

■ Field Names for Marketing Integration Components on page 125

■ Displaying Analytics Columns in Marketing Plans on page 133

Field Names for Marketing Integration 
Components
Table 22 on page 125 contains a list of Marketing integration objects, their components, and field 
names.

Table 22. Field Names for Marketing Integration Components

Parent 
Integration 
Object

Parent 
Integration 
Component Name Data Type Length

Marketing Contact Account Account Location DTYPE_TEXT 50

Marketing Contact Account Account Name DTYPE_TEXT 100

Marketing Contact Account Home Page DTYPE_TEXT 100

Marketing Contact Account Id DTYPE_TEXT 30

Marketing Contact Account Integration Id DTYPE_TEXT 30

Marketing Contact Account Main Fax Number DTYPE_TEXT

Marketing Contact Account Main Phone Number DTYPE_TEXT

Marketing Contact Account Region DTYPE_TEXT 25

Marketing Contact Account Address Address Name DTYPE_TEXT 100

Marketing Contact Account Address City DTYPE_TEXT 50

Marketing Contact Account Address Country DTYPE_TEXT 50

Marketing Contact Account Address Id DTYPE_TEXT 30

Marketing Contact Account Address Integration Id DTYPE_TEXT 30

Marketing Contact Account Address Postal Code DTYPE_TEXT 30

Marketing Contact Account Address State DTYPE_TEXT 10

Marketing Contact Account Address Street Address DTYPE_TEXT 200
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Marketing Contact Account Address Street Address 2 DTYPE_TEXT 100

Marketing Contact Account 
Organization

Organization DTYPE_TEXT 50

Marketing Contact Campaign Contact Campaign Id DTYPE_ID

Marketing Contact Campaign Contact Completion Date DTYPE_TEXT

Marketing Contact Campaign Contact Distribution Id DTYPE_ID

Marketing Contact Campaign Contact Key 1 DTYPE_TEXT 30

Marketing Contact Campaign Contact Key 2 DTYPE_TEXT 30

Marketing Contact Campaign Contact Key 3 DTYPE_TEXT 30

Marketing Contact Campaign Contact Key 4 DTYPE_TEXT 30

Marketing Contact Campaign Contact Key 5 DTYPE_TEXT 30

Marketing Contact Campaign Contact Key 6 DTYPE_TEXT 30

Marketing Contact Campaign Contact Key 7 DTYPE_TEXT 30

Marketing Contact Campaign Contact Load Number DTYPE_NUMBER

Marketing Contact Campaign Contact Load Wave Id DTYPE_ID

Marketing Contact Campaign Contact Scalability Batch 
Number

DTYPE_NUMBER

Marketing Contact Campaign Contact Segment Id DTYPE_ID

Marketing Contact Campaign Contact Source Code DTYPE_TEXT 75

Marketing Contact Campaign Contact Token Number DTYPE_NUMBER

Marketing Contact Contact Cellular Phone # DTYPE_TEXT

Marketing Contact Contact Email Address DTYPE_TEXT 50

Marketing Contact Contact Fax Phone # DTYPE_TEXT

Marketing Contact Contact First Name DTYPE_TEXT 50

Marketing Contact Contact Gender DTYPE_TEXT 30

Marketing Contact Contact Home Phone # DTYPE_TEXT

Marketing Contact Contact Id DTYPE_ID 30

Marketing Contact Contact Integration Id DTYPE_TEXT 30

Marketing Contact Contact Job Title DTYPE_TEXT 75

Marketing Contact Contact Last Name DTYPE_TEXT 50

Table 22. Field Names for Marketing Integration Components

Parent 
Integration 
Object

Parent 
Integration 
Component Name Data Type Length
Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A126 ■



Advanced Marketing Information for Administrators ■  Field Names for Marketing
Integration Components
Marketing Contact Contact Middle Name DTYPE_TEXT 50

Marketing Contact Contact Person UId DTYPE_TEXT 100

Marketing Contact Contact Preferred 
Communications

DTYPE_TEXT 30

Marketing Contact Contact Salutation DTYPE_TEXT 15

Marketing Contact Contact Status DTYPE_TEXT 30

Marketing Contact Contact Work Phone # DTYPE_TEXT

Marketing Contact Contact Address Id DTYPE_TEXT 30

Marketing Contact Contact Address Integration Id DTYPE_TEXT 30

Marketing Contact Contact Address Personal Address 
Name

DTYPE_TEXT 100

Marketing Contact Contact Address Personal City DTYPE_TEXT 50

Marketing Contact Contact Address Personal Country DTYPE_TEXT 50

Marketing Contact Contact Address Personal Postal Code DTYPE_TEXT 30

Marketing Contact Contact Address Personal State DTYPE_TEXT 10

Marketing Contact Contact Address Personal Street 
Address

DTYPE_TEXT 200

Marketing Contact Contact Address Personal Street 
Address 2

DTYPE_TEXT 100

Marketing Contact Contact 
Organization

Organization DTYPE_TEXT 50

Marketing Contact Household Fax Number DTYPE_TEXT

Marketing Contact Household Household Name DTYPE_TEXT 50

Marketing Contact Household Household Number DTYPE_TEXT 100

Marketing Contact Household Household Size DTYPE_NUMBER

Marketing Contact Household Household Wealth DTYPE_TEXT

Marketing Contact Household Id DTYPE_ID 30

Marketing Contact Household Income DTYPE_TEXT

Marketing Contact Household Integration Id DTYPE_TEXT 30

Marketing Contact Household Phone Number DTYPE_TEXT

Marketing Contact Household Revenue DTYPE_TEXT

Table 22. Field Names for Marketing Integration Components

Parent 
Integration 
Object

Parent 
Integration 
Component Name Data Type Length
Siebel Marketing Installation and Administration Guide Version 7.7, Rev. A ■ 127



Advanced Marketing Information for Administrators ■  Field Names for Marketing 
Integration Components
Marketing Contact Household 
Organization

Organization DTYPE_TEXT 50

Marketing Person Campaign Contact Account Id DTYPE_ID

Marketing Person Campaign Contact Campaign Id DTYPE_ID

Marketing Person Campaign Contact Completion Date DTYPE_TEXT

Marketing Person Campaign Contact Contact Id DTYPE_ID

Marketing Person Campaign Contact Distribution Id DTYPE_ID

Marketing Person Campaign Contact Household Id DTYPE_ID

Marketing Person Campaign Contact Key 1 DTYPE_TEXT 30

Marketing Person Campaign Contact Key 2 DTYPE_TEXT 30

Marketing Person Campaign Contact Key 3 DTYPE_TEXT 30

Marketing Person Campaign Contact Key 4 DTYPE_TEXT 30

Marketing Person Campaign Contact Key 5 DTYPE_TEXT 30

Marketing Person Campaign Contact Key 6 DTYPE_TEXT 30

Marketing Person Campaign Contact Key 7 DTYPE_TEXT 30

Marketing Person Campaign Contact Load Number DTYPE_NUMBER

Marketing Person Campaign Contact Load Wave Id DTYPE_ID

Marketing Person Campaign Contact Prospect Id DTYPE_ID

Marketing Person Campaign Contact Scalability Batch 
Number

DTYPE_NUMBER

Marketing Person Campaign Contact Segment Id DTYPE_ID

Marketing Person Campaign Contact Source Code DTYPE_TEXT 75

Marketing Person Campaign Contact Token Number DTYPE_NUMBER

Marketing Prospect Campaign Contact Call Completed DTYPE_TEXT

Marketing Prospect Campaign Contact Campaign Id DTYPE_ID

Marketing Prospect Campaign Contact Completion Date DTYPE_TEXT

Marketing Prospect Campaign Contact Distribution Id DTYPE_ID

Marketing Prospect Campaign Contact Key 1 DTYPE_TEXT 30

Marketing Prospect Campaign Contact Key 2 DTYPE_TEXT 30

Marketing Prospect Campaign Contact Key 3 DTYPE_TEXT 30

Table 22. Field Names for Marketing Integration Components

Parent 
Integration 
Object

Parent 
Integration 
Component Name Data Type Length
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Marketing Prospect Campaign Contact Key 4 DTYPE_TEXT 30

Marketing Prospect Campaign Contact Key 5 DTYPE_TEXT 30

Marketing Prospect Campaign Contact Key 6 DTYPE_TEXT 30

Marketing Prospect Campaign Contact Key 7 DTYPE_TEXT 30

Marketing Prospect Campaign Contact Load Number DTYPE_NUMBER

Marketing Prospect Campaign Contact Load Wave Id DTYPE_ID

Marketing Prospect Campaign Contact Prospect Id DTYPE_ID

Marketing Prospect Campaign Contact Scalability Batch 
Number

DTYPE_NUMBER

Marketing Prospect Campaign Contact Segment Id DTYPE_ID

Marketing Prospect Campaign Contact Token Number DTYPE_NUMBER

Marketing Prospect Prospect Account DTYPE_TEXT

Marketing Prospect Prospect Account Id DTYPE_ID

Marketing Prospect Prospect Alias DTYPE_TEXT

Marketing Prospect Prospect Alternate Phone # DTYPE_TEXT

Marketing Prospect Prospect Annual Revenue DTYPE_NUMBER

Marketing Prospect Prospect Assistant DTYPE_TEXT

Marketing Prospect Prospect Assistant Phone # DTYPE_TEXT

Marketing Prospect Prospect Birth Date DTYPE_DATETIME

Marketing Prospect Prospect Cellular Phone # DTYPE_TEXT

Marketing Prospect Prospect City DTYPE_TEXT

Marketing Prospect Prospect Comment DTYPE_TEXT

Marketing Prospect Prospect Country DTYPE_TEXT

Marketing Prospect Prospect County DTYPE_TEXT

Marketing Prospect Prospect DUNS Number DTYPE_ID

Marketing Prospect Prospect Disable DataCleansing DTYPE_TEXT

Marketing Prospect Prospect Email Address DTYPE_TEXT

Marketing Prospect Prospect Employee At Site DTYPE_NUMBER

Marketing Prospect Prospect Employee Total DTYPE_NUMBER

Marketing Prospect Prospect Expiration Date DTYPE_TEXT

Table 22. Field Names for Marketing Integration Components

Parent 
Integration 
Object

Parent 
Integration 
Component Name Data Type Length
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Marketing Prospect Prospect Fax Phone # DTYPE_TEXT

Marketing Prospect Prospect First Name DTYPE_TEXT

Marketing Prospect Prospect Gender DTYPE_TEXT 30

Marketing Prospect Prospect Hide DUNS Number 
Flag

DTYPE_TEXT

Marketing Prospect Prospect Home Page DTYPE_TEXT 100

Marketing Prospect Prospect Home Phone # DTYPE_TEXT

Marketing Prospect Prospect Id DTYPE_ID 30

Marketing Prospect Prospect Job Title DTYPE_TEXT

Marketing Prospect Prospect Last Name DTYPE_TEXT

Marketing Prospect Prospect Line of Business DTYPE_TEXT 50

Marketing Prospect Prospect Maiden Name DTYPE_TEXT

Marketing Prospect Prospect Manager Name DTYPE_TEXT

Marketing Prospect Prospect Marital Status Code DTYPE_TEXT

Marketing Prospect Prospect Middle Name DTYPE_TEXT

Marketing Prospect Prospect Nationality DTYPE_TEXT

Marketing Prospect Prospect Postal Code DTYPE_TEXT

Marketing Prospect Prospect Preferred 
Communications

DTYPE_TEXT 30

Marketing Prospect Prospect Preferred Language 
Name

DTYPE_TEXT

Marketing Prospect Prospect Primary Account 
Location

DTYPE_TEXT

Marketing Prospect Prospect Primary SIC Code DTYPE_TEXT 30

Marketing Prospect Prospect Primary SIC Id DTYPE_ID

Marketing Prospect Prospect Product Interest DTYPE_TEXT 100

Marketing Prospect Prospect Prospective Contact 
UId

DTYPE_TEXT 100

Marketing Prospect Prospect Province DTYPE_TEXT

Marketing Prospect Prospect Public DTYPE_TEXT 1

Marketing Prospect Prospect Race DTYPE_TEXT

Table 22. Field Names for Marketing Integration Components

Parent 
Integration 
Object

Parent 
Integration 
Component Name Data Type Length
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Marketing Prospect Prospect Salutation DTYPE_TEXT

Marketing Prospect Prospect Social Security 
Number

DTYPE_TEXT

Marketing Prospect Prospect Source Name DTYPE_TEXT 100

Marketing Prospect Prospect State DTYPE_TEXT

Marketing Prospect Prospect Street Address DTYPE_TEXT

Marketing Prospect Prospect Street Address 2 DTYPE_TEXT

Marketing Prospect Prospect Suppress Call Flag DTYPE_TEXT

Marketing Prospect Prospect Suppress Email Flag DTYPE_TEXT

Marketing Prospect Prospect Suppress Fax Flag DTYPE_TEXT

Marketing Prospect Prospect Suppress Mail Flag DTYPE_TEXT

Marketing Prospect Prospect Time Zone DTYPE_TEXT

Marketing Prospect Prospect Work Phone # DTYPE_TEXT

Marketing Prospect Prospect Year Started DTYPE_NUMBER

Analytics Account Account Attribute 66 DTYPE_TEXT 100

Analytics Account Account Attribute 67 DTYPE_TEXT 100

Analytics Account Account Attribute 68 DTYPE_TEXT 100

Analytics Account Account Attribute 69 DTYPE_TEXT 100

Analytics Account Account Attribute 70 DTYPE_TEXT 100

Analytics Account Account Attribute 71 DTYPE_TEXT 100

Analytics Account Account Attribute 72 DTYPE_TEXT 100

Analytics Account Account Attribute 73 DTYPE_NUMBER

Analytics Account Account Attribute 74 DTYPE_NUMBER

Analytics Account Account Attribute 75 DTYPE_NUMBER

Analytics Account Account Attribute 76 DTYPE_NUMBER

Analytics Account Account Attribute 77 DTYPE_NUMBER

Analytics Account Account Attribute 78 DTYPE_NUMBER

Analytics Account Account Attribute 79 DTYPE_NUMBER

Analytics Account Account Attribute 80 DTYPE_NUMBER

Analytics Account Account Attribute 81 DTYPE_NUMBER

Table 22. Field Names for Marketing Integration Components

Parent 
Integration 
Object

Parent 
Integration 
Component Name Data Type Length
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Analytics Account Account Id DTYPE_ID 30

Analytics Account Account Integration Id DTYPE_TEXT 30

Analytics Account Account Location DTYPE_TEXT 50

Analytics Account Account Name DTYPE_TEXT 100

Analytics Contact Contact Attribute 49 DTYPE_TEXT 100

Analytics Contact Contact Attribute 50 DTYPE_TEXT 100

Analytics Contact Contact Attribute 51 DTYPE_TEXT 100

Analytics Contact Contact Attribute 52 DTYPE_TEXT 100

Analytics Contact Contact Attribute 53 DTYPE_TEXT 100

Analytics Contact Contact Attribute 54 DTYPE_TEXT 100

Analytics Contact Contact Attribute 55 DTYPE_TEXT 100

Analytics Contact Contact Attribute 56 DTYPE_NUMBER

Analytics Contact Contact Attribute 57 DTYPE_NUMBER

Analytics Contact Contact Attribute 58 DTYPE_NUMBER

Analytics Contact Contact Attribute 59 DTYPE_NUMBER

Analytics Contact Contact Attribute 60 DTYPE_NUMBER

Analytics Contact Contact Attribute 61 DTYPE_NUMBER

Analytics Contact Contact Attribute 62 DTYPE_NUMBER

Analytics Contact Contact Attribute 63 DTYPE_NUMBER

Analytics Contact Contact Attribute 64 DTYPE_NUMBER

Analytics Contact Contact First Name DTYPE_TEXT 50

Analytics Contact Contact Id DTYPE_ID 30

Analytics Contact Contact Integration Id DTYPE_TEXT 30

Analytics Contact Contact Last Name DTYPE_TEXT 50

Analytics Contact Contact Person UId DTYPE_TEXT 100

Analytics Household Household Attribute 48 DTYPE_TEXT 100

Analytics Household Household Attribute 49 DTYPE_TEXT 100

Analytics Household Household Attribute 50 DTYPE_TEXT 100

Analytics Household Household Attribute 51 DTYPE_TEXT 100

Table 22. Field Names for Marketing Integration Components

Parent 
Integration 
Object

Parent 
Integration 
Component Name Data Type Length
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Displaying Analytics Columns in 
Marketing Plans
To display values from a Siebel Analytics column in the Marketing Plans screen, you can create an 
external table object in Siebel Tools. This external table object contains a logical column and logical 
join so that you can retrieve an external column value from Siebel Analytics. 

You can display Analytics columns in Marketing plans in the following ways:

■ Displaying Analytics Columns in Marketing Plans By Exporting Schema on page 134. It is 
recommended that you use this method.

■ Displaying Analytics Columns in Marketing Plans Using Siebel Tools on page 134. If you need to set 
up this feature manually, use this method.

Analytics Household Household Attribute 52 DTYPE_TEXT 100

Analytics Household Household Attribute 53 DTYPE_TEXT 100

Analytics Household Household Attribute 54 DTYPE_TEXT 100

Analytics Household Household Attribute 55 DTYPE_NUMBER

Analytics Household Household Attribute 56 DTYPE_NUMBER

Analytics Household Household Attribute 57 DTYPE_NUMBER

Analytics Household Household Attribute 58 DTYPE_NUMBER

Analytics Household Household Attribute 59 DTYPE_NUMBER

Analytics Household Household Attribute 60 DTYPE_NUMBER

Analytics Household Household Attribute 61 DTYPE_NUMBER

Analytics Household Household Attribute 62 DTYPE_NUMBER

Analytics Household Household Attribute 63 DTYPE_NUMBER

Analytics Household Household Household Name DTYPE_TEXT 50

Analytics Household Household Household Number DTYPE_TEXT 100

Analytics Household Household Id DTYPE_ID 30

Analytics Household Household Integration Id DTYPE_TEXT 30

Table 22. Field Names for Marketing Integration Components

Parent 
Integration 
Object

Parent 
Integration 
Component Name Data Type Length
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Displaying Analytics Columns in Marketing Plans By 
Exporting Schema
Siebel Marketing supports the ability to display the value of any Analytics column as a field in a form 
or list applet. The standard version of Siebel Analytics uses this capability to calculate actual revenue 
for a marketing plan.

It is recommended that you use the Siebel Analytics Administration Tool to export the corresponding 
schema, create an XML file (table) from the exported schema information, and import the XML file 
back into the Physical layer of the Administration Tool as an XML data source. For more information 
about exporting schemas and importing data sources, see Siebel Analytics Server Administration 
Guide.

Alternatively, you can display values from a Siebel Analytics column by creating an external table 
object in Siebel Tools. This external table object contains a logical column and logical join so that you 
can retrieve an external column value from Siebel Analytics.

Displaying Analytics Columns in Marketing Plans Using 
Siebel Tools
If you need to set up this feature manually, perform the following steps:

■ Example of Creating an External Table Object in Siebel Tools on page 134.

■ Set Up Columns for the Table Object in Siebel Tools on page 135

■ Assign the Column Names for the Table Object on page 135

■ Create a Data Source for the Table Object on page 135

Example of Creating an External Table Object in Siebel Tools
Use this example as a guide when you want to set up the Actual Order Revenue for Marketing Plan 
to be displayed in the Marketing Plans business component.

NOTE: This example can be used to display Analytics column values in other marketing business 
components such as campaigns by using the applicable business component name and appropriate 
table names.

■ In Siebel Tools, from the menu bar, choose Table and then click New.

■ Select an appropriate name. 

EX at the beginning of the name, identifies it as an external object.

■ Select the project.

The User Name field should ideally be Name of Table. This adds the EXT suffix. (Recommended 
convention) 

■ Alias is the Name of the Presentation Catalog. (Enclose in quotes.)

■ Set Type to External.
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■ Set Status to Active.

Set Up Columns for the Table Object in Siebel Tools
■ Click Columns.

■ (Optional, recommended convention) Copy the Name value into the User Name column. 

■ For each new column, type the Alias as the Column Path, enclosed in quotes as shown in the 
following example:

"<Fact Table Name>"."<Column Name/Alias>"

■ Set the Type field to External.

■ Set the Nullable flag, if required.

■ For each column, add the Physical Type and Length.

■ If applicable, add the Precision and Scale for numeric columns.

■ Set Cascade Clear to Ignore.

■ Set Transaction Log Code to True.

■ Set Status to Active.

■ Set System Field Mapping to Id only if the corresponding column is a Row Id (used by Object 
Manager to make queries).

Assign the Column Names for the Table Object
■ Change the Name column to EX_MPL_REVENUE. (The name of the table.)

■ Copy the Name value into the User Name column. (It adds Ext to the user name.)

■ Enclose the Alias ("Marketing Plans") in double quotation marks.

■ Change the Name of 1 column to MARKETING_PLAN_ID and perform the following steps:

■ Copy the Name into User Name. 

■ Set the System Field Mapping attribute to Id.

■ Change Name of 2 Column to TOTAL_ORDER_REVENUE, and then copy the Name into the User 
Name column.

Create a Data Source for the Table Object
■ In the Object Explorer, go to Data Source.

■ Create a New record and in the Name field, type Analytics Web. 

■ The Name should be the name of the DSN that you use to connect to Siebel Analytics Server.

■ Update the Join for the Marketing Plans business component.

■ In the Object Explorer, select Business Components.
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■ Query for business component Marketing Plans.

■ Expand the explorer to see the Joins folder.

■ Go to Join EX_MKT_REVENUE. Replace it with EX_MPL_REVENUE. Change the Table alias to 
EX_MPL_REVENUE.

■ In the Join specification > Destination column should be MARKETING_PLAN_ID.

■ Go to Field > Actual Revenue. Change Join to EX_MPL_REVENUE. Change Column to 
TOTAL_ORDER_REVENUE.
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Marketing
This appendix contains the following upgrade topics for system administrators and marketing 
administrators.

■ About Upgrading Siebel Marketing on page 137

■ Requirements for Upgrading to Siebel Marketing 7.7 With Analytics on page 138

■ Postupgrade Marketing Configuration on page 138

About Upgrading Siebel Marketing
There are several sources of upgrade information that you need to consult before you begin your 
upgrade of Marketing or Marketing Analytics. 

■ This chapter provides information about the following items to help you upgrade metadata and 
seed data that you used with a previous version of Siebel Marketing:

■ Segmentation and list generation metadata

■ User Responsibilities

■ Deactivating obsolete workflow processes

■ For Siebel Analytics upgrade information, see Siebel Analytics Installation and Configuration 
Guide, version 7.7.1 or later.

■ For information about upgrading the Marketing application in the Siebel Enterprise, see the 
Upgrade Guide for the operating system you are using. The following are some of the topics 
discussed in the upgrade guide for Windows:

■ Planning an upgrade

■ Completing a database upgrade (postupgrade tasks)

■ Obsolete data

■ Obsolete business objects

■ Obsolete views

■ Fields that have been hidden

CAUTION: Following all upgrade instructions is critical to make sure that you do not lose your 
customized data.

This section contains the following guidelines for Marketing Analytics upgrade tasks:

■ Requirements for Upgrading to Siebel Marketing 7.7 With Analytics on page 138

■ Postupgrade Marketing Configuration on page 138
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Requirements for Upgrading to Siebel 
Marketing 7.7 With Analytics
For installation and detailed upgrade instructions, see Siebel Analytics Installation and Configuration 
Guide, version 7.7.1 or later.

Before beginning the install, be sure to back up the files that you may want later, including the 
following:

■ Back up your old Web Catalog file. You can find it in the following directory:

\install root\SiebelAnalyticsData\Web\Catalog

■ Back up your Analytics repository (RPD) file. You can find it in the following directory:

\install root\Siebel Analytics\Repository

Verify Database Client
Make sure you have the correct database client on the Analytics Server machine and the Siebel 
Server machine and that you have applied all the latest fixpacks. For a list of supported database 
clients, see System Requirements and Supported Platforms on Siebel SupportWeb.

Postupgrade Marketing Configuration
After the upgrade, Marketing resides on the Siebel Analytics platform. Because some parts of the 
Marketing application are not automatically migrated during the upgrade, they need to be recreated 
or reconfigured on the Siebel Analytics platform. For more information about the upgrade process, 
see Upgrade Guide for the operating system you are using.

The following Marketing elements must be recreated or reconfigured:

■ Reconfigure Marketing Metadata on page 138

■ Update Marketing Responsibilities on page 139

■ Deactivate Obsolete Marketing Workflow Processes on page 139

Reconfigure Marketing Metadata
The Marketing metadata supporting segmentation and list generation must be configured during the 
upgrade project. The following features require new configuration in the Siebel Analytics platform. 
The following Marketing Analytics components require reconfiguration in the Siebel Analytics 
platform.

■ To configure metadata for the Marketing module, see the chapter about Marketing metadata in 
Siebel Analytics Server Administration Guide.

■ To create list formats, including campaign load formats, see �Designing Marketing List Formats� 
on page 45 and �Designing Marketing Campaign Load Formats� on page 73.

■ To create segments, see Siebel Marketing User Guide or the Segment Designer online help.
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Update Marketing Responsibilities
Several views have been removed or replaced in Siebel Marketing. You need to update your Siebel 
Responsibilities to make sure these views are visible to your users. For instructions about how to 
create or modify responsibilities, see Security Guide for Siebel eBusiness Applications. For more 
information about Marketing Responsibilities, see �About Marketing Responsibilities and Access 
Groups� on page 23.

Deactivate Obsolete Marketing Workflow Processes
Table 23 on page 139 contains a list of Marketing workflows that should have been deactivated during 
the upgrade process. Make sure these workflows have not been inadvertently activated. For more 
information, see the section about upgrade planning for Siebel Workflow Designer in the Upgrade 
Guide for the operating system you are using.

CAUTION: After the upgrade, no workflows are deployed. You must deploy and activate workflows 
before you can use them. You manually deploy seed workflows and customer workflows in Siebel 
Tools. For more information, see the section about upgrade planning for Siebel Workflow Designer in 
the Upgrade Guide for the operating system you are using.

Table 23. Obsolete Marketing Workflows

Workflow Name Group

Analytic Adapters Marketing

Automatic Data Retrieval Marketing

Campaign Launch Marketing

Campaign List Association Marketing

Campaign Load Marketing

Marketing Plan Recalculation Marketing

Program Execution Marketing
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